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Abstract

As the transition towards a more sustainable energy production is becoming increasingly more important,
the interest in renewable sources of energy such as wind power increases, due to its potential of satisfying
large power demands. Wind energy companies are, therefore, seeking improvements in the amount of energy
generated from wind turbines, together with solutions to improve the e�ciency of such machines. One possible
solution to improve the aerodynamic e�ciency of wind turbines is to consider the application of �ow control
devices on the blades' surface, to help in preventing undesired �ow conditions that would otherwise occur. A
category of devices that achieve such purposes comprises passive �ow control techniques. Among the di�erent
solutions proposed for passive �ow control, the use of Vortex Generators (VGs) has seen a growing interest
for their easy installation and e�ciency improvements obtained.
For this reason, in this thesis, the e�ects on aerodynamic performance of VGs placed on a wind turbine's
blade sections are investigated. This is achieved through Computational Fluid Dynamics (CFD) simulations
using the SU2 collections of tools for partial di�erential equations. The aim of this thesis is to explore the
capabilities of the SU2 incompressible solver in resolving the �ow features of di�erent VGs con�gurations
placed on two reconstructed blade sections. The blade sections considered are the FFA-W3-241 and the
FFA-W3-301. The con�gurations explored are related to VGs of two di�erent heights and at two streamwise
locations, as well as the Smooth con�guration (e.g without VGs).
First, a number of test cases is run to determine the most suitable CFD-con�gurations set-up for the �nal
simulations. With the information obtained, the cases of interest are simulated, focusing on near-stall and
stall-developed �ow conditions. From these conditions, the e�ect of vortex generators on the �ow �eld is
clearly evaluable.
The results are �rst compared with the corresponding experimental reference data, showing a noticeable
deviation of the simulations' values from the experiments. In addition to this, the results are also analyzed
from a qualitative perspective, to ascertain how the di�erence of the simulations from the experimental values
in�uences the data obtained. The analysis of the results by means of airfoil surface data, such as pressure
coe�cient and skin friction values, demonstrates how �ow separation is e�ectively prevented, as would be
expected through the presence of VGs in the �ow �eld. The vortices in�uence on the �ow �eld, investigated
by displaying the vorticity magnitude and the velocity components on planes perpendicular to the airfoil
streamwise direction, exhibit the typical �ow patterns found in related reference sources. A 2D boundary
layer investigation clearly presents the characteristic velocity and vorticity magnitude pro�les' shape, with
an identi�able in�ection of these pro�le curves in the streamwise direction, due to the application of VGs.
A �nal three dimensional evaluation highlights how the vortices can be identi�ed using the state-of-the-art
techniques for �ow visualization. A skin friction �ow visualization shows, however, how further considerations
from a three dimensional point of view would not be possible, since the actual results are far from being
accurate enough to display such information. In light of this, a detailed vortices structure analysis will not
be addressed.
From this evaluation, it can be stated that the relevant �ow modi�cations introduced by the VGs presence
are captured by the simulations, although further testing and validation is needed to improve the results
obtained. Nevertheless, the simulated data can be regarded to be signi�cative enough for modeling purposes.
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Riassunto Esteso

A causa della crescente necessità di produzione di energia da fonti rinnovabili, le realizzazioni di impianti
eolici hanno visto un aumentato interesse nell'ultimo decennio determinato dalla possibilità di produrre
notevoli quantità di energia, anche attraverso la costruzione di impianti o�-shore. Le aziende che producono
turbine eoliche ricercano pertanto soluzioni per aumentare la produzione di energia, insieme a strategie per
migliorare l'e�cienza di questa tipologia di macchine. Una delle possibili applicazioni che permettono un
aumento dell'e�cienza aerodinamica delle pale di queste turbine prevede l'utilizzo di strumenti per il controllo
del �usso d'aria, che aiutano a prevenire condizioni di funzionamento indesiderate che potrebbero veri�carsi.
Una delle categorie tra quelle identi�cabili per queste strategie di controllo è quella comprendente soluzioni
di controllo passivo del �usso. Tra queste, gli strumenti più utilizzati correntemente sono i Generatori di
Vortici (Vortex Generators, VGs), a causa della loro facilità di installazione e dei miglioramenti in termini di
e�cienza che comportano.
I VGs sono costituiti da piccole sottili lame rigide, di varie forme geometriche, comunemente triangolari
o rettangolari, che vengono applicate su strisce metalliche, perpendicolarmente alle stesse. Queste strisce
metalliche sono poi apposte in diverse posizioni sulle pale eoliche, lungo la direzione principale del �usso e
generalmente nelle zone più vicine alla radice della pala, dove le condizioni di �usso risultano facilmente in
stallo aerodinamico.
In questa tesi vengono investigati gli e�etti dell'applicazione di VGs sull'e�cienza aerodinamica di sezioni di
pale di turbine eoliche, attraverso simulazioni di �uidodinamica computazionale, utilizzando le librerie SU2
per la risoluzione di problemi alle derivate parziali di natura �uidodinamica. Lo scopo principale di questo
elaborato è l'esplorazione delle possibilità e capacità delle librerie SU2 di de�nire le caratteristiche del �usso
d'aria di diverse con�gurazioni di VGs, posizionate sulla super�cie di due sezioni di�erenti di pale eoliche.
Queste sezioni sono riprodotte con le modalità riportate nella pubblicazione scienti�ca di riferimento, che ne
illustra i relativi risultati sperimentali. Le sezioni di pala considerate sono relative ai pro�li aerodinamici FFA-
W3-241 e FFA-W3-301. Le con�gurazioni investigate sono relative a due altezze dei VGs e a due posizioni
sulla super�cie delle sezioni, lungo la direzione principale del �usso. Oltre a queste, viene considerata anche
la con�gurazione senza VG, per poter valutare successivamente l'e�etto dei VG stessi rispetto a condizioni
di �usso non disturbate dalla loro presenza.
Nel Capitolo 1 una breve introduzione all'argomento della tesi spiega le motivazioni e gli obbiettivi delle
successive analisi condotte.
Nel Capitolo 2 è riportata una descrizione degli aspetti teorici necessari per la comprensione dei risultati
ottenuti dalle simulazioni.
Nel Capitolo 3 vengono presentati i risultati principali ottenuti �nora in ambito sperimentale ed accademico,
discutendo i principali aspetti e caratteristiche �siche del �usso in�uenzato dai VGs.
Nel Capitolo 4 vengono descritti i test case realizzati per determinare la con�gurazione dei parametri che
permettono di ottenere i risultati migliori dalle simulazioni.
Nel Capitolo 5 viene riportata la metodologia riguardante la creazione dei modelli tridimensionali da simulare
e l'impostazione delle simulazioni da realizzare con le librerie di SU2. Le simulazioni �nali vengono impostate
tenendo conto solo di condizioni di �usso vicine allo stallo, o in condizioni di stallo sviluppato. Tali condizioni
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di �usso infatti permettono di veri�care chiaramente l'in�uenza dei VGs rispetto alle condizioni di �usso
indisturbate.
Nel Capitolo 6 si analizzano in�ne i risultati ottenuti, confrontandoli con i dati sperimentali di riferimento.
I risultati ottenuti dalle simulazioni evidenziano uno scostamento considerevole dai dati sperimentali. Per
questo motivo, si procede all'analisi delle simulazioni da un punto di vista qualitativo, per veri�care quanto
lo scostamento rilevato in�uenzi la signi�catività dei risultati. Utilizzando i dati estratti dalla super�cie delle
sezioni simulate, ovvero coe�ciente di pressione e di sforzo d'attrito, si rileva come la separazione del �usso,
che si veri�cherebbe per i casi simulati in assenza di VGs, sia e�ettivamente evitata come ci si aspetterebbe.
Analizzando il modulo della vorticità insieme a ciascuna componente di velocità su piani perpendicolari alla
super�cie delle sezioni di pala investigate, si nota che queste quantità mostrano gli andamenti tipici dovuti
alla presenza di vorticosità nello strato limite, come riportato nelle fonti bibliogra�che reperite. Per quanto
riguarda lo strato limite, i pro�li di velocità e del modulo della vorticità presentano gli andamenti attesi. I
pro�li di velocità evidenziano l'in�essione tipica dei pro�li a valle dei VGs, che, a causa della loro presenza,
di fatto costituiscono un ostacolo al �usso. I pro�li del modulo della vorticità illustrano il decadimento
della vorticosità introdotta nel �usso dai VGs. La valutazione delle caratteristiche tridimensionali del �usso,
mediante tecniche di visualizzazione apposite, mostra come sia possibile catturare la forma e l'evoluzione
del tubo di �usso vorticoso a valle dei VGs. Invece, per quanto riguarda la visualizzazione delle linee dello
sforzo d'attrito sulla super�cie della sezione considerata, si vede come non sia possibile identi�care gli an-
damenti caratteristici di queste linee. Questo indica che ulteriori valutazioni ed analisi tridimensionali non
possono essere prese in considerazione, dal momento che i risultati comunque presentano una discrepanza
non trascurabile rispetto ai dati sperimentali, tenendo conto inoltre dei modelli di turbolenza non accurati
abbastanza per tali scopi. E' comunque possibile a�ermare che le modi�che principali introdotte dai VGs al
�usso d'aria, vicino alla super�cie della pala, sono identi�cabili nei risultati, anche se ulteriori veri�che e sim-
ulazioni sono ritenute necessarie per un loro miglioramento. Nonostante ciò, si ritiene che i dati ottenuti dalle
simulazioni possano comunque essere utilizzati per la creazione iniziale di modelli che riproducano l'e�etto
dei VGs sul �usso indisturbato, senza dover ricorrere a simulazioni di �uidodinamica computazionale che
presentano tempi notevolmente lunghi.
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Chapter 1

Introduction

The renewable energy sector is expected to grow fast in the next decades, due to technological cost reduction
and speci�c policies to promote and support a transition towards clean and sustainable energy production.
According to [1], energy production by renewable sources has risen at a rate of 2.8% per year in 2017.
Among these sources, the most prominent are solar and wind energy, as a result of the increasing support of
more countries and the increased cost e�ectiveness over time.
In Figure 1.1, the growing importance of wind energy can in fact be observed: it is expected to reach an
installed capacity of 2.5 trillion kWh in 2040.
Moreover, according to the International Energy Agency (IEA), the percentage of electricity generated from
wind energy will increase up to 18% around 2050. For this reason, during the next years wind power
production will most likely experience a continuos development.

Figure 1.1: World net electricity generated from renewable sources [1]

Following the growth lines of the past years, larger turbines can be expected to be manufactured in the
future, expecially regarding o�shore installations. As a matter of fact, from the mid-eighties an increase in
the dimensions of wind turbines installations is noticeable; from an average capacity of the installations of
30 kW, with turbines having a rotor diameter of 15 m, in 2017 the Enercon E-126 turbine installation had
already reached a capacity of 7.5 MW, with a diameter of 127 m.
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In addition to that, not only larger rotor diameters could be predicted, but also taller wind turbines. Due to
the growth of the o�shore sector, it will be possible to reach greater heights and thus exploit the increased
wind speeds that follow: this would be achieved without incurring in possible environmental impacts issues
related to the otherwise excessive dimensions for common onshore installations. Being the power produced
given by a cubic relation of the wind speed, together with the considerations about a large rotor size, the
expected power output will therefore be considerable. From Figure 1.2, this increase in dimensions and
installed power over the years can be observed.

Figure 1.2: Wind turbines size evolution over decades [2]

Even if larger rotors and taller turbines would be the most probable wind turbine manufacturing developing
sectors, a report from Fraunhofer Institute for Wind Energy and Energy System Technology (IWES) indi-
cates that as the blade length, width and thickness will possibly increase, so will weight and related costs,
proportionally with the cube of the blade length. Taking this into consideration, wind turbines companies
are advancing also with regard to design optimization strategies and blade quality, to tackle the production
challenges of the future [24].
From this perspective, various solutions are being evaluated, of which increasing the aerodynamic performance
of the blades is with no doubt one that has seen a constant interest throughout the years [21],[2].
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1.1 Thesis Motivation

This thesis therefore investigates the e�ectiveness of a class of �ow control devices to increase aerodynamic
performance of wind turbines blades.
Flow control techniques could be divided in two main categories [25], passive and active �ow control tech-
niques.
Passive �ow control techniques do not need an energy input since the desired control is achieved through
compact geometrical modi�cations in desired locations on the blade, whereas active �ow control techniques
require an extra energy input, and as a consequence of this they need regular maintenance.
Among all the possible alternatives for these devices, the use of passive �ow control ones is one of the most
promising, and it already proved to be e�ective in the aeronautical sector, reason for which wind turbine
applications were soon considered.
A signi�cant amount of passive �ow control techniques has been developed in the aeronautical sector, includ-
ing Vortex Trapping Airfoils, Passive Aspiration, Fences, Trailing Edge E�ectors, Riblets, Porous Airfoils,
Winglets, and Vortex Generators, which can be seen in Figure 1.3:

� Vortex Trapping Airfoils sections are constructed with the use of a vortex cell that aids in mantaining
a formed vortex trapped. This concept is di�cult to manufacture since the vortex has to be mantained
as close as possible to the airfoil surface, in order to improve the lift coe�cient. However, the drag
coe�cient will increase as a consequence of the vortex cell, so this solution can be used when it does
not penalize signi�cantly the lift to drag ratio [26].

� Passive Aspiration uses passive blowing as vortex generator jets: these jets pass through openings on
the airfoil surface that create a primary vortical structure in the chordwise direction. This solution
excludes the extra drag formation present in mechanical devices applied to the airfoil surface [4].

� Fences are used to control the radial �ow movement that could occur at the hub of a wind turbine blade
under stalled-�ow conditions, which could propagate throughout the blade span. They are mostly useful
when strong spanwise pressure gradients are experienced during operational conditions [5].

� Trailing Edge E�ectors modify the �ow at the trailing edge of the airfoil, increasing the camber, hence
the lift. Among these devices, the most known are Gurney �aps [6].

� Riblets are cavities on the blade surface, created in the streamwise direction. They reduce turbulent
skin friction, thus reducing the total drag coe�cient [7].

� Porous Airfoils are manufactured as an airfoil surface covered with small holes, through which air is
injected, creating small vortices in the boundary layer. Overall, the e�ect of all these vortical structures
is to globally enhance the lift coe�cient while decreasing also the drag coe�cient [8].

� Winglets are used at the blade tip to reduce the tip �ow between pressure side and suction side of the
airfoil pro�le. These devices help to reduce the induced drag in this blade location [27].

� Vortex Generators are simple solid geometries placed perpendicular to the blade surface, at a given
chordwise position and at a given angle with respect to the incoming �ow. These devices help in reducing
�ow separation, but at low angles of attack they show an undesirable drag increase. Nevertheless, this
is one of the most known and used technique in preventing �ow separation and increasing aerodynamic
performance that has been studied for more than 30 years [28].

For this reason, in this thesis the e�ect of vortex generators will be investigated through numerical simulations
using the SU2's open source collection of tools for partial di�erential equations, in order to ascertain their
in�uence in the �ow �eld [29]. This could subsequently allow future modelling approaches to characterize
the �ow �eld and the overall performance enhancements for wind turbines blades.
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Figure 1.3: Di�erent passive �ow control techniques. a) Vortex Trapping Airfoil [3]. b)
Passive Aspiration [4]. c) Fences [5]. d) Gurney Flaps [6]. e)Riblets [7]. f) Porous Airfoil
[8]. g) Winglets [9]. h) Vortex Generators [10].
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1.2 Research Questions

Given the information described in the previous sections, the research questions for this thesis are proposed
as follows:

1. Is the current SU2's incompressible solver implementation able to reproduce vortex generators' exper-
imental results up to a reasonable degree of accuracy?

2. Are the results obtained from the simulations qualitatively describing the relevant �ow modi�cations?

3. Is a 2D boundary layer analysis showing the expected essential qualitative aspects?

4. Is a 3D qualitative �ow visualization analysis displaying the important �ow features?

1.3 Thesis Outline

This thesis explores the potentiality of the current SU2's incompressible solver in solving di�erent vortex-
generators-related �ow �elds con�gurations. These con�gurations are reproduced using the wind tunnel
results introduced in [23], where experimental pressure data of wind turbine blades sections with and with-
out vortex generators are reported. These data are compared with the data obtained from the numerical
simulations performed, and the e�ectiveness of the solver is assessed. Complementing that, additional �ow
analysis and visualization techniques are considered, examining the results collected.
The present work begins with a brief presentation of the relevant theoretical background in Chapter 2, to
allow a better understanding of the results obtained. In Chapter 3 the vortex generators are presented; the
�ow modi�cations that such devices introduce are explained in more detail, and an outline of the current
research and applications, in particular for wind turbines, is provided. Chapter 4 will investigate the ability
of SU2 in solving standard �ow con�gurations, considering the FFA-W3-241 wing section of [23] without
vortex generators. The results are compared with the experimental ones; this chapter represents the test case
section of the thesis, based on which the �nal simulations setup will be decided. In Chapter 5 the methodology
followed in obtaining the �nal results is described; the pre-processing, simulations set-up and post processing
is also reported. In Chapter 6, the results are presented and the research questions are discussed. Finally
the conclusions are outlined in Chapter 7, providing an answer to the proposed research questions.
The appendices are presented at the end of the thesis. They contain the reference equations of the theoretical
background chapter, together with a detailed description of the computational grids creation-process and the
relevant programming scripts used in analyzing the data collected.
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Chapter 2

Background Theory

In this chapter the background theory necessary to understand the separated-�ow phenomenon is presented,
because the main advantage of the use of vortex generators is in fact delaying �ow separation.
A brief introduction of general aerodynamics concepts related to wind turbines is presented �rst, introducing
the importance of boundary layers for wind turbine performance.
A simple introduction about the boundary layer model and its equations follows.
With the equations provided, the qualitative behaviour of boundary layer �ows is then emphasysed; this will
permit to interpret the �nal results of this work. Related to this section, an integral boundary layer overview
about the main equations is also reported next, so that overall properties of this �ows could be evaluated.
At the end of this chapter, the �ow separation phenomenon is described, using the knowledge obtained in
the previous sections; in this section the favourable e�ects of turbulence are highlighted, suggesting how they
could be exploited in order to prevent �ow separation.

2.1 Aerodynamics Introduction

The Wind turbines aim is to transform the kinetic energy from the wind resource and convert it to mechanical
energy and subsequently to electric energy.
The appearance of wind turbines resembles the one of propellers, with a number of blades connected to a
rotating shaft, which can be placed in the horizontal direction (Horizontal Axis Wind Turbine) or in the
vertical direction (Vertical Axis Wind Turbine).
In the early 20th century, the performance successes obtained in the propellers �eld for aerodynamic applica-
tions showed that exploiting the lift aerodynamic force, instead of the drag force, leads to increased e�ciency
during their functioning. The aerodynamics knowledge obtained during that time allowed to improve the
wind turbines design concepts and performance throughout the 20th century [11].
Wind turbine manufacturers began to use airfoils developed with aircraft applications in mind, but these
were not optimized for high angles of attack, being this a working condition that is frequently experienced
by wind turbines during their operation period. For this reason the blades of a wind turbine are currently
manufactured from 2D dedicated airfoil pro�les, extruding the blades �nal shape considering di�erent pro�les
at di�erent spanwise positions, given a chord and a twist distribution.
During the design process of a wind turbine, power production is an essential requirement to satisfy.
Equation (2.1) allows a simple evaluation of the power produced by a wind turbine,

P = 1/2ṁU2
∞ = 1/2ρAU3

∞ (2.1)

where ṁ is the mass �ow, ρ is the air density, A is the rotor swept area and U∞ the freestream wind velocity.
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Chapter 2: Background Theory

Therefore, it can be seen that for a given wind velocity U∞, increasing the area A swept by the rotor would
increase the power output generated. This area is given by A = πL2, with L as the blade length, so in order
to increase the area L has to increase.
From this simple evaluation, it is possible to comprehend why technological developments regarding the radial
extension L of the blades were soon been considered by manufacturers.
For the reason described above, modern blades are usually long structures, making it possible to assume that
the local velocity direction will be predominantly streamwise, with negligible spanwise component.
This assumption allows in the design stage to treat the �ow as two dimensional (2D), so that the corresponding
airfoil theory's well-known-concepts and models could be used, together with its �ow characterization as in
Figure 2.1.
It should be pointed out that to consider a true 2D �ow, an in�nite span wing should be created from a
constant chord and shape airfoil pro�les. In reality, chord and twist change along the span of the blade and
the blade itself is of �nite length, hence 2D �ow conditions cannot represent the real �ow development. In
order to implement successfully the 2D theory, the trailing vortices behind the wing should be considered
and the angle of attack corrected accordingly.

Figure 2.1: 2D airfoil pro�le with generic streamlines [11]

From the 2D airfoil theory, when considering an airfoil shape in a uniform �ow, the reacting force from the
�ow experienced by the airfoil is usually decomposed, with respect to the freestream velocity, in a component
perpendicular to it (Lift force L) and a component parallel to it (Drag force D).
From a physical point of view, lift is caused by the pressure di�erence between the upper side and the lower
side of the airfoil. This pressure di�erence is the consequence of the streamlines curvature induced by the
presence of the airfoil in the �ow �eld, that cause a local pressure gradient.
In aircraft applications, the lift force is the force that is responsible for lifting mass o� the ground in order to
prevail over gravity, whereas the drag force is the force responsible for the decrease in �uid velocity relative
to the airfoil in the �uid path.
In wind turbine applications, the decomposition of lift and drag forces on the plane of rotation of the blade,
at a given spanwise position and multiplied by it, results in the contribution to the overall torque that ensures
the desired power output. With these de�nitions, the lift and drag force can be made adimensional as follows,
introducing the lift coe�cient CL and the drag coe�cient CD:

CL =
L

1/2ρU2
∞c

CD =
D

1/2ρU2
∞c

(2.2)

In Equation (2.2), c is the chord distance on the chord line.
In Figure 2.2, the de�nition of the chord line is displayed: this is the ideal line that connects the leading edge
to the trailing edge of an airfoil; in the same �gure, α is de�ned as the angle of attack measured between the
chord line and the free stream direction.
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Therefore, it is important to maximize the ratio CL/CD in aerodynamic applications.
For aircrafts, this maximizes the lifting action o� the ground. For wind turbines, the in�uence of lift and
drag forces on the power production can be evinced from Blade Element Momentum (BEM) theory; this is a
successful 2D model used in the design and manufacturing process to determine the loads on the blade and
the power output.
Considering the Equation (2.3) for the torque contribution dM at a given spanwise position r and for a given
number of blades B:

dM = BpT rdr (2.3)

where pT = Lsin(φ) −Dcos(φ) and φ is the relative �ow angle, it is then clearly displayed that increasing
the lift force, while mantaining a low drag force, increases the contribution dM of the given blade section to
the total torque and power production.

Figure 2.2: Lift and Drag de�nition [11]

The lift and drag coe�cients are generally functions of the angle of attack α, the Reynolds number Re and
the Mach number Ma. For wind turbine applications, the two coe�cients can be considered indipendent of
the Mach number, since tipically �ow conditions are characterized by Ma < 0.3, that is to say subsonic �ow
conditions.

Figure 2.3: Lift and Drag coe�cients for the S809 airfoil [12]

In Figure 2.3 the typical lift coe�cient and drag coe�cient curves are displayed.
The behaviour of lift coe�cient, as a function of α, is linear up to a maximum for a certain value of α. After
that, the airfoil experiences aerodynamic stall, a condition where airfoil performance decrease abruptly. In
this situation, the lift values decrease in a typical way for each airfoil considered.
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Regarding the drag coe�cient, it shows an almost constant value for α below the corresponding stall angle,
and it increases rapidly in stall �ow conditions.
The aerodynamic stall conditions are greatly in�uenced by the �uid �ow phenomena occurring in the region
close to the airfoil surface, named Boundary Layer following the studies of Prandtl.
According to Prandtl [30], this region is described as the region where the �uid adheres to the wall surface of
a body immersed in a �uid, with a zero relative velocity between the �uid and this wall surface. Under the
circumstances of a very small viscosity value and a short �uid path along the wall, the velocity in this model
will reacquire its freestream value rapidly in a direction normal to the wall. The boundary layer is therefore
the region where the viscous e�ects are not negligible, and where sharp changes of velocity occur even with
small friction.
The boundary layer can be characterized by laminar or turbulent �ow conditions. The �rst is related to the
assumption of �uid layers sliding over each other, with few �uid particles interchange. The latter is described
by layers that exchange a greater momentum between each other, inducing additional shearing forces.
Having introduced this information about the boundary layer, as mentioned before the stall condition is
highly dependent on the way this �ow region develops around a given airfoil geometry.
In fact, when the boundary layer separates from the upper side of the airfoil surface, stalled conditions
manifest.
If separation occurs at the airfoil trailing edge and it does not develop much under greater angles of attack
�ow condition, a so called soft stall is observed. If early separation is seen, that is to say separation close to
the leading edge, a strong stall is observed, with a considerable loss in lift coe�cient.
The dependency from the Reynolds number Re for lift and drag coe�cients is related closely to the laminar
or turbulent boundary layer behaviour just described. In particular, it is associated to the chordwise position
on the airfoil surface after which the boundary layer transitions to turbulent �ow conditions.
The Reynolds number in�uence, in particular for the drag coe�cient, is negligible when reaching a critical
value ReCRIT , after which the boundary layer becomes predominantly turbulent.
From this brief introduction to aerodynamics theory, the importance of boundary layers regarding airfoil
performance has been pointed out. Hence, in the next sections boundary layers are treated more in detail.

2.2 Boundary Layer Equations

The reference equations for �uid motion are the Navier-Stokes equations. These equations are obtained from
the laws of conservation of mass, momentum and energy. When they are coupled with relations for viscous
stresses, heat conduction and the equations of state, they characterize the entire �ow �eld.
For the purposes of the following explanation, 2D incompressible Navier-Stokes equations are introduced,
allowing a more intuitive description of the boundary layer region.
In Equation (2.4), Equation (2.5) and Equation (2.6), u and v are the components of the velocity in the
x and y directions respectively, p is the pressure, µ is the dynamic viscosity and ρ is the �uid density, so
that ν = µ/ρ [m2/s] is the kinematic viscosity; the body forces will be neglected for simplicity, and a steady
�ow will be assumed. The following equations are respectively the continuity (Equation (2.4)), x-momentum
(Equation (2.5)) and y-momentum (Equation (2.6)) equations.
In Figure 2.4 the corresponding coordinate system is displayed.

Figure 2.4: Coordinate system for the boundary layer equations [13]
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The set of equations for �uid motion is therefore:

∂u

∂x
+
∂v

∂y
= 0 (2.4)

u
∂u

∂x
+ v

∂u

∂y
= −1

ρ

∂p

∂x
+ ν (

∂2u

∂x2
+
∂2u

∂y2
) (2.5)

u
∂v

∂x
+ v

∂v

∂y
= −1

ρ

∂p

∂y
+ ν (

∂2v

∂x2
+
∂2v

∂y2
) (2.6)

The assumptions behind Prandtl boundary layer model are that, for high Reynolds number, the viscous forces
can be neglected in the whole �ow �eld except for a thin region in the proximity of solid boundaries. This
region is characterized by its own thickness, that is the boundary layer thickness, which becomes smaller as
viscosity approaches a zero value. This boundary layer thickness is assumed to be very small compared to
the characteristic length of the object (for airfoils it would be the chord length c), therefore written as in
Equation (2.7):

δ � c (2.7)

Following the approach of Veldman [16], the boundary layer equations can now be derived with an analysis
of the order of magnitude of the terms in Equation (2.4), Equation (2.5) and Equation (2.6), as explained in
Section �A.1.
To determine the corresponding factors to nondimensionalize the 2D Navier-Stokes equations, �rst an order-
of-magnitude analysis is performed.
Subsequently, it is possible to derive the nondimensional boundary layer equations, applying the nondimen-
sionalization to the original variables with the estimated quantities obtained at the previous step.
The �nal step is to calculate the limit for large Reynolds numbers, since this is the assumption for the viscous
forces to be neglected. In the end the �nal nondimensionalized boundary layer equations Equation (2.8),
Equation (2.9) and Equation (2.10) are obtained:

∂u′

∂x′
+
∂v′

∂y′
= 0 (2.8)

u′
∂u′

∂x′
+ v′

∂u′

∂y′
= −∂p

′

∂x′
+
∂2u′

∂y′2
(2.9)

0 =
∂p′

∂y′
(2.10)

With this approach, information about the terms to neglect was obtained.
Simplifying the corresponding terms in the original Navier-Stokes equations (Equation (2.4), Equation (2.5)
and Equation (2.6)), the boundary layer equations can be derived using the information obtained from the
order of magnitude analysis and the nondimensionalization.
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The equations for a 2D steady laminar boundary layer are shown in Equation (2.11), Equation (2.12) and
Equation (2.13):

∂u

∂x
+
∂v

∂y
= 0 (2.11)

u
∂u

∂x
+ v

∂u

∂y
= −1

ρ

∂p

∂x
+ ν

∂2u

∂y2
(2.12)

0 =
∂p

∂y
(2.13)

Through Equation (2.11), Equation (2.12) and Equation (2.13), an important result is highlighted in partic-
ular by Equation (2.13): the pressure in the boundary layer can be assumed constant in the normal direction.
The boundary conditions to apply to the boundary layer domain are the following:

� zero velocity at the wall (No-slip condition) u(x, 0) = 0 and v(x, 0) = 0, and

� velocity at the edge of the boundary layer u(x,∞) = U∞(x).

The velocity edge boundary condition applied on the x-momentum equation Equation (2.12) results in the
relation shown in Equation (2.14):

U∞
∂U∞
∂x

= −1

ρ

∂p∞
∂x

(2.14)

Equation (2.13) states that there is no pressure gradient in the y-direction, then it is possible to assume the
pressure gradient in the x-direction equal to the one at the edge of the boundary layer, relation expressed in
Equation (2.15):

dp

dx
∼ dp∞

dx
(2.15)

The x-momentum equation can then be written as in Equation (2.16):

u
∂u

∂x
+ v

∂u

∂y
= U∞

∂U∞
∂x

+ ν
∂2u

∂y2
(2.16)

The �nal 2D steady laminar boundary layer set of equations is given in Equation (2.17) and Equation (2.18):

∂u

∂x
+
∂v

∂y
= 0 (2.17)

u
∂u

∂x
+ v

∂u

∂y
= U∞

∂U∞
∂x

+ ν
∂2u

∂y2
(2.18)

For the 2D incompressible turbulent boundary layers, it is possible to follow the same approach as the one
for the laminar set of equations.
In this case, the Reynolds averaging process will be used, which separates a given variable into a mean value
and a �uctuating quantity [14].
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For a generic variable Q, the mean value Q is given by the integral shown in Equation (2.19):

Q =
1

T

∫ to+T

to

Qdt (2.19)

where T is an integration interval larger than the �uctuation period, and to is a starting time.
The �uctuation is then de�ned as the subtraction from the velocity Q of the mean value Q, as in Equa-
tion (2.20):

Q′ = Q−Q (2.20)

This �uctuation by de�nition has a zero-mean value, Q′ = 0. Because of this, to characterize the magnitude
of the �uctuation the mean square value is used as in Equation (2.21):

Q′2 =
1

T

∫ to+T

to

Q′2dt (2.21)

Under the assumption of independency of the integrals from the starting time to, the �uctuation is said to
be statistically stationary, as can be seen in Figure 2.5.

Figure 2.5: Mean and �uctuating values of Reynolds averaging [14]

It is now possible to write an expression for the �uid quantities of interest for an incompressible turbulent
�ow, as shown in Equation (2.22):

u = u+ u′, v = v + v′, p = p+ p′ (2.22)

From the de�nitions of Q and Q′, the statements in Equation (2.23), Equation (2.24) and Equation (2.25),
useful for the derivation of the turbulent set of equations, can be written for any two turbulent quantities f
and g, and a generic space coordinate s [14]:

f ′ = 0, f = f, fg = fg (2.23)

f ′g = 0, f + g = f + g,
∂f

∂s
=
∂f

∂s
(2.24)

fg = fg + f ′g′,

∫
fds =

∫
fds (2.25)

The �nal equations are obtained through the same procedure of the laminar set of equations and are presented
in Equation (2.26), Equation (2.27) and Equation (2.28).
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The turbulent set of equations for a 2D steady incompressible turbulent boundary layer are:

∂u

∂x
+
∂v

∂y
= 0 (2.26)

u
∂u

∂x
+ v

∂u

∂y
=

1

ρ

∂τ

∂y
+ U∞

∂U∞
∂x

(2.27)

τ = µ
∂u

∂y
− ρu′v′ (2.28)

where u and v are the mean components of the velocity in the same x and y directions displayed also in
Figure 2.4, u′ and v′ are the �uctuating components of the corresponding velocities (with u′v′ the mean value
of their product), U∞ the freestream velocity, µ is the dynamic viscosity, ρ is the �uid density and τ is the
total shear stress.

2.3 Boundary Layer Flow Description

Having introduced in Section �2.2 the boundary layer equations for both laminar and turbulent �ow condi-
tions, this �ow conditions can now be described qualitatively with the help respectively of Equation (2.17)-
Equation (2.18) and Equation (2.26)-Equation (2.27)-Equation (2.28).

2.3.1 Laminar Boundary Layer

Throughout the boundary layer, the �uid is decelerated essentially for two reasons: the presence of the
wall (no-slip condition) and of momentum di�usion, which is also referred to as viscous di�usion since it is
characterized by viscosity.
Intuitively, this deceleration is the result of the interaction between each �uid layer, from the wall surface up
to the potential �ow region. The layer of �uid next to the wall will need to have the wall's zero velocity (no-
slip condition), so when considering this together with the viscosity of the other layers, each layer, including
the �rst, will exert shear stresses on the next layer up, causing it to accelerate or decelerate. This process
is continued up through the �uid because of the momentum di�usion due to the shear stresses between the
layers; the development of this process is faster in more viscous �uids.
The �uid will move in the general direction of the inviscid outer �ow. Considering a positive direction with
respect to a given reference frame, the velocity pro�les in the region of the boundary layer closer to the wall
will be characterized by a positive slope trend.
This generic trend of the shape of velocity pro�les is in�uenced by two main forces, that can alter the pro�les
shape signi�cantly [13]:

� the Shear Stress τ , and

� the Streamwise Pressure Gradient dp/dx.

The Shear Stress is proportional to the derivative of the streamwise component of the velocity with respect
to the normal coordinate to the wall, as in Equation (2.29):

τ ∼ µ∂u/∂y (2.29)

For a given velocity pro�le in a 2D laminar boundary layer with constant viscosity, the shear stress has a
zero value outside this region, and grows in magnitude as it approaches the wall.
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For a turbulent boundary layer, the relation between the shear stress and the derivative of the velocity has a
di�erent expression, but it is again proportional to ∂u/∂y. Generally, in a turbulent boundary layer a larger
gradient of the velocity exists at the wall, causing a higher shear stress.
With the de�nition of the shear stress in Equation (2.29), it follows that the calculated shear stress gradient
in the y normal direction to the wall is therefore proportional to the second derivative of the streamwise
velocity, i.e ∂2u/∂y2.
At this point, the explanation of the force introduced by the shear stress can be combined with the boundary
conditions on the derivative, which imply a region with a negative shear stress gradient.
This negative shear stress gradient contributes to a net viscous force on the �uid parcels tending to decelerate
them. In most of the boundary layer �ows, this force dominates; the above explained e�ect of decelerating
the �uid parcels allows the boundary layer to become thicker as it �ows in the streamwise direction.
The Streamwise Pressure Gradient is described by Equation (2.30) and it causes an additional acceleration
that modi�es the velocity pro�les:

∂p∞/∂x = −1/ρ[U∞(∂U∞/∂x)] (2.30)

When considering the acceleration of a given �uid particle in a Lagrangian frame of reference, this acceleration
would be nearly the same for all �uid parcels, with no appreciable di�erence of this force along the normal
coordinate to the wall. This can be proved recalling the Lagrangian acceleration formula for a 1D steady �ow
given by Du/Dt = u∂u/∂x, where it can be seen that the same acceleration of the particle can be obtained
if u is small and ∂u/∂x is large, or if u is large and ∂u/∂x is small.
Applying this last statement in the bottom region of the boundary layer, where u is small, results in a
larger velocity gradient ∂u/∂x, hence the �uid particles respond to a modi�cation in the streamwise pressure
gradient, ∂p∞/∂x, with correspondingly a larger spatial rate of change of the streamwise velocity, ∂U∞/∂x.
This acceleration is linked to a corresponding force. Based on its sign, the streamwise pressure gradient can
be therefore de�ned as follows:

� Adverse Pressure Gradient (APG) when ∂p∞/∂x > 0, since it reduces more the velocity of the lower
region of the boundary layer compared to what happens in the upper part of it (∂U∞/∂x < 0);

� Favourable Pressure Gradient (FPG) when ∂p∞/∂x < 0, since it tends to increase the velocity of the
lower region of the boundary layer (∂U∞/∂x > 0).

The predominant decelerating behaviour of the �uid parcels in the boundary layer, mentioned at the beginning
of the section, has an exception when considering the region closer to the wall under an APG.
In this situation, τ > 0 at the wall, and farther out it becomes zero and subsequently negative; τ > 0 at the
wall corresponds to a net viscous force that accelerates the parcels. Therefore, this constitutes a favourable
e�ect under APGs, since it allows the �ow to resist the main deceleration due to the combined e�ect of the
negative τ and the APG in the outer region of the boundary layer, as shown in Figure 2.6.

Figure 2.6: Velocity changes due to the in�uence of pressure gradient (left) and shear
stress gradient (right) [15]
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2.3.2 Turbulent Boundary Layer

The boundary layer behaviour described so far becomes more complex when considering turbulent boundary
layers [13].
In 2D turbulent boundary layers, there are very large velocity gradients at the wall, with the highest gradient
in a very thin region called viscous sublayer; in this region the shear stress is completely viscous and therefore
negligible, with no contribution from Reynolds stresses, i.e the term −ρu′v′ in Equation (2.28).
The fact that there is a negligible turbulent shear stress does not imply a zero-turbulence condition in the
sublayer. In this region the �ow is quite turbulent, with large velocity �uctuations with respect to the mean
velocity, but the particularity of this region is that the Reynolds stress is instead nearly zero because of the
constraints that the near wall imposes on the turbulence phenomenon. Therefore, in the viscous sublayer,
the viscous shear stress dominates. In the outer region, the turbulent shear stress dominates over the viscous
stress; the velocity pro�le is however still a�ected by the viscosity, because the presence of the viscous sublayer
has a considerable e�ect on the pro�le shape, even in the part where the turbulent shear stress has more
in�uence.
Another characteristic of turbulent boundary layers is related to in�ection points under APGs:

� For a laminar boundary layer, the in�ection point has to be present since there is a change of sign of
∂2u/∂y2, from a positive value near the wall, to a negative value farther away.

� For a turbulent boundary layer, the in�ection is present both in the viscous sublayer and farther out:
a region of ∂2u/∂y2 > 0 can in fact occur in a 2D turbulent pro�le under a very strong APG, or an
APG that has been present for long enough. The in�ection point is not as pronounced as the laminar
case, so it is di�cult to see it from experiments and is mostly argued from the outer �ow behaviour
with physical reasoning.

Outside the viscous sublayer, a distinctive feature of turbulent velocity pro�les is a �corner�, in which
∂2u/∂y2 � 0.
In the outer region of the turbulent boundary layer, the eddy viscosity increases rapidly with increasing y,
and the velocity gradient diminishes accordingly to the lower levels of the outer part of the boundary layer.
In this region, it is assumed that the transport of momentum is completely turbulent and that the velocity
pro�le is not directly viscosity dependent. The velocity pro�le in the outer region approaches the value
of the inviscid outer �ow at the edge of the boundary layer, and it has to merge with the velocity pro�le
characterizing the wall region in proximity of the �corner� of the pro�le mentioned previously, as can be seen
in Figure 2.7.
The outer region can be thought as a boundary layer characterized by a slip velocity at the distinction between
sublayer and outer layer. In contrast with the no-slip velocity at the real wall, this slip velocity is then the
velocity present at the boundary with the real wall-region pro�le. Because the �ow in the outer region is
not in�uenced by the velocity relative to the wall, the velocity that in�uences this layer is the velocity defect
(U∞=u), with u being the slip velocity. The outer region is therefore often called the defect layer.
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Figure 2.7: Turbulent boundary layer velocity pro�le [16]

2.3.3 3D Boundary Layer

What described so far about the generic behaviour for 2D �ows of the boundary layer region and the forces
acting on it, becomes more complex when considering 3D boundary layers, because of the presence of cross-
�ow velocity pro�les.
The cross-�ow pro�le is linked to pressure gradients in the same cross-�ow direction, since, when considering
�ows over a stationary wall, it is necessary that the pressure gradient in a cross-�ow direction has a cross-�ow
pro�le.
With respect to the cross-�ow direction, a cross-�ow pressure gradient has an e�ect similar to a streamwise
pressure gradient in 2D �ows. This means that, inside the boundary layer, it has almost the same value
along the normal to the wall, with a more appreciable e�ect in the region closer to the wall. This e�ect is
again restrained by the viscosity, as in 2D �ows. The viscous forces in this case are produced by the negative
second derivative of the cross-�ow pro�le, in a region that starts at the wall until the peak of the cross-�ow
velocity pro�le, as shown in Figure 2.8.

Figure 2.8: Schematic of a 3D velocity pro�le, and di�erent types of cross-�ow pro�les:
a) Shear driven cross-�ow due to the motion of the wall, b) pressure driven cross-�ow
increasing c) pressure driven cross-�ow reversing [13]
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The presence of the cross-�ow in a 3D boundary layer a�ects considerably the momentum transport and
consequently the development of the �ow, contrary to what would happen in a 2D �ow under the same
streamwise pressure gradient.
The momentum de�cit convection phenomenon in a 2D Boundary Layer is in the streamwise direction, from
upstream to downstream. In a 3D Boundary Layer the momentum de�cit is convected in the local direction
of the �ow, which varies.
Cross-�ow is therefore an important aspect to take into consideration when describing a 3D boundary layer
�ow, due to the lateral momentum transport present in some regions of the boundary layer. Moreover, if
there are patterns of increasing or decreasing cross-�ow velocity in the 3D boundary layer, this leads to a
convergence or divergence of the �ow, which a�ects the velocity component normal to the wall (through
continuity balance) and indirectly also momentum transport, modifying the development of the boundary
layer as can be seen in Figure 2.9.

Figure 2.9: Examples of cross-�ow convergence or divergence: a) divergence to either side
of a location b) divergence all of one sign c) convergence to either side of a location d)
convergence all of one sign [13]

2.4 Integral Boundary Layer Equations

In Section �2.2, Equation (2.26) and Equation (2.27) describe the turbulent �ow �eld inside the boundary
layer, but often when analyzing it, the global parameters are of major interest, since they allow a more
immediate analysis of the �ow.
Equation (2.26) and Equation (2.27) can be therefore integrated, introducing integral quantities that are
used, together with the equations just mentioned, to describe quantitatively the �ow separation phenomena
in Section �2.5.
The two integrated equations that will be considered in the following analysis are the Von Kàrmàn integral
momentum equation, and the integral kinetic energy equation.
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2.4.1 Von Kàrmàn Integral Momentum Equation

The Von Kàrmàn integral momentum equation in dimensional form results in Equation (2.31) (the derivation
of the Von Kàrmàn integral momentum equation is presented in Section �A.2):

∂

∂x
(ρU2
∞θ) = τw − ρU∞

∂U∞
∂x

δ∗ (2.31)

The parameters introduced through the integral boundary layer formulation in Equation (2.31) are:

� Displacement Thickness δ∗ =
∫ δ
0

(1− u
U∞

)dy

� Momentum Thickness θ =
∫ δ
0

[ u
U∞

(1− u
U∞

)]dy

Equation (2.31) can be also formulated in its corresponding nondimensional form, expanding the derivative
∂
∂x (ρU2

∞θ) as in Equation (2.32):

∂
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(ρU2
∞θ) = θ

∂
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(ρU2
∞) + ρU2

∞
∂θ
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= 2θρU∞

∂U∞
∂x

+ ρU2
∞
∂θ
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(2.32)

Equation (2.32) is substituted in Equation (2.31), and after rearranging and dividing all the terms by ρU2
∞

yields the non dimensional Von Kàrmàn integral momentum equation in Equation (2.33):

∂θ

∂x
=
cf
2
− (H + 2)

θ

U∞

∂U∞
∂x

(2.33)

The parameters introduced through the integral boundary layer formulation in Equation (2.33) are the
following:

� Shape Parameter H = δ∗

θ

� Skin Friction Coe�cient cf = τw
1/2ρU2

∞

2.4.2 Integral Kinetic Energy Equation

The integral kinetic energy equation in its dimensional form is shown in Equation (2.34)(the derivation of
the integral kinetic energy equation is presented in Section �A.3):

2D =
∂(ρU3

∞θ
∗)

∂x
(2.34)

The parameters introduced through the integral boundary layer formulation in Equation (2.34) are:

� Energy Thickness θ∗ =
∫ δ
0

[ u
U∞

(1− u2

U2
∞

)]dy

� Dissipation Integral D =
∫ δ
0
τ ∂u∂y dy

To obtain the nondimensional form of the same equation, the RHS can be di�erentiated as in Equation (2.35):

2D = ρU3
∞
∂θ∗

∂x
+ ρ3θ∗U2

∞
∂U∞
∂x

(2.35)

Dividing Equation (2.35) by ρU3
∞ yields the nondimensional form of the integral kinetic energy equation

shown in Equation (2.36):

∂θ∗

∂x
= 2cD − 3

θ∗

U∞

∂U∞
∂x

(2.36)

The parameters introduced through the integral boundary layer formulation in Equation (2.36) are the
following:

� cD = D
ρU3
∞

Dissipation Coe�cient
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2.4.3 Integral Parameters Physical Meaning

The two equations obtained, the Von Kàrmàn integral momentum equation and the integral kinetic energy
equation, govern the evolution of the momentum thickness θ and the energy thickness θ∗ respectively.
These two parameters, together with the displacement thickness δ∗, are the main parameters that describe
the boundary layer from a global perspective in the streamwise direction.
Their pysical meaning can be described introducing the concept of a strictly-potential �ow�eld named Equiv-
alent Inviscid Flow (EIF). The EIF is characterized by values of velocity and pressure that are the same as
the ones at the edge of the boundary layer; this concept is used mostly in integral boundary layer codes,
where it becomes useful for viscous-inviscid coupling.
At this point, the following interpretation can be made regarding the three integral parameters [15]: assuming
a thin boundary layer, with respect to the radius of curvature of the airfoil geometry, the EIF will almost
exactly match the �ow outside the boundary layer and will have constant values through the boundary layer
thickness. Under these conditions, using a control volume approach in treating the integral quantities of
interest, it can be seen that if the same cross section is taken in the normal direction to the airfoil surface,
the EIF will have a mass �ow greater than the real �ow situation, being the �ow slowed down by the presence
of the surface itself in the latter.
To account for this mismatch, the �ow can be thought as being displaced by a certain distance from the
wall, so that the EIF through the new cross-section will have the same mass �ow as the real situation. The
distance to displace the EIF �ow from the wall is the displacement thickness δ∗; these considerations are
depicted in Figure 2.10.

Figure 2.10: Real and EIF �ow [15]

For the momentum θ and energy thickness θ∗, the momentum �ow as well as the kinetic energy �ow is
considered to be carried by mass �ow. Considering the control volume approach, the momentum �ow can
be seen as the force acting on a �ctitious barrier that captures all the mass �ow and slows down the �uid
to zero velocity, whereas the kinetic energy �ow can be seen as the power from an ideal arrays of turbines
which brings the stream velocity to zero reversibly.
When considering the same mass �ow for both the real �ow and the EIF, the EIF has more momentum and
kinetic energy than the real �ow. The ipotetic barrier and the turbine array just introduced are shorter by
a quantity equal to the displacement thickness δ∗, as shown in Figure 2.11.
In this case, the thicknesses interpretation for momentum and kinetic energy is related to the corresponding
defect of the real case when compared to the EIF. The defect in momentum is characterized by the momentum
thickness θ, whereas the defect in kinetic energy is characterized by the energy thickness θ∗.
It can be proved that the momentum thickness from a physical point of view is associated with drag force,
whereas the energy thickness is associated to viscous dissipation and drag as well [15].

20



Chapter 2: Background Theory

Figure 2.11: Momentum thickness and Energy thickness interpretation [15]

For the particular case of incompressible �ows, like the one considered in this thesis, another intepretation
of the mentioned thicknesses is possible.
This approach considers a geometric interpretation of the normalized velocity pro�le U . The thicknesses
formulation is rewritten as shown in Equation (2.37) and Equation (2.38):

U =
u

U∞
(2.37)

δ∗ =

∫ δ

0

(1− U)dy, ⇒ θ =

∫ δ

0

(U − U2)dy, ⇒ θ∗ =

∫ δ

0

(U − U3)dy (2.38)

These incompressible thicknesses de�nitions allow to consider them as the geometric areas under the pro�les
U , U2, U3, as seen in Figure 2.12. Using the normalized velocity pro�le results in a unit length in the plots,
so that comparisons between these geometric areas could be performed even for di�erent �ow situations.

Figure 2.12: Integral thicknesses interpretation for an incompressible �ow [15]

The displacement thickness δ can also be interpreted, along the normal direction to the surface, as the
distance of the horizontal line that results in equal geometric areas between this line and the U pro�le.
The last consideration regarding displacement and momentum thickness is related to a separated �ow region;
this is a situation of interest in this work since the vortex generators provide a mean to control �ow separation.
In a separated �ow condition, the �uid of the boundary layer with its associated vortices is lifted o� the
airfoil surface. This �ow constitutes a free shear layer that separates 2 �ow regions: the outer potential �ow
and the recirculating �ow region near the surface. Therefore, the displacement thickness is the distance from
the wall of the free shear layer centerline, while the momentum thickness can be considered as the thickness
of this layer.
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2.5 Flow Separation

Having introduced the boundary layer both qualitatively and quantitatively, �ow separation can be now
addressed, being the in�uence of this �ow phenomenon of great importance for the remainder of this thesis.
The main application of vortex generators is in fact preventing �ow separation and as a consequence the
performance of wind turbine blades.
When �ow separation occurs, a region of �ow reversal is seen next to the wall, with a negative slope of the
velocity pro�le. The process from attached to separated �ow requires then a change on the slope of velocity
from positive to negative at the wall, passing through the condition of zero slope at the separation point,
which is the point after which separation occurs.
An APG is required for separation to occur [13]. This requirement can be explained considering that a
negative slope of the velocity pro�le at the wall can appear only if in that region the velocity pro�le has
a positive second derivative. Therefore in a laminar boundary layer, or in the lower region of a turbulent
boundary layer, a convex velocity pro�le (∂2u/∂y2 > 0) implies a positive shear stress gradient (∂τ/∂y ∼
∂2u/∂y2 > 0), which is characteristic of an APG.
In APG �ows, the resulting positive shear stress gradient on its own is a favourable viscous force, sustaining
the �ow at the bottom of the boundary layer and allowing it to stay attached for a while and not separate
immediately. If viscous forces where not present (e.g purely inviscid �ow), immediate separation would
instead happen.
An APG is not su�cient then to cause �ow separation. This phenomenon can only happen relative to the
combined action of an APG, of the viscous force and of the no-slip condition. If viscosity and the no-slip
condition are absent, the inviscid �ow remains attached throughout the whole length of the wall, but when
they are present, they slow down the �ow enough to be subject to the �ow separation phenomenon.
Recalling the general development of an attached boundary layer �ow, this would be characterized by an
increase in the boundary layer thickness as it proceeds downstream, since viscosity and the no-slip condition
together have the e�ect of decelerating the �ow. But when it is subjected to an APG, it presents instead in
the lower region the combination of 2 forces acting along opposite directions; these forces are due to viscosity
and the positive shear stress gradient respectively.
Until the force due to the positive shear stress gradient has a decreasing rate low enough to allow the �ow
to still stay attached (even with �ow reversal), there will not be separation. When viscosity is so that
the decrease rate of the positive shear stress gradient will not be low enough anymore, the boundary layer
experiences separation; this is the physics mechanism at the root of this phenomenon.
Nevertheless, the APG is an important factor, and its e�ect is di�erent when considering a laminar or
turbulent boundary layer:

� A laminar boundary layer cannot resist separation long enough, since the favourable viscous force
experienced under APG comes only from molecular shear stress, which is usually small.

� In a turbulent boundary layer instead, the favourable net viscous force is stronger, and this is due to
the fact that there is only a thin sublayer near the wall where the eddy viscosity is almost zero, while
outside this sublayer the eddy viscosity is much greater than the one in a laminar boundary layer.

As for turbulence in particular, this has an important and favourable e�ect on delaying separation. Intuitively,
the greater resistance to separation of the turbulent boundary layer can be explained imagining the mixing
part of the �ow pulling the top of the lower sublayer along, mantaining the velocity-pro�le slope and the
skin-friction positive.
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These considerations made so far about �ow separation are valid for 2D �ows. When considering 3D �ows,
the de�nition of separation becomes more complex, since it is not due anymore only to a streamwise pressure
gradient, but also to a cross �ow one. This can be intuitively explained considering that the reversal of
velocity could happen also in the cross-�ow direction. This idea of cross-�ow velocity reversal is though not
uniquely linked to separation, since �ow reversal in the cross-�ow direction could happen also in other �ow
conditions.
The most general de�nition of �ow separation in 3D �ows that can be stated is some �ow that leaves the
surface, forming a shear layer somewhat separated from the surface [13].
To identify separation regions in 2D �ows, the commonly accepted procedure is to identify zero skin friction
Cf values, but in 3D �ows the identi�cation of a separation is complicated by the presence of an additional
dimension.
To identify separation in this case, the separation line concept can be used. A separation line identi�ed on the
airfoil surface is a geometrical entity dividing this surface in regions where the �ow from di�erent directions
converges to it; the local direction of the �ow de�nes the direction of the surface shear stress, or skin friction
lines, thus the separation line is a skin friction line towards which other skin friction lines converge.
For these lines, even if the skin friction magnitude is not zero, the skin friction component perpendicular to
the surface will present a zero value, as in 2D �ows. This last characteristic is present for every other skin
friction line, and not only for the separation line in particular. Moreover, the converging behaviour of the
lines previously described is not su�cient either to identify uniquely a separation line, reason for which a
di�erent de�nition of a separation line is necessary.
McLean [13] proposes a de�nition of separation line that is related to the locations of origin of the skin friction
lines and their converging movement towards a particular line. If skin friction lines originating from distant
locations on the surface are converging to a particular skin friction line, then the chances the identi�ed line
is a separation line are higher.
In this way it is possible to identify two main distinct types of separation lines, as shown in Figure 2.13:

� The �rst one identi�es the separation region referred to as Close Separation. The separation line divides
the surface into a region where the boundary layer is fed by the outer �ow �owing from upstream, and
a separation bubble identifying the Close Separation area.

� The second one identi�es an Open Separation. In this case, the separation line does not divide areas of
the �ow identi�ed by di�erent kinds of �ow, but it can be noticed that from both sides of this line the
boundary layer is fed by the outer �ow.

Figure 2.13: Illustration of the two types of separation lines. a) Closed type (�bubble�)
b) Open type (�free shear layer�) [13]
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To describe the turbulent phenomena and the vortical structures arising when considering the �ow separation
situation, the mathematical tool to consider is vorticity.
Vorticity is a vector quantity proportional to the angular momentum of a �uid element. It is generally a
function of position and time, e.g −→ω = −→ω (x, y, z, t), and it is de�ned as in Equation (2.39):
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−→
∇ ×

−→
V ⇒ −→ω = ωx
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k
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Vorticity originates at the �uid boundaries, di�using into the �uid where it experiences convection, stretching
(vortices increase their characteristic length) and associated intensi�cation (the vorticity component in the
stretching direction becomes greater because of angular momentum conservation). Moving away from �ow
domain boundaries, viscous e�ects are generally neglected (inviscid �ow region) and therefore vortex lines
are transported together with the outer �uid [31].
Vorticity is governed by the so called vorticity equation, that can be obtained taking the curl of the Navier-

Stokes equation for conservation of the angular momentum. From the incompressible formulation, where
−→
V

is the velocity vector, p the static pressure, ρ the density and f a generic force �eld, the vorticity equation
results in Equation (2.40):
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The time and spatial evolution of vorticity is in�uenced by the vortex intensi�cation phenomenon just men-
tioned, which is quite pronounced in turbulent �ows and �ow separation situations. For this reason, in these
kind of �ows a progressive decrease of the scales of �ow variation (i.e the movements of �ow particles) is
experienced. This chain of events is referred to as an energy cascade, leading to small �uctuations in the �ow
�eld that are mainly governed by viscosity dissipation, which therefore cannot be neglected when considering
these small scale phenomena.
The energy dissipation occurring at small scales in�uences vortical structures evolution. This is of importance
when considering �ow separation control devices that generally exploit the idea of adding vortices in the �ow
�eld to energize it, such as vortex generators.

2.6 Conclusions

In this chapter, �ow separation has been presented as a key physical phenomena that has to be delayed or
prevented in order to improve wind turbine blades aerodynamical performance. The connection between
�ow separation and physical interpretations was highlighted based on boundary layer theory. This theory
was introduced both from a quantitative and a qualitative point of view, through the constitutive equations
and the related integral ones, and physical reasoning using the results obtained from these relations was
presented. Using these concepts, it was pointed out that one way to improve the aerodynamic performance
of wind turbine blades with respect to �ow separation is exploiting the positive e�ects of turbulence in
delaying separation. This could be achieved by means of devices that induce additional turbulence and �ow
mixing in the �ow such as vortex generators, as it will be described in the next chapter.
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Vortex generators

In this chapter vortex generators are introduced as devices that allow separation prevention under otherwise
stalled circumstances.
Their e�ect on the �ow �eld is addressed �rst, describing the modi�cations that they introduce. Even if still
not complete from a physical point of view, the main models describing them are also reported.
The current research branches regarding vortex generators are then brie�y summarized, and the main appli-
cations are presented.
In the last section applications regarding wind turbines are highlighted, focusing mostly on ongoing research
and �ow �eld characterization e�orts.

3.1 Vortex Generators Physics

In Chapter 2 it was introduced the fact that a turbulent boundary layer is more e�ective than a laminar
boundary layer at resisting separation, because of the higher eddy viscosity outside the sublayer therefore
contributing to a higher turbulent shear stress gradient. Following this, it would seem bene�cial for preventing
�ow separation to introduce even more turbulent mixing in the boundary layer, so that the favourable e�ect
of turbulence just mentioned could be even more e�ective.
One way of achieving such an e�ect is generating streamwise vortices in the boundary layer, upstream of
where separation would be likely to occur, to �enhance mixing�. The device that allows the introduction of
such streamwise vortices is called Vortex Generator (VG).
A VG can have various geometrical shapes: the most common shape is a low-aspect ratio vane, with a plane
form that could be rectangular, triangular (delta shape) or trapezoidal. Other shapes have been manufactured
too, such as doublets, wishbones, as can be seen in Figure 3.1. They are attached perpendicular to the wall,
and placed at an angle of attack to the local �ow that varies between 15°-20° [18].

Figure 3.1: Types of VGs. (a) Forward and backward facing wedge or ramp (b) Counter
and co rotating vane (c) Wishbone and doublet type Wheeler vanes [17]
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VGs can have a height comparable to the boundary layer thickness (h ≈ δ), or they could have a much
smaller height (h <�< δ): in this case they would be de�ned as Submerged Vortex Generator (SVG).
The explanation of the e�ectivenes of the VGs, using the �enhanced mixing� idea, is approximative. When
talking of a large VG (h ≈ δ), the e�ect of those VGs on the �ow is more similar to a strong side force
pushing the �ow strongly to the side, with a major rearrangement of the meanvelocity �eld [13].
A satisfactory and comprehensive explanation of the VG physics has not yet been given, since it involves
complex turbulence phenomena that are still subject to study and speculation in �uid dynamics. Nevertheless,
it is possible to �nd research papers that provide interesting insights on how VG modify the �ow �eld, to
understand better their e�ectiveness in practical applications. These speculations are mainly qualitative;
some interesting modelling suggestions were provided by Velte in [18].
In this Phd thesis, passive rectangular vanes VG (h ≈ δ) were considered mounted on a �at plate, and the
embedded vortices were studied by Stereoscopic Particle Image Velocimetry. The VGs were considered in
a turbulent �ow condition. It was shown that the embedded vortices induced by VGs are characterized by
helical symmetry for a device angle of attack 20◦ ≤ β ≤ 40◦, which are the typical angles used in practical
applications.
From the experimental �ow �eld, it was possible to highlight two main vortical structures: a primary and
a secondary one. The secondary vortex is constantly present for all the angles considered: this introduces
an asymmetric disturbance in the ideal helical symmetric �ow �eld. In the case of smaller angles (β <
15°) an additional vortex structure arises, complicating the �ow �eld even more. For angles β > 40◦, the
streamwise vorticity component will decrease resulting in higher spanwise component that induces a vortex
shedding from the VG and a disappearance of the simmetry highlighted before. The vortex radius was seen
to be increasing weakly as the angle of attack β of the vortex generator increases, while the circulation was
increasing considerably under the same conditions of larger angles [18].
Moreover, a separation control with VGs was also addressed, studying a triangular pair of vanes on top of a
bump that created counter-rotating vortices. In this experiment, it was shown that the �ow separation that
would otherwise be experienced after the bump was signi�cantly reduced by the presence of VGs. The �ow
experiences rotation, with a distortion, so that the high momentum �ow transfers in the near wall region. The
boundary layer therefore becomes thinner in this region, and the �uid with low momentum is transported
upwards in the area between two vortices.
The donwstream development of the �ow sees initially vortices isolated from each other, and then gradually
integrated and mixed with the boundary layer, becoming submerged in it and lifting away from the wall
in the end as can be seen in Figure 3.2. The main e�ect of the VGs is the primary vortex structure that
generates additional shear layers.
In [32, 33] the 3D evolution of the vortices induced by a counter-rotating VG pair was studied. It was shown
that the vortices move down towards the wall, with the boundary layer below and between the vortices
being thinned by a lateral divergent �ow movement pattern. The divergent movement causes the skin
friction coe�cient to increase approximately 10% in the central region. On the sides of the vortices lateral
convergence can be seen, causing reduced skin-friction. Overall, the �ow experiences a lateral contraction,
reattaches in the central region and separates at the sides where secondary �ow patterns develop. This
�ow development and the skin friction behaviour just described were depicted also in [19], where wall �ow
visualization was used to display the skin friction lines on the surface, as seen in Figure 3.3.
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Figure 3.2: Example of �ow�eld average velocity and vorticity. The terms uncontrolled
and controlled refer to �ow�elds without and with VGs. Image produced from experi-
mental results of VGs placed on top of a bump. [18]

Figure 3.3: Example of �ow visualization behing VGs [19]
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As it is observed from the research papers mentioned before, and practical engineering applications too, VGs
are generally used in arrays, having two main con�gurations, characterized by whether the vortices are all of
the same sign (co-rotating) or of alternating signs (counter-rotating) [13].
The counter-rotating VGs con�guration has the e�ect of producing regions of strong �ow divergence, where
the boundary layer is thinned considerably, increasing its resistance to separation. Regions of �ow convergence
appear too, in which the boundary layer is thickened, reducing presumably the resistance to separation. As
the vortices move laterally, the regions of divergence become wider, and the regions of convergence narrower,
until these pairs of vortices converge on each other, rising from the surface. The rising vortices lift some of
the low-energy �uid at the wall away from it, and in doing so, this process contributes to a less tendency to
separate.
If counter-rotating VGs are placed not upstream enough of where separation will manifest, a �ow separation
will occur in the convergence regions mentioned previously, since the converged vortex pairs will rise too far
and lose their e�ectiveness.
The placement of an array of VGs, relative to its spacing, is thus a balancing act, still subject to research in
optimization methods. So far, most of the successful con�gurations rely strongly on best-practices guidelines
and not on many empirical observations. A common practice about counter-rotating arrays is to group the
devices usually in pairs, such that vortex convergence and lifto� are delayed farther downstream than they
would be with uniform spacing.
The co-rotating VGs con�guration has a similar behaviour to the counter-rotating con�guration, producing
regions of divergence (thinning) and convergence (thickening), but not as pronounced as those produced by
counter-rotation.
The following points summarize the positive and negative e�ects of the two types of con�gurations, described
by Figure 3.4:

� Counter-Rotating Arrays can be more e�ective in short distances, since they produce a stronger diver-
gence. When the vortices merge, the e�ectiveness for the remaining portion of the airfoil is reduced.
The enhanced performance of this con�guration can be degraded consistently if the vortices produced
in a pair are not of equal strength [34]: this situation could happen with �ow direction changes that
cause di�erent angles of attack for each single vane. In 3D �ows with strong cross-�ow in the boundary
layer, the two vortices in a pair behave di�erently, with a less favourable e�ect on delaying separation
than a co-rotating con�guration, which would be preferred in this case.

� Co-Rotating Arrays are less e�ective in the immediate downstream �ow region, but the vortices are
able to persist farther downstream than a counter-rotating solution. A co-rotating con�guration is used
more in cases with strong boundary-layer cross-�ow. In the case when the main vortex from the VG
has the same rotation as the background cross-�ow vorticity in the outer part of the boundary layer,
the vortex will di�use more rapidly, than it would do when it rotates in the opposite direction, with a
co-rotating con�guration. The vortices from VGs will then decay two to three times faster than they
would in a comparable 2D �ow [35].

To brie�y consider the e�ect of a VG con�guration in the design process, a rule of thumb about the direction
of the force exerted by VGs is provided in [13]: this force should push the �ow in the direction opposite to
the direction of the cross�ow.
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Figure 3.4: Mean velocity �eld behing VGs. The left plot shows a counter-rotating
con�guration, the right plot a co-rotating one [20]

In these previous papers cited, VGs were placed in locations were separation was expected to occur. Separa-
tion is a �ow phenomenon in�uenced by a pressure gradient, which in aerodynamics applications is induced
by airfoil pro�les curvature. For this reason, in [36] numerical experiments investigated the development of
modelled vortex pairs in turbulent boundary layers, considering the in�uence of both streamwise curvature
and pressure gradients.
Two di�erent types of counter-rotating vortex pairs were studied, common �ow between them towards the wall
and away from the wall. These two vortices con�gurations were then considered in three di�erent curvature
situations in the boundary layers: �at, convex and concave surface, leading to 6 total con�gurations studied.
The modeled vortex pairs were introduced to the Reynolds Averaged Navier Stokes solver by means of inlet
boundary conditions. A semi-empirical model was developed allowing the user to choose the size, strength
and location of vortices related to the VG geometry considered. Velocity and turbulence distributions in the
vortices dowstream of the VG were calculated.
The results show that:

� the combination of common-�ow-down vortices with concave-wall boundary layer leads to the formation
of secondary vortices outside the primary vortices, which remain closer to each other (as compared with
�at plate or convex wall cases).

� circulation of both common-�ow-down and common-�ow-up vortices becomes larger as the �ow proceeds
downstream in a concave surface case, but decreases when considering a �at plate or a convex wall.
This can be explained, with respect to the other cases, by the di�erent primary longitudinal vorticity
caused by a concave surface.

� for the peak vorticity in the curved duct geometry considered, it can be seen that in the case of concave
wall:

� in the initial part, it decreases rapidly due to adverse longitudinal pressure gradient present during
transition from �at to curved surface.

� in the �nal part, it increases rapidly due to favourable longitudinal pressure gradient present during
transition from curved surface to �at.

� common-�ow-down vortices on a convex wall remain closer to the wall due to the normal pressure
gradients accompanying streamwise curvature, thus reducing their magnitude rapidly.

� common-�ow-up vortices on convex wall are quickly attenuated as well, being replaced by secondary
vortices forming below them. Even if this is the case of common-�ow-up vortices, the �nal e�ect is
similar to that of the common-�ow-down con�guration.
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The models and physical explanations given so far were related to subsonic �ows VGs applications. There
is also a considerable number of supersonic applications in which SVGs are used, mainly concerning the
prevention and reduction of Shock Boundary Layer Interaction (SBLI).
In [17] results from numerical investigations involving SVG are presented, related to high-speed �ow appli-
cations and SBLI. Wedge type SVG were considered in supersonic �ow conditions, that is Ma = 1.4 and
Ma = 2.5. The SVG model proposed by Babinsky [37] was con�rmed in [17], with the characteristic sepa-
ration bubble forming right after the VG leading-edge, caused by a SBLI phenomenon. This model predicts
a pair of weak trailing vortices in the vicinity of the leading edge corner separation, in which a horseshoe
geometry is observed, with a primary vortex pair stronger than the previous that is been shed from the edges
of the SVG. The presence of other generic minor secondary vortices is also considered. This model is shown
in Figure 3.5.

Figure 3.5: The left plot shows the vortex model postulated for VGs in high speed �ow,
the right a numerical visualization of the vortices behind VGs in high speed �ow [17]

The following points summarize the main physical behaviour of vortices due to vortex generators:

� when a single device is considered, depending on the angle of attack relative to the incoming �ow, if this
angle of attack is positive or negative the �ow experiences a vortex with circulation of a di�erent sign.
This vortex initially moves closer to the wall, entraining the high momentum �uid in the lower region
near the surface. The vortex then tends to move laterally due to the presence of secondary vortices,
and at a certain streamwise location, it starts to lift o� of the surface, creating an additional shear layer
in the boundary layer.

� when multiple devices are considered, they are usually grouped in pairs and their e�ect on the �ow-�eld
depends on the con�guration chosen, that can producing counter-rotating or co-rotating vortices. In
the counter-rotating con�guration, the two primary vortices created by each device converge on each
other, creating a unique primary vortical structure that at some location will move away from the wall.
The vortex intensity measured by circulation decays as the vortex moves donwstream and the primary
vortex radius tends to increase during its movement. In the co-rotating con�guration, the primary
vortices do not converge on each other and they tend to move laterally downstream of the VG, with a
direction depending on the VG angle of attack with the incoming �ow. These vortices are characterized
by a smaller radius and a lower circulation.

� depending on their mutual position, the counter-rotating con�guration can be divided into two other
subcategories: one that produces a �ow between them that tends to move closer to the wall (common
�ow-down) and one that is characterized by a �ow between them moving away from the wall (common
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�ow-up). When these two con�gurations are considered together with the e�ect of a streamwise pressure
gradient created by di�erent curvatures of the base where VGs are mounted, it can be seen that in
the common �ow-down con�guration, the primary vortices remain closer to each other than the other
�ow-�eld pattern, with a stronger circulation. When considering a concave base curvature, secondary
vortices arise near the primary vortices. If a convex base curvature is taken into consideration, the
primary vortices will remain closer to the base surface due to the pressure gradient generating from the
type of curvature introduced.

3.2 Vortex Generators Ongoing Research

The research about low pro�le VGs can be divided in two main branches [10]:

� the �rst focuses on studying the e�ciency of di�erent devices for �ow-separation control, and

� the second is focused instead on the characterization of the vortical �ow�eld induced downstream by
devices. The aim of this type of research is to produce correlations to be used later in numerical
simulations during the design process of VGs con�gurations

Flow Separation Control
In the �rst research branch, two sub-categories can be indenti�ed, Adverse Pressure Gradients (APG) at low
speeds and Normal Shocks at supersonic speeds.
For APG at low speed, the most e�ective group of �ow separation control devices is the one that generates
streamwise vortices, such as SVGs and Conventional VGs. These types of devices are the ones to which
the term vortex generator relates directly. In theory, there is also another group of devices that could be
considered, that is to say devices that generate transverse vortices (spanwise cylinders, transverse grooves,
etc.). This other group of devices is generally less e�cient than SVGs and Conventional VGs.
The term Conventional VGs considers devices with h/δ ∼ 0.8, where h is the VG height and δ is the
boundary layer thickness, placed approximatively at 6h upstream of the baseline separation. Results from
experimental investigations on a backward facing ramp indicate that pairs of counter rotating VGs provide
mostly an attached �ow directly downstream of the ramp trailing edge. The �ow in this region is highly 3D,
with areas of recirculating �ow on the separation ramp between adjacent attached-�ow regions, as can be
seen from Figure 3.6.

Figure 3.6: Oil �ow visualization of VGs over a backward facing ramp. The leftmost
plot shows the case without VGs, the middle plot shows the case with VGs with height
h = 0.8δ and the rightmost plot shows the case with VGs with height h = 0.2δ [10]

The recirculating �ow region on the separation ramp is thought to be an indication of the excessive strength
of the vortices, reason for which another type of VGs was introduced in research, called SVGs. This type is

31



Chapter 3: Vortex Generators

smaller than the Conventional type (h/δ ∼ 0.2), and generally placed at approximately 10h upstream of the
baseline separation. The main di�erence is that these new devices can produce weaker streamwise vortices to
overcome �ow separation in the areas of recirculating �ow. The reduction of separation was of almost 90%.
The e�ectiveness of the SVGs can be explained considering that when comparing the height of low-pro�le
VG relative to the boundary layer velocity pro�le, for h/δ ∼ 0.2, the local velocity is already over 75% of
the free stream value. This means that any further increase in height will consider only an additional small
fraction of the corresponding velocity pro�le, thus providing only a moderate increase in local velocity and a
dramatical increase in the drag of the device.
VGs substantially lose their e�ectiveness when lowering h/δ < 0.1. The most e�ective location range of low
pro�le VGs is determined to be about 5h ÷ 30h upstream of the baseline separation. The device induced
streamwise vortices could last up to 100h.
The other subcategory, Normal Shocks at supersonic speeds, is related to a physical phenomenon present in
many aerodynamics applications such as transonic inlets, di�users or airfoils. The Normal Shock has the e�ect
of increasing the drag and lowering the pressure recovery dramatically, when interacting with a turbulent
boundary layer. In this case, the use of SVGs shows that they can signi�cantly suppress the shock-induced
separation bubble, improving consequently the boundary layer characteristics downstream of the shock: the
boundary layer becomes thinner and contains lower mixing losses.

Vortex Characterization
In the second research branch, related to vortex characterization and correlation, the vortex strength measured
by the circulation Γ is usually determined through �ow�eld measurements or numerical experiments.
Ashill et al. [38], introducing the concept of device e�ective height he, showed that it is possible to generalize
the correlation of a non-dimensional circulation parameter with respect to this he. he is selected ensuring that
the maximum value of non-dimensional circulation is independent of device geometry, so that it is possible
to combine a family of circulation curves for various VGs into a single curve. The correlation introduced
enables the prediction of vortex strength just downstream of the VGs for a wide range of Reynolds numbers.
Being still an active research �eld, modelling and optimization has therefore not reached a mature state yet.
The main modelling approaches used to represent these �ow features are Statistical Models, Velocity-Pro�le
based Models, the Wendt Model, the BAY Model and the jBAY Model. These approaches are described as
follows:

� as for the Statistical Models approach, there are Statistical Models based on the Lamb-Oseen vortex
model, used also in the work of Velte [18], or Statistical Models based on Second-Order statistics of the
initial vortices computed using a vortex model in combination with the Prandtl Lifting Line theory. In
the last case, the statistics are added as additional turbulence stress terms to the governing equations.

� Velocity-Pro�le based Models are useful in cases in which only the dowstream e�ects of the VG are
thought to be relevant (and not the local e�ects near the VG). Smooth velocity distributions in 3D
simulations can be speci�ed in regions where the vortex generation is to be modeled, including some
additional control of the upstream in�uence to increase the additional velocities from zero to those
desired. The main forms of velocity imposition that can be used are:

� Direct Forcing, which sets the velocity directly as a boundary condition (best performance, but
di�cult to implement in commercial solvers), and

� Proportional Control Feedback Forcing, which gives reasonable performance in terms of setting
the velocity, but it has a steady-state error which cannot be entirely removed.

� The Wendt Model is an empirical model suited for subsonic �ows with adverse pressure gradients, which
simulates the VG by adding vorticity as a step change at a given axial station (the VG should have a
height comparable to the one of the Boundary Layer).
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� The Bender, Anderson and Yagle (BAY) Model is a lift-force model applicable to a wide range of �ows,
including supersonic and sub-boundary layer VGs. This model adds a source term to the momentum
and energy equations, that simulates the lift force introduced by a VG, aligning the local �ow velocity
with the vane VG. The BAY Model introduces a non-physical Boundary Condition that explicitly
modi�es �ow properties, with the intention of modeling the e�ect of the presence of the VG on a given
�ow.

� The jBAY Model is based on lifting force theory developed by Bender, Anderson and Yagle. This new
model introduces a novel technique for de�ning control points on which to apply the simpli�ed model,
allowing a better user experience, with improved accuracy.

In [39], the validation results for a single vane in subsonic �ow, an array of vanes in a subsonic S-duct di�user,
and a pair of counter-rotating vanes in supersonic �ow are considered, using the BAY Model and the Wendt
Model. These models, in particular the BAY Model, provide comparable numerical results to those of gridded
vanes simulations. The author concludes that the BAY Model is easier and accurate enough to use than
gridded vanes.
In [40], di�erent methods of modelling vortex generators in Computational Fluid Dynamics codes without
meshing are investigated, focusing on large scale applications, such as using vortices for force augmentation
or directing the �ow. The di�erent methods considered fall under two main categories: direct VG modelling
(BAY Model), useful in cases such as presence of Strakes, and modelling the vortex alone without VG, using
Velocity Pro�le based Models. The calculation using a Velocity Pro�le based Model with Direct Forcing directly
from Navier Sokes equations has not provided good results, because it requires an accurate discretization of
the domain for complex cases. The BAY Model provided good results, as already proved also in the other
papers.
In [41], the Lamb-Oseen statistical vortex model is proposed. This model was applied to an APG boundary
layer �ow, and evaluated qualitatively against experimental and fully resolved Vortex Generators computa-
tional simulations. The test cases considered were a 2D clean �at plate, a 2D �at plate with the VG Model
implemented, and a 3D Model that fully resolved the VGs on a �at plate. Di�erent streamwise positions and
set-ups (co-rotating or counter-rotating) are presented. The model is compared against distributions of wall
pressure and skin-friction coe�cient obtained experimentally. The results of the investigation successfully
predicts both attached and separated �ow states, and it is capable also of predicting �ow control sensitivity
with respect to the streamwise position.
In [42], a Statistical Model based on Second-Order statistics was implemented. Numerical simulations of a
�at plate in zero and APG conditions, and of a plane axisymmetric di�user are performed. The models
used are in the order: the proposed statistical model, the fully resolved simulations, and the experimental
results. The application of the model in �at plate boundary layer has shown that it generally underpredicts
the stresses downstream of the VG, since the vortices are not the ones actually induced by the VG, but they
are only modeled. Qualitatively it is possible to produce correct results in trends and tendencies of the �ow
quantities considered.
The jBAY Model was considered in [43]. Numerical simulations were conducted for a single Vortex Generator
on a �at plate, on an S-Duct air intake and for a high lift con�guration. Good agreement was shown when
comparing the results against fully gridded CFD results and experimental ones. The limitation for this model
is that it does not take into account the thickness of the vortex generator.
In [44] the BAY Model was implememented and tested for an array of vortex generators. This model was
calibrated, comparing the results against fully gridded numerical simulations and experimental results for a
single SVG vane, with the height of this being just a fraction of the boundary layer thickness. The BAY
Model allowed a reduction of approximately 70% of the grid resolution, when compared with the full grid,
with a good accuracy in the prediction of shape and size of vorticity and velocity contours. It was also
possible to predict well the peak vorticity location and vortex circulation.
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3.3 Vortex Generators Applications

VG applications can be summarized into two main categories [10]:

� the �rst includes investigations that focus on �ow separation control applications for various airfoils
and wings, and

� the second is about investigations for non-airfoil applications, seeking performance improvement through
�ow control.

In the �ow separation control category, 4 di�erent subcategories can be identi�ed: Low Reynolds Airfoils,
High Lift Airfoils, Highly Swept Wings and Transonic Airfoils:

� The Low Reynolds Airfoils subcategory includes many modern airfoil applications operating in a Low-
Reynolds regime, such as remotely piloted vehicles, high-altitude aircraft, compressor blades, and wind
turbines. In these cases, usually airfoils operate at Re < 1000000, experiencing a laminar separation
bubble for angles of attack below stall. Even though these separation bubbles are small, with a little
e�ect on the airfoil lift, they can cause a thicker turbulent boundary layer, which results in a signi�cant
drag increase and consequent decrease of airfoil e�ciency. Therefore reducing the separation bubble
will result in a thinner turbulent boundary layer downstream, extending the range of application. As
a note, a signi�cant drag reduction over the entire midrange of the lift coe�cient was shown to be
possible, when using SVGs.

� In the High Lift Airfoils subcategory are included high-lift systems of modern commercial transport
aircrafts. In particular, the focus is on �ow separation on multielement high-lift airfoils, which is a
complicated function of geometry and �ight conditions. In previous research conducted, it was shown
that certain high-lift con�gurations exhibit boundary-layer separation on the �ap at low angles of attack.
To prevent this low-angle-of-attack separation, altering the geometrical con�guration is an option, but
this would cause an important reduction on the maximum lift obtainable. An e�ective countermeasure
is employing �ap-mounted, SVGs, that allow the airfoil to maintain high maximum-lift values while
attenuating boundary-layer separation at low angles of attack.

� In the Highly Swept Wings subcategory, including wings with sweep-back greater than 40%, used mostly
for supersonic combat or transport aircraft, the interest is on reducing the large lift-dependent drag, so
that the aircraft could maneuver more e�ciently at subsonic speeds. An e�ective application of VGs
on swept wings is a co-Rotating vane-type con�guration, which can give a great improvement in terms
of maximum lift for modern �ghter aircrafts. In fact, during aggressive maneuvers in �ight regimes
characterized by highly separated �ow�elds and sometimes strong vortical �ows, this measure aids in
reducing the drag force.

� In the Transonic Airfoils subcategory, the applications are aimed at increasing the lift coe�cient of
aircrafts during high-speed turning maneuvers. During these, very large APGs are present in the
streamwise direction, and also shock waves over the wing's upper surface. The use of SVGs, in particular
wedges and split vanes, can improve lift and overall performance. In particular, the use of wedges seems
to provide the greatest reduction of shock strength, probably due to compression waves induced by the
wedges. On the other hand, using split vanes produces instead the largest shock strength, and this
could be due to the reduced growth of the boundary-layer caused by the split vanes upstream of the
shock. Weaker compression waves strength could cause this e�ect.
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In the non-airfoil applications category, 3 main subcategories can be found: Noise Reduction, Engine Face
Distortion Management in Compact Inlets and Heat Exchangers:

� As for Noise Reduction, the interest is in lowering noise that could arise from small region of shock-
induced boundary-layer �ow separation at high Mach numbers. From experiments it was shown that the
low-frequency noise known as �Mach rumble� is produced by vibrations caused by an unsteady vortex
separation, which might be excited by a von Karman vortex street shed from the shock wave. To
prevent this phenomenon, SVGs placed attached to the fuselage upstream of the shock are successful in
suppressing the formation of the Karman vortex street in the wake region: they very e�ectively reduce
both the Mach rumble and the vibration.

� As for Engine Face Distortion Management in Compact Inlets, the applications are on �ow-control
methods to manage the �ow�eld inside compact inlet con�gurations. Modern S-duct inlet con�gurations
are being created more compact (shorter) to achieve weight, volume and cost reduction. This reduction
in size comes with the price of high �ow distortion and low pressure recovery caused by extreme wall
curvature and strong secondary �ow gradients. In the �ow con�guration without VGs, counter-rotating
vortices form in the forward section of the duct, leading to vortex lift-o� in the back section; this lift-
o� (3D separation phenomenon) is the primary distortion mechanism in compact inlet systems, and
consequently the �ow phenomenon that must be controlled. The VGs are usually placed inside and
around the surface of the duct in a co-rotating con�guration, closer to the region of separation and with
a device height on the order of the boundary-layer momentum thickness, in order to evenly redistribute
the boundary-layer �ow around the circumference of the fan face. The purpose of these VGs is to
create vortices that merge quickly to form a single overall secondary �ow pattern that remains within
the �thin� boundary layer next to the wall. This induced secondary �ow pattern adjacent to the wall
prevents the formation of the pair of counter-rotating vortices described before, and the undesirable
e�ects of the vortex lift-o� phenomenon. The near-wall low-momentum �uid is e�ectively spread out
circumferentially, suppressing 3D �ow separation from the wall.

� In [45], Vortex Generators e�ect was studied in External Compression Inlets of supersonic air-
crafts. These inlets are characterized by a reduction in Mach number from supersonic to subsonic,
obtained using shocks and an area expansion region. The performance is in�uenced by the in-
teractions between shocks and viscous regions. Vortex Generators are used in this article since
they reduce the need for bleeding the �ow at the shock impingement; they cause though the side
e�ect of increasing parasitic drag when VG height is comparable to Boundary Layer thickness.
In general, the use of a counter-rotating VG con�guration reduced the total separation area and
increased the spanwise variation compared to the solid wall case.

� In [46]a design of SVGs in a rectangular S-duct di�user is presented. The use of VGs in this type of
di�user is necessary because the separation inside the duct, due to its geometry and high curvature,
lowers the performance considerably. Numerical simulations were performed for S-Ducts without
and with SVGs, in di�erent con�gurations. It was shown that it is possible to obtain a reduction
in the distortion coe�cient of the inlet �ow by 27%, thus making the �ow more uniform at the
inlet. A drop in momentum thickness by 61.54% at the exit plane is achieved too with the Vortex
Generators considered, when comparing this values with the bare S-Duct di�user.

� As for the Heat Exchangers subcategory, the successful application of VGs on S-duct Engine Compact
Inlets, improving their performance by means of a reduction of �ow distortion and an increase in pressure
recovery, stimulated the interest for VGs being used also for thermal applications in Heat Exchangers.
One such example of these new applications is described in [47]. In this paper, novel �n-tube surfaces are
presented, with the aim of reducing pressure losses and pressure loss penalty, increasing heat transfer.
On this novel surfaces delta winglet pairs of Vortex Generators were introduced, through a punch out
from the surface, only from the larger �n area around the �rst transverse row of tubes. In particular,
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the Vortex Generators were designed with the angle of attack of the delta winglet to be modest: a
large angle of attack would lead to a pressure drop increase, whereas a small angle of attack would
cause less heat transfer enhancement. To increase the leading edge of the delta winglet pairs, which
was seen to cause an heat transfer enhancement, a large �n area around the �rst transverse row of
tubes can be used. The height of the VGs for this con�guration has been chosen as 0.9 times the �n
pitch (distance between centerlines of �ns). Numerical simulations were conducted, showing that it is
possible to achieve enhancements in both heat transfer and pressure drop reduction, with the proper
con�guration of the location, size and angle of attack of the VGs.

3.4 Vortex Generators Research and Applications for Wind Tur-

bines

In the last decades, the renewed interest for VGs as devices to enhance aerodynamic performance was due
also to a discovery of new possible usages, such as wind turbines applications.
VGs have proved to be e�ective devices in improving aerodynamic performance expecially for large wind
turbines. Related to wind turbines applications, they are generally mounted in multiple strips in the hub
region of the blades, as can be seen in Figure 3.7, where the stall phenomenon manifests sooner than other
radial positions. Their aim is to delay as much as possible the presence of stall �ow conditions in this region,
increasing the tolerable range of optimum angles of attack and therefore power production.

Figure 3.7: Installation of VGs on the root section of the blade [21]

As a consequence of their capability of delaying separation and therefore stall conditions, VGs are also able
to address the noise reduction problem due to vortex shedding from the blade. When energizing the �ow
through induced vortices, the result is a stronger attached �ow and a decrease in vortices recirculation area,
with an associated noise reduction.
The research regarding applications for wind turbines is focused currently on �ow characterization through
CFD simulations. There are also e�orts in modeling their e�ect in lower �delity simulation codes, employing
for example panel code techniques coupled with an Integral Boundary Layer formulation.
Regarding the research about �ow characterization through CFD simulations, this is aimed mainly at un-
derstanding and representing the �ow �eld adequately. This branch includes turbulence model selection and
meshing strategies to resolve properly the �ow�eld discretization; in some cases, the use of the BAY Model
is considered, to reduce the computational e�ort.
In [48], VGs were studied considering their height in�uence on the �ow �eld physics. CFD simulations
were performed, with these devices placed at approximatively 20% chord on the blunt trailing-edge airfoil
DU97-W-300. A counter-rotating con�guration was used, with �ve pairs of VGs in total. Di�erent geometric
parameters of these devices were analyzed. It was shown that increasing the VG height under the same
VG streamwise position causes an increase of the maximum lift coe�cient, but a larger increase in the drag
coe�cient too: this was explained as due to the additional shear stresses introduced with the greater device
height. When considering di�erent devices length, an increase of this parameter involves stronger vortices but
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also a greater drag coe�cient. Therefore increasing the devices length, even if it produces more circulation,
involves also additional shear stresses that can result in abrupt additional drag under high angles of attack.
With regards to VG pair intra-spacing, a change of this quantity does not produce appreciable e�ects in
terms of lift and drag coe�cients, but when considering a larger value both for the long and short spacing,
it can be seen from the analysis of the �ow �eld that the vortices tend to remain closer to the airfoil surface,
with a slight bene�cial e�ect in �ow separation control.
In [49], the e�ect of VGs on the CAS-W2-350, CAS-W2-400 and CAS-W1-450 thick wind turbine airfoils
was presented through experiments carried out at a Reynolds number of 1 million. Di�erent con�gurations
of VG height, chordwise position and VG pair spanwise spacing were considered, together with the analysis
of a second row of VGs. From the results obtained, it can be seen that the maximum lift coe�cient has a
greater value when VGs are placed closer to the leading edge position of the airfoil. When the chordwise
position is lower than 20% of the chord distance, the lift coe�cient decreases at lower angles of attack with
respect to the smooth con�guration.
As for the drag coe�cient, an overall increase is noticed at low angles of attack when using VGs, and the
larger values could be reduced if the VGs are placed gradually at greater chordwise positions. Related to VG
height sensitivity analysis, an increase of this parameter causes the minimum pressure drag coe�cient. The
spanwise spacing has a negligible e�ect on the performance of the airfoils. It was noted a further performance
enhancement when using a second row of VGs, depending on the chordwise position and the VGs dimensions
of this additional VG strip.
In [22] the aerodynamic performance of the NREL S809 airfoil with and without VGs was investigated through
CFD simulations. A counter-rotating con�guration was investigated, with rectangular VGs characterized by
a height equal to 1% of the chord distance. Both one and two rows of VGs were analyzed: for the single row
con�guration, the devices were placed at respectively 10%, 20% and 40% of the chordwise position, whereas
for the double row con�guration, the two rows were placed in two main con�gurations, that is (10% - 20%)
and (10% - 40%) of the chord distance. It was seen that in the single-row 40%-chordwise-position case, the
lift coe�cient is increased. In this case though, the stall phenomenon at high angles of attack occurs early
in the position along the streamwise direction, therefore the stall delay is not very e�ective. For the other
single-row con�gurations, the 20%-chordwise-position is the one that produces the highest lift coe�cients, in
accordance to what found generally in the previous articles referenced. For double VGs row con�gurations,
they generally increase lift values. For angles of attack greater than the critical value, they have a main
bene�cial e�ect in reducing drag as compared to the single row cases.
Regarding the �ow �eld investigation, the double row con�guration shows interesting results in terms of
pressure coe�cient and velocity pro�les. The pressure coe�cient behaviour shows a considerable decrease
of values at the suction side, where VGs are placed. This causes a larger integration area between the two
curves of the suction side and pressure side, resulting in a greater lift coe�cient. As for velocity pro�les, it
can be seen that the increase in momentum in the region close to the airfoil surface is considerable, with
respect to the single row con�guration. Consequently, a more energized �uid stays attached by a notably
large portion of the surface: for a high angle of attack such as 18°, the pro�les in fact show the reversed �ow
behaviour but not the separating one at the trailing edge. These considerations are shown in Figure 3.8.
The vorticity development for a VG pair in the streamwise direction is characterized by the presence of
the two corresponding vortex cores, related each to the corresponding VG. In the article, the single-row
con�guration at 10% chordwise position is analyzed for the angle of attack of 18°. The contour plots show
that the vortex induced by the presence of the VGs di�uses rapidly already at a streamwise position of 20%
of the chord distance, thus implying that the momentum increase is not able to resist separation for long
enough. This behaviour, with the proper distinctions regarding di�erent con�gurations, is a typical �ow�eld
development of the vortices induced by a counter-rotating VG con�guration, such as the one considered in
the rest of this thesis.
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Figure 3.8: CFD results of the NREL S809 equipped with VGs. The left plot shows
the velocity pro�les for di�erent streamwise locations, the right plot shows the pressure
coe�cient. Two di�erent VGs con�gurations are considered here: VGs_1 is a single VG
of height h = 0.1 ∗ c placed at a streamwise location of x/c = 0.1; VGs_6 is a double
strip VG con�guration, with VGs of height h = 0.1 ∗ c placed at a streamwise location of
x/c = 0.1 and x/c = 0.4 [22]

In [50], CFD simulations of two airfoils, FFA-W3-301 and FFA-W3-360, are performed, for both cases with
and without VGs. The peculiarity of this paper is that it is one of the very few describing the meshing process
for fully resolved VGs simulations, allowing the reader to try to test and repeat the results more easily than
other papers. The meshing steps consist of an initial VG blocking meshing strategy, realized using an in house
optimization meshing solver to create the surface grids in this region. From this step interesting indications
on a fast and generalizable meshing strategy could be obtained. The remaining airfoil surface grids are then
generated, followed by a single normal hyperbolic extrusion creating the �nal �ow domain. The Reynolds
number considered in these simulations is 3 million, and the k − ω SST with the γ − R̃eθ transition models
were employed in the simulations. The computations are then compared with experimental results from wind
tunnel measurements, comparing pressure coe�cient, lift and drag coe�cient. The fully resolved simulations
do not capture exactly the measured performance, although the results obtained show that it is possible to
compare VGs setups qualitatively, with respect to chordwise position, inner and intra spacing.
In the papers mentioned previously, fully resolved CFD simulations are used in analyzing the �ow �eld, in
substitution of experiments: these simulations are generally quite expensive from a computational point of
view, if good accuracy in the results is to be achieved. Usually Reynolds Averaged Navier Stokes (RANS)
simulations are performed, allowing a lower computational time at the cost of a lower resolution in the results
obtained. The �ow resolution accuracy of the results could be improved by using more computationally
intensive models such as Detached Eddy Simulations (DES) and Large Eddy Simulations (LES).
If the interest in VGs simulations is related to global parameters and performance estimation accuracy, it is
possible to further simplify the calculations and simulations by using lower �delity models such as the BAY
model or Integral Boundary Layer codes.
Examples of these simpli�cations are present in [51], in which a modi�ed version of the BAY model is tested,
together with another analytical model. In this paper, two di�erent models of VGs are compared, considering
a test case of a single vortex generator mounted on a �at plate. The two models considered are Actuator
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Vortex Generator Model (AcVG), based on the lifting force theory used in the BAY Model, and the analytical
model developed by Velte [18], proposed considering the recognizable helical structure of the vortices for a
given range of VG geometrical parameters. The AcVG Model permit the user to simulate in CFD codes
the e�ect of VGs, without creating and grid-resolving the real geometry of the VG. These two models were
compared with a fully resolved simulation and experimental results. It was shown that the analytical model
deviates quite importantly from experiments values, whereas the AcVG model predicts well the �ow �eld
after the VG, saving computational time when compared to the fully grid resolved simulation.
In [52] instead, an Integral Boundary Layer approach was introduced. In this paper, the well-known aerody-
namic tool XFOIL was modi�ed to account for the additional dissipation due to the vortices in the boundary
layer along the streamwise direction. The in�uence of the VG was considered forcing transition at the actual
VG streamwise location on the airfoil pro�le. A semi-empirical relation is implemented, and according to
the authors, the results show that the e�ect of the devices in the �ow is well captured, considering di�erent
parameters such as VG height, VG angle of attack and chordwise position. The polar curves for the airfoils
examined are in good agreement with the experimental data.

3.5 Conclusions

In this chapter vortex generators are described considering �rst the �ow �eld modi�cations that they intro-
duce. Their main e�ect is to create additional vortices in the boundary layer moving towards the base surface.
During this movement, they entrain the high momentum �uid from the outer zones to the region near the
wall surface. The vortex generally shows a lateral movement due to the presence of secondary vortices, and at
a particular position in the streamwise direction, it moves away from the surface, creating a free shear layer
region in the boundary layer. VGs are usually grouped in pairs, and depending on the con�guration chosen,
that is producing either counter-rotating or co-rotating vortices, they a�ect the �ow �eld in a di�erent way.
In the counter-rotating one, the two primary vortices, characteristic of the pair con�guration considered,
converge on each other, creating a single primary vortex that will again lift o� the wall at a given location,
as in the single VG case. In the co-rotating con�guration, the primary vortices do not converge on each
other, but they move laterally as described for the single VG situation. They are characterized by a smaller
radius and a lower circulation. For the counter-rotating con�guration it is possible to identify two other
subcategories based on their position with respect to each other: common �ow-down and common �ow-up,
if respectively the �ow between them moves down or away the wall.
The current research developments are then summarised. These are divided in two branches, the �rst focuses
on �ow-separation control, while the second is focused instead on �ow�eld characterization.
The main engineering applications are then presented, which can be divided in �ow separation control for
airfoils and wings, and non-airfoil applications. Flow separation control is related to Low Reynolds Airfoils,
High Lift Airfoils, Highly Swept Wings and Transonic Airfoils; non-airfoil applications are subdivided in
Noise Reduction, Engine Face Distortion Management in Compact Inlets, and Heat Exchangers.
In the end of the chapter, wind turbines applications are considered more in detail. VGs are generally placed
in the hub portion of the blades, and generally in multiple strips. In this part of the radial blade development,
the stall phenomenon manifests sooner than other radial positions, hence their purpose is delaying the presence
of such �ow conditions. In doing so, they tend to increase the angles of attack working range, enhancing
power production. They suppress noise formation too, decreasing the vortex shedding phenomenon and its
associated frequency.
The research in this �eld is related currently to CFD simulations for �ow�eld characterization and modelling
e�orts in lower �delity simulation codes (e.g panel codes with Integral Boundary Layer formulations).
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Chapter 4

Test Cases

In this chapter, the test case simulations that were initially run to verify the SU2 solver capabilities are
described.
First, the reference paper from which the test cases were designed is brie�y summarized, describing how the
experimental data were obtained. This paper also contains the experimental values of the VG con�gurations
considered in Chapter 5 and Chapter 6. Then, the SU2 solver is introduced, reporting the current incom-
pressible solver implementation used. The complications that were found during this thesis, regarding the
convergence of the solver formulation, are highlighted using appropriate references.
The test cases run consist of a comparison of the turbulence models implemented in SU2 at the time of writing
this thesis. This is followed by a mesh dependency of the simulations conducted and by a veri�cation of the
in�uence of the far�eld boundary condition that is to be used. The procedure to generate these test cases is
described, from the Pre-Processing phase involving the CAD model creation and the mesh-grid generation,
to the CFD simulations setup and results discussion.

4.1 Reference Paper

The reference paper for the experimental data, to compare the simulations with, is [23]. The airfoils presented
in this paper are the FFA W3-241 and FFA W3-301, �rst presented by Bjork [53], and the NACA 63-430.
The experimental data were obtained from a measurement campaign in the VELUX wind tunnel. This wind
tunnel is of the closed-return type, characterized by an open test section. The cross-section of the test section
has an area of 7.5 ∗ 7.5m2, with a length of 10.5m. The cross section of the jet of air in the wind tunnel is
3.4 ∗ 3.4 m2. The maximum �ow velocity achievable is 45 m/s. The airfoils tested were manufactured with
a chord of 0.6 m, extruding the airfoil pro�le with a span of 1.9 m. The manufactured airfoils pro�les were
positioned at a height of 1.7m on the test-stand used, at a distance of 3.2m from the exit of the nozzle, from
which the air is blown into the wind tunnel. The wind tunnel reference pressure was measured using three
Pitot tubes at di�erent locations, as shown in Figure 4.1. These Pitot tubes were used also to estimate the
turbulence level.
The airfoils pressure data were measured using a pressure-scanning module recording the pressure signals
received. This module was mounted on the test-stand outside of the airfoil section, with tubes characterized
by an equal length that were guided from the airfoil section considered to the pressure module. On the airfoils
sections' surface, 62 pressure taps were placed along the chord at the centre of the extruded airfoil pro�le.
These taps were positioned in a staggered con�guration, to minimize the disturbances for each tap from
the sorroundings ones. The taps positions for the airfoil sections considered in this thesis, the FFA-W3-241
and the FFA-W3-301, can be seen in Figure 4.2. Wind tunnel corrections were applied for the streamline
curvature and the downwash, when considering the experimental results.
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Figure 4.1: Wind tunnel dimensions, displaying the position of the Pitot tubes as well.

Figure 4.2: Pressure taps positions for the airfoil sections considered in this thesis. The
pressure taps are located in correspondence to the reconstructed pro�le points indicated
by the �lled squares. The reconstructed model used in the experimental tests is derived
from the original points of the airfoil sections, denoted by the continuos line without the
�lled squares.
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4.2 SU2 Solver

The generic class structure of the SU2 solver can be described by Equation (4.1) [54]:

∂tU +∇ ·
−→
F c −∇ ·

−→
F v = Q (4.1)

where U is the state variables vector,
−→
F c(U) is the vector of the convective �uxes,

−→
F v(U) is the vector of

the viscous �uxes, and Q(U) is the vector of the source terms.

This generic equation can be solved for a speci�c problem de�ning the vectors U ,
−→
F c(U),

−→
F v(U), and Q(U),

together with the appropriate boundary and temporal conditions that are characteristic of the problem
considered.
Di�erent forms of the Reynolds Averaged Navier Stokes (RANS) equation are implemented in SU2. For the
purposes of this thesis, only the incompressible formulation is considered, being wind turbine applications
described by the incompressible set of RANS equations.
The incompressible solver formulation used in the SU2 collection of tools to solve Partial Di�erential Equations
is described by Equation (4.1), with the following vectors:

U =


P
ρv1
ρv2
ρv3

 ,
−→
F c
i (U) =


β2vi

ρviv1 + Pδi1
ρviv2 + Pδi2
ρviv3 + Pδi3

 ,
−→
F v
i (U) = µtot


·

∂iv1
∂iv2
∂iv3

 , Q(U) =


·
·
·

− ρ
Fr2


where i = 1, . . . , 3 refers to the related quantity component along the x, y, and z coordinate.
In these vectors the following variables are introduced:

� P is the pressure

� ρ is the density

� vi is the velocity component

� δij is the Kronecker delta function, with j = 1, . . . , 3 related to the x, y, and z coordinate directions

� β2 is the arti�cial compressibility parameter

� Fr is the Froude number

� µtot = µdyn+µtur is the total viscosity, sum of the dynamic viscosity µdyn and of the turbulent viscosity
µtur

The boundary conditions available in SU2 for this incompressible solver formulation are: Euler wall (�ow
tangency), no-slip wall (adiabatic), far-�eld, symmetry boundaries, inlet boundaries (total conditions or
prescribed mass �ow), and outlet boundaries (back pressure prescribed).
This particular incompressible implementation is based on the arti�cial compressibility formulation by Chorin
[55], that is valid only for steady-state problems de�nition.
A typical problem regarding this particular formulation is the convergence speed of the calculations using an
Euler implicit integration scheme, expecially for low Mach number �ows [56].
However, implicit Euler schemes are the most robust ones and are widely used for CFD applications, reason
for which its usage in the remainder of the thesis.
Related to the convergence issue that is experienced with this kind of solvers, the choice of the optimal value
for the β parameter in�uences considerably the convergence capabilities of the calculations.
In [56], a sensitivity study regarding the arti�cial compressibility factor for a low Mach number �ows has
been performed, showing that the optimal value is believed to be around β = 1. This optimal value allows
a clear improvement in the convergence speed. This value is con�rmed by an order of magnitude analysis
of β that is conducted in [57]. If values greater or lower than β = 1 are considered, the convergence speed
decreases drastically.
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4.3 Turbulence Models Test Case

Given the previous considerations, during the test case phase of this thesis, a signi�cant number of simulations
were conducted, in order to investigate the solver capabilities and identify a suitable solver set-up for the
�nal simulations. In the remainder of the chapter, the most signi�cant results of all the simulations run is
presented. As an initial test case, it was decided to compare the turbulence models implementations present
in SU2, to test their accuracy. The aim of this test case was to reproduce the experimental data of the lift,
drag and pressure coe�cient of the FFA-W3-241 airfoil section. Since the computational time required to
run a 3D simulation was already seen to be considerably high at this stage of the thesis, only 2D simulations
were considered, reproducing the Smooth airfoil con�guration experimental data.

4.3.1 Pre-Processing

In the Pre-Processing phase, the CAD model and the mesh grid are generated. The complete description of
the mesh generation process can be found in Appendix B.
As for the CAD model, a zero-thickness surface delimited by the airfoil pro�le was created. This was
done in SolidWorks, importing the airfoil coordinates through the Curve Through XYZ Points feature, and
subsequently using the Filled Surface function for the generation of the zero thickness surface. The airfoil
chord considered is the unitary chord c = 1.
The CAD model created was imported in Pointwise to generate the mesh of the 2D �ow domain for the
subsequent calculations. Connectors were created on the model imported, with the Connectors On Database
Entities feature. After this, 250 nodes were assigned to the connectors on the suction side and on the pressure
side of the airfoil, and 3 nodes to the connector of the blunt trailing edge. The O-Grid domain was created
using the Hyperbolic Normal Extrusion feature, selecting all the connectors of the airfoil pro�le. The settings
for the Normal Extrusion performed were:

� Method: Geometric Progression

� Initial ∆s = 4.56e− 6

� Growth Rate: 1.088

� Stop Conditions: Total Height=500

The initial ∆s was calculated from the �at plate boundary layer theory as presented in [14]:

Rex =
ρU∞c

µ
⇒ Cf =

0.026

Re
1/7
x

⇒ τwall =
CfρU

2
∞

2
⇒ Ufric =

√
τwall
ρ

⇒ ∆s =
y+µ

Ufricρ
(4.2)

where ρ is the air density, U∞ the free-stream velocity, c the airfoil chord, µ the dynamic viscosity, Rex the
Reynolds number related to the airfoil chord length, Cf the skin friction coe�cient, τwall the shear stress at
the wall, Ufric the friction velocity, and y+ the dimensionless wall distance. To calculate the ∆s spacing,
the values of ρ, U∞, c, and µ have to be given together with the desired y+. For these test cases, a y+ = 1
is speci�ed. The resulting ∆s value is halved, since it was seen that when using the original value computed
with Equation (4.2), a y+value slightly greater than 1 was obtained in the results. To resolve properly the
boundary layer region, a y+ ≤ 1 should be ensured in all parts for the cells adjacent to the airfoil pro�le.
The Growth Rate value was chosen to allow a su�cient number of cells in the normal direction to the airfoil
pro�le, up to a distance d = c, with c being the airfoil chord. Resolving with a proper number of cells
the region around the airfoil, up to a distance of one airfoil chord from the pro�le, was seen to ensure a
good accuracy in the results from the simulations. With a Growth Rate of 1.088, 70 nodes in the normal
direction were achieved. The Total Height value of the Stop Conditions ensures a domain boundary distant
enough from the airfoil pro�le, to avoid the in�uence of the far�eld boundary condition used for this domain
boundary. The �uid domain external boundary is, therefore, distant from the airfoil pro�le 500 times the
airfoil chord.
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4.3.2 CFD Simulations Set-up

After creating the mesh grid, the CFD simulations can be run. All the turbulence models available in the
SU2 solver were tested, that is, the Menter's Shear Stress Transport (SST), without a transition model [58],
and the Spalart�Allmaras (SA), with the Bas-Cakmakcioglu (B-C) transition model [59]. The SU2 solver
is set up through a con�guration text �le for each case considered. In this text �le, the initial conditions
speci�ed are the free-stream �ow properties, that is:

� the free-stream density ρ and the dynamic viscosity µ, and

� the free-stream velocity components as (u, v, w) = U∞(cos(α), sin(α), 0).

In addition to these conditions, the Reynolds reference length c, corresponding to the airfoil chord, is speci�ed
as well. These values are introduced as an input in nondimensionalized quantities, allowing an easier set-up
for each case. Considering the free-stream density ρ and the free-stream velocity magnitude U∞, nondimen-
sionalizing these values by the free-stream �ow conditions result in unitary values ρadim = 1 and U∞adim

= 1
(the free-stream values are the same ρ and U∞ values). The Reynolds reference length is for all the cases
c = 1, since the nondimensionalized pro�le coordinates are used. The nondimensionalization allows to input
the dynamic viscosity as the reciprocal of the Reynolds number µ = 1/Re, simplifying the con�guration �le
set-up. In addition to this, the free-stream velocity can now be simply inputted as the cosine and the sine of
the simulated angle of attack.
The considered angles of attack are related to the simulation of a complete 2D polar curve, that is: α = −4.4◦,
α = −2◦, α = −0.3◦, α = 0.9◦, α = 2.4◦, α = 4◦, α = 5.4◦, α = 7.1◦, α = 8.8◦, α = 10.2◦, α = 12.6◦,
α = 14.4◦, α = 16.4◦, and α = 18.6◦.
Regarding the numerical schemes adopted for the �ow numerical method set-up, it was decided to use the
following:

� the JST model for the discretization of convective �uxes terms [60],

� the MUSCL scheme for the spatial discretization (2nd order scheme), and

� the Euler Implicit scheme for the time discretization.

As for the numerical schemes regarding the turbulent equation discretization, the following were chosen:

� a scalar upwind discretization for the convective �uxes terms,

� a 1st order scheme for the spatial discretization, and

� an Euler Implicit scheme for the time discretization.

In addition to the set-up described so far, the Multigrid algorithm implemented in the solver is used to
accelerate the convergence of the simulation. This is adapted as follows:

� the Multigrid cycle type �W� was chosen;

� a total of 3 multigrid coarsening levels were chosen;

� the damping restriction factor value is 0.65;

� the damping prolongation factor value is 0.65;

� the pre-smooth number of cycles for each coarsening level is chosen as follows (1,1,1,1) (the �rst number
refers to the original grid provided in input, to which apply the pre-smoothing cycles);

� the post-smooth number of cycles for each coarsening level is chosen as follows (1,1,1,1) (the �rst number
refers to the original grid provided in input, to which apply the post-smoothing cycles);
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The boundary conditions used for the simulations are:

� wall boundary condition, used for the airfoil pro�le, and

� far�eld boundary condition, used for the external boundary delimiting the O-Grid mesh created.

The Courant-Friedrichs-Lewy (CFL) condition of the �nest computational grid (the original grid provided in
input) is ensured to be CFL = 1.
The convergence criterion for all the simulations was a reduction of the residuals order of magnitude 10−14.
The residuals are calculated as the log10 of the L-2 norm of original residuals for the entire computational
domain. A High Performance Computing facility is used to run the aforementioned cases, and each simulated
case is run on a single node consisting of 24 cores. All the simulations were run for a total of 150.000 iterations,
corresponding to approximately 8 hours of computational time.

4.3.3 Results

With the simulations' set-up described in 4.3.2, the results for the two considered turbulence models are
compared in terms of their lift and drag coe�cients.
The values of the lift and drag coe�cients are obtained from the log.txt �le resulting from the SU2 simulations,
and are shown in Figure 4.3 and Figure 4.4.
From Figure 4.3, it can be seen that the SA model with the B-C transition model is able to capture the linear
portion of the lift curve with a very good accuracy, from an angle of attack of α = −4.4◦ to α = 7.1◦. When
approaching stall conditions for the considered airfoil section, that can be evinced from the experimental curve
shown, it can be seen that the simulation values of the lift coe�cient start to deviate from the experimental
curve considerably. The critical angle of attack and the corresponding lift coe�cient value are overpredicted.
The critical conditions are identi�able from the experimental values at an angle of attack of α = 10.2◦, with
a corresponding lift coe�cient value of CL = 1.37, whereas the simulations show a critical condition at an
angle of attack of α = 14.4◦, with a lift coe�cient value of CL = 1.67.
When considering the SST model without transition, in the linear portion of the lift coe�cient curve, it
can be seen that the lift coe�cient values are underpredicted, with respect to the experimental reference
values. This is in agreement with the fact that the SST turbulence model considered refers to fully turbulent
�ow conditions, being a transition model not implemented at the moment of writing this thesis. The �ow
conditions that are being simulated are only comparable with experimental values that are related to not fully
developed turbulent �ow conditions, such as the values considered in this comparison. These �ow conditions
require a �ow-transition detection, since the airfoil experiences laminar �ow conditions in the initial portion of
the airfoil surface. Therefore, a turbulence model without a suitable transition model is not able to represent
the �ow conditions investigated for the Smooth case presented in the reference paper.
Regarding the stalled �ow conditions, it can be seen that the simulations results are closer to the experimental
values in terms of lift coe�cient. From a qualitative point of view, this portion of the lift curve is better
captured than the curve resulting from the simulations with the SA Turbulence model with the B-C transition
model implementation. It can be seen, in fact, that with the SST turbulence model, the critical condition
is identi�able at an angle of attack of α = 12.6◦, with a lift coe�cient value of CL = 1.39. Therefore, this
condition is still overpredicted but with less di�erence from the experimental reference.
Regarding the comparison of the turbulence models related to the drag coe�cient values obtained, shown
in Figure 4.4, in the region where the drag coe�cient is characterized typically by a constant value, the
simulations considering the SA model with the B-C transition model show a very close prediction with the
experimental reference values. The critical condition from the simulations is again identi�able at an angle of
attack of α = 14.4◦, con�rming what was obtained from the �gure of the lift coe�cient comparison.
The SST model shows a general overprediction in the constant-value portion of the drag coe�cient curve.
Under stalled �ow conditions, the drag coe�cient's results obtained with this model are closer to the exper-
imental values, as seen in the lift coe�cient values as well.
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Figure 4.3: Turbulence models comparison by means of the resulting lift coe�cient
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Figure 4.4: Turbulence models comparison by means of the resulting drag coe�cient
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From the simulations run, the results in terms of pressure coe�cient values are compared as well, as can be
seen in Figure 4.5 and Figure 4.6.
The pressure coe�cient values are obtained directly from the surface_�ow.csv �le resulting from the SU2
simulations. The cases considered are related to an angle of attack α = 8.8◦, characterizing an incipient
stalled �ow condition, and to an angle of attack of α = 16.4◦, describing a developed stalled �ow condition.
From Figure 4.5 describing the case at α = 8.8◦, it can be seen that at the suction side, the results using
the SA with the B-C transition model show a general overprediction of the data until the x/c = 0.7 location.
Around the leading edge and trailing edge location, at the suction side, these simulation values are close to
the experimental data. As for the pressure side, it can be seen that at the leading edge, the results provided
by the simulations are close to the experimental values, whereas at the trailing edge they are considerably
distant from the experiments curve.
Regarding the pressure coe�cient values obtained with the SST model, these are overall closer to the ex-
perimental values. Around the leading edge location at the suction side, it can be seen that the SST model
overpredicts the pressure coe�cient values. Therefore, it can be stated that the SST model is predicting the
pressure coe�cient distribution better than the SA with the B-C transition model, as was highlighted from
the previous lift and drag coe�cient �gures.
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Figure 4.5: Turbulence models comparison by means of the resulting pressure coe�cient,
for the angle of attack of α = 8.8◦

In Figure 4.6, it can be seen that the pressure coe�cient values at the pressure side are close to the experi-
mental values. At the suction side, the pressure coe�cient distribution shows a general overprediction in the
�rst half of the airfoil pro�le, up to x/c = 0.4. For the remaining portion of the airfoil pro�le, the simulation
values are underpredicting the experiments. This �gure is representative of a developed stalled �ow condition,
in which the separation point at the suction side can be clearly identi�ed with the location after which the
pressure coe�cient curve becomes �at. From the leading edge to the separation point, the �gure shows that
both the SST model and the SA with the B-C transition model are distant from the experimental reference
curve. After the separation point, the SST model slightly overpredicts the experimental pressure coe�cient
curve at the suction side, whereas the SA with the B-C model underpredicts considerably the reference values.
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From the evaluation of the pressure coe�cient for the α = 16.4◦ case, it can be concluded that the curve
behaviours described con�rm what was stated from the comparison of the two turbulence models by means
of the lift and drag coe�cient curves. The SST model is able to better describe stalled �ow conditions than
the SA with the B-C transition model.
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Figure 4.6: Turbulence models comparison by means of the resulting pressure coe�cient,
for the angle of attack of α = 16.4◦

4.3.4 Mesh dependency

To validate the 2D results obtained, a mesh dependency study was performed for two �ow conditions, at an
angle of attack α = 4◦ and α = 8.8◦. The turbulence model considered is the SA with the B-C transition
model. Four di�erent mesh grids were created, following the procedure described in 4.3.1. These mesh grids
were generated with a progressively increasing number of cells, changing only the Growth Rate parameter of
the Hyperbolic Normal Extrusion as reported in Table 4.1.

Total number of cells Growth Rate of the Hyperbolic Normal Extrusion
95500 1.088
177000 1.04
274500 1.02
333000 1.01

Table 4.1: Computational grids created for the mesh dependency study

The results are presented in terms of pressure coe�cient curves in Figure 4.7. It can be seen from both plots
that the pressure coe�cient curves for the four cases considered coincide. The results from the simulations
are, therefore, independent from the mesh provided as an input, con�rming that the simulations using the
coarsest mesh of 95500 cells provide accurate results.
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Figure 4.7: Mesh dependency results in terms of pressure coe�cient values. The top
image refers to the α = 4◦ �ow condition. The bottom image refers to the α = 8.8◦ �ow
condition.
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4.4 Far�eld Boundary Condition Test Case

As a �nal test case, it was decided to verify the far�eld boundary condition implementation present in SU2,
to test its in�uence on the solutions obtained from the solver. Therefore, in this test case the lift and drag
coe�cients values are considered, for the FFA-W3-241 airfoil section at an angle of attack of α = 4◦. 2D
simulations were run, comparing the values from the simulations with the experimental reference ones.

4.4.1 Pre-Processing

The CAD model creation and the mesh-grid generation procedure are the same as the ones described in 4.3.1.
The only di�erence is the Stop Conditions: Total Height parameter, that is changed accordingly with the
desired far�eld distance to investigate.
A total of 8 di�erent far�eld distances were considered, from a distance of 500c to a distance of 20c, with c
being the airfoil chord.
Mantaining the same settings of the previous cases in 4.3.1 ensured a constant grid resolving of the boundary
layer region, so that the in�uence of the far�eld boundary condition regarding the lift and drag coe�cients
values could be evaluated without considering the e�ect of a di�erent grid re�nement.

4.4.2 CFD Simulations Set-Up

All the con�guration settings reported in 4.3.2 were used in these test cases as well. The computational time
and convergence criteria were approximately the same too. In the cases were the far�eld distance was lower,
this resulted in less computational cells created, therefore allowing a slight computational time saving.

4.4.3 Results

The results from this test case are reported in Table 4.2 and Figure 4.8.
Regarding the lift coe�cient values, it can be seen from Figure 4.8 that decreasing the far�eld distance
from the airfoil pro�le decreases progressively the lift coe�cient values. When considering the in�uence on
the drag coe�cient, lowering the far�eld distance is seen to increase the drag. Comparing the di�erent lift
coe�cient values with the experimental reference data, it can be seen that from a far�eld distance of 300c
on to lower distances, the lift computed from the simulations results in underpredicted values. As for the
drag, it is seen that generally the increased far�eld distance causes larger overprediction of the corresponding
computed values.

Far�eld Distance Lift Coe�cient Drag Coe�cient
500*c 0.800619 0.012736
400*c 0.798316 0.012938
300*c 0.792990 0.013427
200*c 0.794651 0.013296
100*c 0.790585 0.013717
60*c 0.788235 0.013999
40*c 0.784383 0.014434
20*c 0.773285 0.015655

Table 4.2: Far�eld test case results in terms of lift and drag coe�cient. The airfoil
considered is the FFA-W3-241 at an angle of attack of α = 4◦.
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Figure 4.8: Far�eld test case results in terms of lift and drag coe�cient. The airfoil
considered is the FFA-W3-241 at an angle of attack of α = 4◦. The top image shows the
lift coe�cient results. The bottom image shows the drag coe�cient resulting values.
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4.5 Conclusions

In this chapter the initial test-cases phase of this thesis is presented. The reference paper for the experimental
data to test is �rst introduced, describing brie�y how the data were obtained.
The SU2 incompressible solver is then described, highlighting its set-up complications due to the particular
solver formulation.
Then the test cases conducted are reported. Two main test cases were considered, one testing the turbulence
models' accuracy in terms of lift, drag and pressure coe�cient values, and another verifying the in�uence of
the far�eld boundary condition regarding the lift and drag coe�cient values obtained.
The test cases run for the turbulence models show that the SA turbulence model with the B-C transition
model is able to reproduce better the experimental results, when considering �ow conditions characterizing
the linear portion of the lift coe�cient curve, that is non stalled �ow conditions. The SST model implemented
is instead able to capture more accurately the �ow features of stalled �ow conditions. These results will be
used when setting up the �nal simulations, di�erentiating the set-up with regards to the �ow condition
considered. The main interest of this thesis is demonstrating the SU2 solver capabilities in resolving properly
the �ow conditions investigated with respect to the experimental reference data, thus a suitable choice of
turbulence models is necessary in light of these results.
The test case run verifying the in�uence of the far�eld boundary condition shows that, when considering a
distance from the airfoil pro�le not far enough, the lift coe�cient values decrease progressively as shorter
distances are used, with a corresponding increase in the drag coe�cient values. With this information, the
choice of the far�eld distance from the airfoil pro�le will be maintained at a value of 500 times the airfoil
chord length, since this value is regarded to be far enough for the simulations to not be in�uenced by it.
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Chapter 5

Methodology

In this chapter the methodology followed in the Pre-Processing, in the CFD Simulations Set-Up and in the
Post-Processing phases is presented.
First, the experimental reference is introduced, providing the geometrical parameters to recreate the experi-
mental con�gurations for the simulations.
Then, the Pre-Processing phase is brie�y described. This phase involves the CAD model creation and the
computational mesh generation process.
In the CFD Simulations Set-Up section, the numerical models and the set-up of the con�guration �les that
are used to run the simulations are reported.
In the �nal part of the methodology, the Post-Processing phase is described in detail, indicating the procedures
used to create each �gure presented in the Results chapter.

5.1 Experimental Reference

The reference paper is [23]. In this paper, the airfoils are tested both as simple extruded airfoils shape and
as extruded airfoils with vortex generators placed on the top surface.
The vortex generators tested experimentally are the typical triangular vanes, placed orthogonally to the
airfoil surface. They are arranged in a common-�ow-down con�guration, that is, an arrangement in pairs
with equal and opposite angles, calculated relatively to the airfoil chord. Their height increases towards the
airfoil trailing edge.
The Reynolds number used is Re = 1.6 ∗ 106, for all the experiments conducted, and the turbulence intensity
at the inlet of the test section is 1%.
The VG design con�gurations considered in the reference paper are the ones depicted in Figure 5.1, where
the corresponding geometrical dimensions are displayed.
In the simulations performed in this thesis, only the FFA-W3-241 and the FFA-W3-301 airfoil pro�les are
considered.
Out of all the con�gurations presented in the paper, the ones simulated are:

� For the FFA-W3-301 airfoil pro�le:

� Smooth, the con�guration without VGs mounted on top of the suction side surface,

� VG x/c=0.2 h=6mm, the con�guration with a VG strip placed at a normalized streamwise position
of x/c=0.2, characterized by VGs with a height of h=6mm

� VG x/c=0.3 h=6mm, the con�guration with a VG strip placed at a normalized streamwise position
of x/c=0.3, characterized by VGs with a height of h=6mm
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� For the FFA-W3-241 airfoil pro�le:

� Smooth, the con�guration without VGs mounted on the top surface,

� VG x/c=0.2 h=4mm, the con�guration with a VG strip placed at a normalized streamwise position
of x/c=0.2, characterized by VGs with a height of h=4mm

� VG x/c=0.2 h=6mm, the con�guration with a VG strip placed at a normalized streamwise position
of x/c=0.2, characterized by VGs with a height of h=6mm

� VG x/c=0.3 h=6mm, the con�guration with a VG strip placed at a normalized streamwise position
of x/c=0.3, characterized by VGs with a height of h=6mm

Figure 5.1: Original VG geometrical dimensions from [23]. In the top image the dimen-
sions for the VG with height h=4mm are shown. In the bottom image the dimensions
for the VG with height h=6mm are instead displayed. The dimensions reported are in
millimeters.

The airfoil chord considered was the unitary chord c = 1, enabling the original normalized airfoil coordinates
to be used. Following this choice, the VG dimensions were appropriately changed as shown in Figure 5.2. It
was decided to reduce the computational domain to half the original VG pair domain, for reasons related to
the boundary conditions available in the solver, as explained in Section �5.3.

56



Chapter 5: Methodology

0,0133 m 0,0333 m

0,0066 m 0,0166 m

0,02 m

0,0066 m

0,00033 m

Airfoil section with VG reproduced

Flow

0,0166 m 0,04166 m

0,00833 m 0,020833 m

0,03 m

0,01 m

0,00033 m

Flow

Airfoil section with VG reproduced

Figure 5.2: Scaled dimensions for the airfoil sections with VG reproduced. In the top
image the dimensions used for the VG cases with height h=4mm are displayed. In the
bottom image the dimensions used for the VG cases with height h=6mm are instead
shown.
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5.2 Pre-Processing

In this section the CAD model creation and the mesh generation process are presented. For the CAD model
creation, only a brief explanation is provided, since this step of the Pre-Processing phase is easily reproducible
without the need for a detailed description. As for the mesh generation process, this is only summarized,
since the complete mesh generation process is reported in Appendix C and Appendix D.

5.2.1 CAD Model Creation

Prior to executing the simulations, a 3D CAD model needs to be created to reproduce the half section
depicted in Figure 5.2.
The 3D CAD model is generated using the commercial software SolidWorks. The steps to create the 3D CAD
model, for both the Smooth and the VG simulations, can be summarized in the following steps:

1. Import the airfoil pro�le coordinates from the corresponding text �le (in Solidworks this could be
achieved using the Curve Through XYZ Points feature)

2. Create 2 planes parallel to the airfoil pro�le imported in step 1. These 2 planes are positioned at
an equal and opposite distance from the airfoil pro�le. On these planes project the airfoil pro�le.
Then, from the 2 projected pro�les, create the extruded airfoil section using a Loft-like function. This
produces a better 3D model of the airfoil section, as can be seen in Figure 5.3. In SolidWorks this was
achieved using the Loft function.

Figure 5.3: Smooth airfoil section extruded
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3. In case an additional VG CAD model has to be created for the corresponding simulations:

(a) Create a plane parallel to the airfoil pro�le imported in step 1, at a speci�ed distance from the
minimum-spanwise-coordinate plane created in step 2. On this plane, a vertical line is drawn at
the VG leading edge streamwise position, intersecting the suction side surface of the airfoil section,
as seen in Figure 5.4.

Figure 5.4: Plane created to position the VG at the given streamwise coordinate location

(b) Create a plane using the vertical line as reference, and specifying an inclination angle equal to the
VG inclination angle, as shown in Figure 5.5. On this plane, the trapezoidal sketch of the VG is
created.

Figure 5.5: The plane created for the VG sketch is shown in the left �gure. The trapezoidal
VG sketch is shown in the right �gure.
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(c) Project this sketch on the two extreme planes delimiting the airfoil section, that were created in
step 2, as shown in Figure 5.6.

Figure 5.6: VG sketch projected on the side planes.

(d) Create 2 extruded lofts, from the VG sketch to both opposite projected sketches created in (c).
These lofts are representative of the mesh blocking strategy used to create the computational grid
for the simulations, as it can be seen in Figure 5.7.

Figure 5.7: VG blocks for the mesh blocking strategy.

The VG was modeled as a 2D surface of zero thickness that is shared between the two lofts created in (d).
It was determined to create a trapezoidal pro�le for the VG, considering the base band thickness together
with the triangular shape of the actual VG. The resulting trapezoidal sketch allows an easier mesh creation
on the VG surface.
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5.2.2 Mesh Generation Process

After the CAD model design phase, the computational grid is created using the commercial software Point-
wise. The main steps for the creation of the 3D grid representing the �ow domain are the following:

1. Import the CAD model and create connectors on the database entities imported, as shown in Figure 5.8.

Figure 5.8: CAD model imported

2. When a VG case is considered:

(a) Mirror the trapezoid blocks as in Figure 5.9.

Figure 5.9: VG trapezoid blocks mirrored

(b) Create a 2D mesh for each surface of the original and mirrored VG blocks.
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(c) Create the 3D mesh blocks from the mesh surfaces generated in (b), as shown in Figure 5.10.

Figure 5.10: Mesh surfaces for the VG trapezoid blocks.

3. Generate the airfoil surface mesh. When a VG case is considered, the surface mesh for the portion of
the surface not occupied by the presence of the original and mirrored VG blocks is generated.

Figure 5.11: Airfoil surface mesh.
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4. Generate the 3D grid for the �ow domain, using the hyperbolic normal extrusion feature as follows:

(a) If a Smooth case is considered, generate directly the whole �ow domain grid extruding from the
airfoil surface, as it can be seen in Figure 5.12.

Figure 5.12: Generated 3D �ow domain mesh for the Smooth airfoil case.

(b) If a VG case is considered, an extrusion from the airfoil surface is �rst generated, to match the
mesh surfaces of the VG base band. Subsequently, select all the outer spanwise mesh surfaces
generated, and extrude them to create the �nal �ow domain. This can be seen in Figure 5.13 and
Figure 5.14.

Figure 5.13: First boundary layer normal hyperbolic extrusion
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Figure 5.14: Generated 3D �ow domain mesh for VG airfoil cases.

The blocking strategy, used for resolving the �ow domain near the VG, is chosen in order to create a more
uniform cell distribution in the vicinity of the VG surface modeled. If the VG blocks are not mirrored, the
trapezoidal shape introduced will cause an excessive cell stretching in the region immediately downstream of
the VG.
In the hyperbolic normal extrusion phase, the initial grid spacing of the �rst cells adjacent to the airfoil
surface and the growth ratio of the subsequent extruded cells have a fundamental importance in properly
resolving the boundary layer.
The initial grid spacing value ∆s is derived from the �at plate boundary layer theory as presented in [14]:

Rex =
ρU∞c

µ
⇒ Cf =

0.026

Re
1/7
x

⇒ τwall =
CfρU

2
∞

2
⇒ Ufric =

√
τwall
ρ

⇒ ∆s =
y+µ

Ufricρ

where ρ is the air density, U∞ the free-stream velocity, c the airfoil chord, µ the dynamic viscosity, Rex the
Reynolds number related to the airfoil chord length, Cf the skin friction coe�cient, τwall the shear stress at
the wall, Ufric the friction velocity, and y+ the dimensionless wall distance.
To calculate the ∆s spacing, the values of ρ, U∞, c, µ have to be provided together with the desired y+. For
all the cases simulated, a y+ = 1 is speci�ed.
For the whole hyperbolic normal extrusion, a growth factor of less than 10%, with respect to the previous cell
progressively generated, is ensured. This provides an adequate number of cells in the boundary layer region.
The maximum extrusion distance was guaranteed to be 500 times the chord length, to avoid any possible
in�uence of the far�eld boundary condition, as highlighted in Chapter 4.
The mesh generated is of the O-Grid type, with approximately 2.5 million cells in the VG cases, and 1.5
million cells for the Smooth cases.
The cells created have a hexahedral shape throughout the whole computational domain.
The mesh quality metrics Equiangular Skewness and Aspect Ratio indicate that the grids created are of
appropriate quality. An Equiangular Skewness maximum value of 0.63 is ensured for both the Smooth and
the VG cases. As for the Aspect Ratio, this metric presents large values in the boundary layer region,
expecially in the very �rst cells adjacent to the airfoil surface with Aspect Ratio values of 24000. This
is due to the very thin spanwise distance considered in choosing the geometrical boundaries of the �ow
domain to be simulated. These boundaries choice follows from the geometrical parameters of the original
VG con�guration tested in the reference paper, and therefore can not be avoided. Since all the cells on the
airfoil surface are of the hexahedral type, normal to the surface and following the airfoil pro�le curvature,
it is possible to conclude that even with these high Aspect-Ratio-values the cells created are of acceptable
quality. The constraint imposed of cells normal to the airfoil pro�le introduces more computational bene�ts
than disadvantages.
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5.3 CFD Simulations Set-Up

After creating the grids for all the con�gurations, the simulations can be run.
It was determined to run the con�gurations mentioned previously at angles of attack that hypothetically
would refer to stalled conditions, or near-stalled conditions. These angles of attack are chosen by visually
inspecting the lift coe�cient and drag coe�cient curves, identifying the �ow conditions around the maximum
lift coe�cient value after which the airfoils are proved to stall.
In addition to this selection of angles of attack conditions, the test-cases run in Chapter 4 are used to select
the turbulence model that allows the best �ow results. The di�erence in turbulence models employed is due
to the fact that the current SU2 implementation does not provide full set of turbulence models yet. The
models implemented are the Spalart�Allmaras (SA) [61] and the Menter's Shear Stress Transport (SST) [58].
For the SA model, the transition is considered using the Bas-Cakmakcioglu (B-C) transition model [59],
whereas for the SST model no transition model implementation is present so far.
From the test cases, it is seen that the SA model, with the transition phenomena described by the B-C
model, predicts the �ow in the boundary layer, up to the expected maximum lift coe�cient, with good
accuracy. The linear portion of the lift coe�cient matches the experimental results. When approaching
stalled conditions, this model departs from the experimental results considerably. Therefore, being the SST
model known to capture best the �ow features under developed turbulent conditions like the ones in deep
stall, from the expected point of maximum lift coe�cient on, the SST model is chosen instead of the SA
B-C used previously. In the following simulations the SA B-C model is used for most of the cases, to try to
capture the transition �ow region inevitably experienced by the airfoils considered.
The complete list of choices for the turbulence models is reported in Table 5.1 for the FFA-W3-241 airfoil
section, and in Table 5.2 for the FFA-W3-301 section:

Angle of
Attack

Smooth VG x/c=0.2
h=4mm

VG x/c=0.2
h=6mm

VG x/c=0.3
h=6mm

8.8° SA B-C Model SA B-C Model SA B-C Model SA B-C Model
10.2° SST Model SST Model SST Model SST Model
12.6° SST Model SST Model SST Model SST Model
14.4° SST Model SST Model SST Model SST Model

Table 5.1: Turbulence models-choice for the FFA-W3-241 simulated cases

Angle of Attack Smooth VG x/c=0.2 h=6mm VG x/c=0.3 h=6mm
9° SA B-C Model SA B-C Model SA B-C Model

11.2° SA B-C Model SA B-C Model SA B-C Model
12.9° SA B-C Model SA B-C Model SA B-C Model
14.6° SA B-C Model SA B-C Model SA B-C Model

Table 5.2: Turbulence models-choice for the FFA-W3-301 simulated cases

The SU2 solver is set-up through a con�guration text �le for each case considered.
In this text �le the initial conditions speci�ed are the free-stream �ow properties, that is:

� the free-stream density ρ and the dynamic viscosity µ, and

� the free-stream velocity components as (u, v, w) = U∞(cos(α), sin(α), 0).

In addition to these conditions, the Reynolds reference length c, corresponding to the airfoil chord, is speci�ed
as well.
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These values are introduced as an input in nondimensionalized quantities, allowing an easier set-up for each
case.
Considering the free-stream density ρ and the free-stream velocity magnitude U∞, nondimensionalizing these
values by the free-stream �ow conditions results in unitary values ρadim = 1 and U∞adim

= 1 (the free-stream
values are the same ρ and U∞ values). The nondimensionalization, together with the Reynolds reference
length, that is for all the cases c = 1 since the nondimensionalized pro�le coordinates are used, allows to
input the dynamic viscosity as the reciprocal of the Reynolds number µ = 1/Re, simplifying the con�guration
�le setup. In addition to this, the free-stream velocity can now be simply inputted as the cosine and the sine
of the simulated angle of attack.
Regarding the numerical schemes adopted for the �ow numerical method set-up it was decided to use the
following:

� the JST model for the discretization of convective �uxes terms [60],

� the MUSCL scheme for the spatial discretization (2nd order scheme), and

� the Euler Implicit scheme for the time discretization.

As for the numerical schemes regarding the turbulent equation discretization, the following were chosen:

� a scalar upwind discretization for the convective �uxes terms,

� a 1st order scheme for the spatial discretization, and

� an Euler Implicit scheme for the time discretization.

In addition to the set-up described so far, the Multigrid algorithm implemented in the solver is used to
accelerate the convergence of the simulation. This is adapted as follows:

� the Multigrid cycle type �W� was chosen;

� a total of 2 multigrid coarsening levels were chosen;

� the damping restriction factor value is 0.65;

� the damping prolongation factor value is 0.65;

� the pre-smooth number of cycles for each coarsening level is chosen as follows (1,1,0) (the �rst number
refers to the original grid provided in input, to which apply the pre-smoothing cycles);

� the post-smooth number of cycles for each coarsening level is chosen as follows (1,1,1) (the �rst number
refers to the original grid provided in input, to which apply the post-smoothing cycles);

The boundary conditions used for the simulations are:

� wall boundary condition, used for the airfoil and VG surfaces,

� far�eld boundary condition, used for the most external grids delimiting the O-Grid mesh created, in the
spanwise direction,

� symmetry boundary condition, used for the lateral grid surfaces delimiting the O-Grid mesh.

The choice to reproduce half of the original strip section with the VG pair is considered to reduce the size
and the number of grid cells of the computational mesh. At the lateral boundaries of the �ow domain, the
symmetry boundary condition ensures that the VG pair e�ect is reproduced correctly.
The Courant-Friedrichs-Lewy (CFL) condition of the �nest computational grid (the original grid provided in
input) is ensured to be CFL = 1.

66



Chapter 5: Methodology

The convergence criteria for all the simulations was a reduction of the residuals order of magnitude of 10−8.
The residuals are calculated as the log10 of the L-2 norm of original residuals of the entire computational
domain.
A High Performance Computing facility is used to run the aforementioned cases, and each case simulated
is run on a single node consisting of 24 cores. All the simulations were run for a total of 80.000 iterations,
corresponding to approximately 5 days of computational time. This time constraint was quite prohibitive,
and therefore a mesh dependency study was not performed, since it would have required an excessive amount
of time for each case considered. The mesh dependency performed in Chapter 4, for the 2D airfoil pro�le, was
considered to validate the grid re�nement chosen for the �nal 3D cases run. Therefore, the same boundary
layer grid re�nement was ensured at each spanwise position, in order to validate the simulations to run.

5.4 Post Processing

In the Post Processing phase, the data was extracted from the simulations to produce the �gures displayed
in Chapter 6. In the extraction phase, the open-source software Paraview is used, exploiting the Python
scripting capabilities provided with this software. The plots were created using both the R language and the
Python language. The extraction phase and the subsequent �gure creation step are therefore fully automated.
An example of the scripts created can be found in Appendix E and Appendix F.
In the following subsections, the data extraction procedures and the consequent post-processing steps for the
�gures created are explained.

Figure 6.1

In this �gure, the lift coe�cient and drag coe�cient data are shown, comparing the experimental values and
the simulations results for the FFA-W3-301 airfoil section.

Experimental Data

The experimental data displayed are obtained from the reference paper [23], digitizing Figure 10-3 and Figure
10-4 from the mentioned document.

Simulations Data

The simulation data are obtained directly from the log �le output of the SU2 simulations.

Figure Creation

The �gure is created by combining all the single plots for the Smooth, the VG x/c=0.2 h=6mm and the VG
x/c=0.3 h=6mm con�gurations in a unique �gure.

Figure 6.2

In this �gure, the lift coe�cient and drag coe�cient data are shown, comparing the experimental values and
the simulations results for the FFA-W3-241 airfoil section.

Experimental Data

The experimental data displayed are obtained from the reference paper [23], digitizing Figure 5-3 and Figure
5-4 from the mentioned document.
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Simulations Data

The simulation data are obtained directly from the log �le output of the SU2 simulations.

Figure Creation

The �gure is created by combining all the single plots for the Smooth, the VG x/c=0.2 h=4mm, the VG
x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm con�gurations in a unique �gure.

Figure 6.3

In this �gure, the pressure coe�cient data are shown, comparing the experimental values and the simulations
results for the FFA-W3-241 airfoil section.

Experimental Data

The experimental data displayed are obtained from the reference paper [23], digitizing the following �gures
from the mentioned document:

� Figure 4-1 for the Smooth case experimental values, considering the angles of attack α = 8.8°, α = 10.2°,
α = 12.6°, α = 14.4°;

� Figure 5-1 for the experimental values of the VG x/c=0.2 h=4mm, the VG x/c=0.2 h=6mm and the
VG x/c=0.3 h=6mm cases, at an angle of attack of α = 10.2◦;

� Figure 5-2 for the experimental values of the VG x/c=0.3 h=6mm at an angle of attack α = 14.4°.

For the VG x/c=0.2 h=4mm case in Figure 5-1, the original angle of attack reported in [23] is α = 10.1◦. For
consistency with the simulations data obtained at an angle of attack of α = 10.2◦, in the remainder of the
thesis, these experimental values are referred to as related to the α = 10.2◦ angle of attack. This choice was
made to be able to compare di�erent VG con�gurations at the same angle of attack, since both the Smooth
and the VG cases remaining are reported for α = 10.2◦.
It is believed that the di�erence between the angle of attack actually tested in the experiments (α = 10.1◦),
and the one considered for the simulations to compare the experiments with (α = 10.2◦), will not add a
considerable error to the qualitative discussion related to the VG x/c=0.2 h=4mm plot.
The same reasoning applies to the VG x/c=0.3 h=6mm case in Figure 5-2, where the original angle of
attack is α = 14.0°. This experimental case will be referred to as the α = 14.4◦, hypothesizing again not an
appreciable qualitative di�erence with the simulations considered. The angle of attack α = 14.4◦ chosen for
the simulations allows a comparison with the corresponding Smooth case.

Simulations Data

The simulation data are obtained extracting the pressure coe�cient values already present in the sur-
face_�ow.vtk �les, created during the SU2 simulations.
If a VG solution is considered, �rst the VG surface mesh coordinates are extracted from the corresponding
.pw �le. This is achieved selecting the grid surface interactively in Pointwise, exporting it in the .cgns �le
format. Obtaining the VG coordinates allows, in the following data extraction phase, to skip points too close
to the VG surface. In this way points in the computational cells immediately adjacent to the VG surface are
not extracted, avoiding unwanted interpolation errors due to the underlying Paraview functions used.
The data extraction phase is described in the following steps:

1. Import data of interest. These are contained in the surface_�ow.vtk �le and in the VG_GridPoints.cgns
�le. The last �le is imported only if a VG simulation case is considered.
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2. Input the variable string name to extract, in this case the corresponding pressure coe�cient string in
the surface_�ow.vtk �le. All the variables present in this �le are �rst displayed in the standard output,
to allow the user to choose the proper string name.

3. Input whether the streamwise and spanwise locations, from which to extract the data, are to be created
linearly spaced, or are user-speci�ed.

(a) In case they are to be created linearly spaced, input �rst the number of points in the streamwise
direction to consider, and then the number of points in the spanwise direction for each streamwise
location. These linearly spaced coordinates are created between the streamwise and spanwise
airfoil surface boundaries, automatically obtained from the surface_�ow.vtk solution.

(b) In case the locations are user-speci�ed, input �rst the streamwise locations and then the spanwise
ones for each streamwise position.

4. If the simulation results, from which to obtain the pressure coe�cient data, are of a VG case simulated,
then store the coordinates near the VG surface to avoid. These coordinates are selected from the ones
created in Step 3.

5. Extract the data, avoiding in the extraction loop the coordinates stored in Step 4:

(a) First slice the surface_�ow.vtk solution with a plane normal to the streamwise axis.

(b) Then slice the extracted data from (a) with a plane normal to the spanwise axis.

(c) From the extracted data in (b), get the coordinates of the point in the upper and the one in the
lower airfoil surface (that is respectively suction side and pressure side)

(d) Find the unique indices of the points from (c), in the complete surface_�ow.vtk solution

(e) Extract the �ow variable of interest, in this case the pressure coe�cient, from the complete sur-
face_�ow.vtk solution. This is done using the unique indices from (d).

6. Store the extracted pressure coe�cient data, together with the coordinates of the locations considered,
in the corresponding .csv �les for the upper and lower airfoil surface

Figure Creation

The �gure is created by combining all the single plots for the con�gurations mentioned in the Experimental
Data subsection in a unique �gure.
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Figure 6.4

In this �gure, the pressure coe�cient data are shown, comparing the experimental values and the simulations
results for the FFA-W3-301 airfoil section.

Experimental Data

The experimental data displayed were obtained from the reference paper [23], digitizing the following �gures
from the mentioned document:

� Figure 9-1 for the Smooth case experimental values, considering the angles of attack α = 9°, α = 11.2°,
α = 12.9°, α = 14.6°;

� Figure 10-1 for the experimental values of the VG x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm cases,
at an angle of attack of α = 9◦;

� Figure 5-2 for the experimental values of the VG x/c=0.3 h=6mm at an angle of attack α = 12.9°.

The data from Figure 10-1 are originally referred to α = 9.4◦ for the VG x/c=0.2 h=6mm case, and to
α = 9.5◦ for the VG x/c=0.2 h=6mm case.
The data from Figure 5-2 are also referred to a slightly di�erent condition, that is α = 12.9◦ for the VG
x/c=0.3 h=6mm.
For analogous reasons as the ones stated for the previous cases in the Experimental Data subsection of
Figure 6.3, the data will be referred to the angle of attack of the SU2 simulations, since a negligible di�erence
regarding the qualitative behaviour of the curves displayed can be assumed.

Simulations Data

The simulation data are obtained extracting the pressure coe�cient values already present in the sur-
face_�ow.vtk �les, created during the SU2 simulations. The same extraction process described in the Simu-
lations Data subsection of Figure 6.3 is also applied in this case.

Figure Creation

The �gure is created by combining all the single plots for the con�gurations mentioned in the Experimental
Data subsection in a unique �gure.

Figure 6.5

In this �gure, the pressure coe�cient values from the simulations of the Smooth and the VG con�gurations
are compared. The results displayed are related to the FFA-W3-241 airfoil at an angle of attack of α = 10.2◦,
and to the FFA-W3-301 airfoil at an angle of attack of α = 11.2◦.

Simulations Data

The simulation data considered for the FFA-W3-241 plot are related to the Smooth, VG x/c=0.2 h=4mm,
VG x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 10.2◦.
Instead, the simulation data used for the FFA-W3-301 plot are related to the Smooth, VG x/c=0.2 h=6mm
and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 11.2◦.
The simulation data are obtained extracting the pressure coe�cient values already present in the sur-
face_�ow.vtk �les, created during the SU2 simulations.
The same extraction process described in the Simulations Data subsection of Figure 6.3 is also applied in
this case.
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Figure Creation

The plots are created importing the data stored in the .csv �les produced in the Simulations Data subsection.
The data in each of the dataframes, for the con�gurations considered, are averaged for each streamwise
location, calculating the arithmetic mean of all the spanwise locations extracted.
The �gure is created by combining the plots for the con�gurations mentioned in the Simulations Data
subsection in a unique �gure.

Figure 6.6

In this �gure, the pressure coe�cient values from the simulations of the Smooth and the VG con�gurations
are compared. The results displayed are related to the FFA-W3-241 airfoil at an angle of attack of α = 14.4◦,
and to the FFA-W3-301 airfoil at an angle of attack of α = 12.9◦.

Simulations Data

The simulation data considered for the FFA-W3-241 plot are related to the Smooth, VG x/c=0.2 h=4mm,
VG x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 14.4◦.
Instead, the simulation data used for the FFA-W3-301 plot are related to the Smooth, VG x/c=0.2 h=6mm
and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 12.9◦.
The simulation data are obtained extracting the pressure coe�cient values already present in the sur-
face_�ow.vtk �les, created during the SU2 simulations.
The same extraction process described in the Simulations Data subsection of Figure 6.3 is also applied in
this case.

Figure Creation

The plots are created importing the data stored in the .csv �les produced in the Simulations Data subsection.
The data in each of the dataframes, for the con�gurations considered, are averaged for each streamwise
location, calculating the arithmetic mean of all the spanwise locations extracted.
The �gure is created by combining the plots for the con�gurations mentioned in the Simulations Data
subsection in a unique �gure.

Figure 6.7

In this �gure, the skin friction coe�cient magnitude values from the simulations of the Smooth and the VG
con�gurations are compared. The results displayed are related to the FFA-W3-241 airfoil at an angle of
attack of α = 10.2◦, and to the FFA-W3-301 airfoil at an angle of attack of α = 11.2◦.

Simulations Data

The simulation data considered for the FFA-W3-241 plot are related to the Smooth, VG x/c=0.2 h=4mm,
VG x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 10.2◦.
Instead, the simulation data used for the FFA-W3-301 plot are related to the Smooth, VG x/c=0.2 h=6mm
and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 11.2◦.
The simulation data are obtained extracting the skin friction coe�cient values already present in the sur-
face_�ow.vtk �les, created during the SU2 simulations.
The same extraction process described in the Simulations Data subsection of Figure 6.3 is also applied in
this case, with two main di�erences:

� Only values at the suction side of the airfoil are extracted, since this is the surface where VGs are
applied, and therefore where the favourable e�ects of VGs are better appreciated.
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� From the SU2 simulations, values of skin friction along the 3D directions are provided. Since in the
plots considered the skin friction magnitude is displayed, the extraction of all the three components is
required. These skin friction values are subsequently used for calculating the skin friction magnitude
when generating the plots.

Figure Creation

The plots are created importing the data stored in the .csv �les produced in the Simulations Data subsection.
The data in each dataframe are averaged for each streamwise location, calculating the arithmetic mean of all
the spanwise locations extracted.
The skin friction coe�cient magnitude is then computed as the square root of the three skin friction compo-
nents extracted for each con�guration.
The �gure is created by combining the plots for the con�gurations mentioned in the Simulations Data
subsection in a unique �gure.

Figure 6.8

In this �gure, the skin friction coe�cient magnitude values from the simulations of the Smooth and the VG
con�gurations are compared. The results displayed are related to the FFA-W3-241 airfoil at an angle of
attack of α = 10.2◦, and to the FFA-W3-301 airfoil at an angle of attack of α = 11.2◦.

Simulations Data

The simulation data considered for the FFA-W3-241 plot are related to the Smooth, VG x/c=0.2 h=4mm,
VG x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 10.2◦.
Instead, the simulation data used for the FFA-W3-301 plot are related to the Smooth, VG x/c=0.2 h=6mm
and the VG x/c=0.3 h=6mm cases, for the angle of attack α = 11.2◦.
The simulation data displayed are obtained extracting the skin friction coe�cient values already present in
the surface_�ow.vtk �les, created during the SU2 simulations.
The same extraction process described in the Simulations Data subsection of Figure 6.3 is also applied in
this case.

Figure Creation

The plots are created importing the data stored in the .csv �les produced in the Simulations Data subsection.
The data in each dataframe are averaged for each streamwise location, calculating the arithmetic mean of all
the spanwise locations extracted.
The skin friction coe�cient magnitude is then computed as the square root of the three skin friction compo-
nents extracted for each con�guration.
The �gure is created by combining the plots for the con�gurations mentioned in the Simulations Data
subsection in a unique �gure.
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Figure 6.9 and Figure 6.10

In these �gures, the vorticity magnitude is displayed in contour plots for di�erent streamwise locations.
The results displayed are related to the FFA-W3-301 airfoil at an angle of attack of α = 12.9◦, for the Smooth
and the VG x/c=0.2 h=6mm cases.

Simulations Data

The simulation data displayed are obtained extracting slices normal to the airfoil streamwise direction axis,
from the Results.vtk �les created during the SU2 simulations.
If a VG solution is considered, �rst the VG surface mesh coordinates are extracted from the corresponding
.pw �le. This is achieved by selecting the grid surface interactively in Pointwise, exporting it in the .cgns �le
format. Obtaining the VG coordinates allows, in the following data extraction phase, to skip locations too
close to the VG surface. With this approach, points in the computational cells immediately adjacent to the
VG surface are not considered, thus avoiding unwanted interpolation errors due to the underlying Paraview
functions used.
The data extraction phase is described by the following steps:

1. Import data of interest. These are contained in the Results.vtk, in the surface_�ow.vtk �le and in the
VG_GridPoints.cgns �le. The last �le is imported only if a VG simulation case is considered.

2. Compute the vorticity magnitude from the data provided by the SU2 simulation:

(a) The �rst step is to create a vector quantity in Paraview, corresponding to the velocity �eld. This is
performed using the Calculator function, creating a vector variable Vel_Field from all the velocity
components already present in the Results.vtk �le.

(b) In the second step the Python Calculator function is used, computing the curl of the velocity �eld
created in (a). This produces the vorticity �eld.

(c) In the third step, the vorticity magnitude is calculated from the vorticity �eld using the Calculator
function

3. The resulting �ow domain from 2.(c) is mirrored with respect to the global minimum spanwise location
('Y Min' option), using the function Re�ect. This produces the �ow domain for the VG pair.

4. Input the variables string names to extract, that is the corresponding vorticity magnitude string. All
the variables present in this �le are �rst displayed in the standard output, to allow the user to choose
the proper string name.

5. Compute the normal vectors of the grid nodes in the airfoil surface solution surface_�ow.vtk. This
is done �rst using the ExtractSurface function on the surface_�ow.vtk data, in order to produce a
PolyData dataset. This PolyData dataset is subsequently given in input to the function GenerateSur-
faceNormals, producing the resulting surface data together with the computed normals.

6. Input whether the streamwise and spanwise locations from which to extract the data, are to be created
linearly spaced, or are user-speci�ed.

(a) In case they are to be created linearly spaced, input �rst the number of points in the streamwise
direction to consider, and then the number of points in the spanwise direction for each streamwise
location. These linearly spaced coordinates are created between the streamwise and spanwise
airfoil surface boundaries, automatically obtained from the surface_�ow.vtk solution.

(b) In case the locations are user-speci�ed, input �rst the streamwise locations and then the spanwise
ones for each streamwise position.
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7. If the simulation results are of a VG case simulated, then store the coordinates near the VG surface to
avoid. These coordinates are selected from the ones created in Step 3.

8. Extract the data, avoiding in the extraction loop the coordinates stored in Step 4:

(a) First, slice the results from 5. with a plane normal to the streamwise axis.

(b) Then, slice the extracted data from (a) with a plane normal to the spanwise axis.

(c) From the extracted data in (b), get the coordinates of the point in the upper airfoil surface (that
is the suction side), �nd its unique index in the global solution, and extract the corresponding
normal vector using this unique index.

(d) Calculate the perpendicular normal to the one found from (c), and slice the �ow domain from
2.(c) with this perpendicular normal computed, at the point location given from (c).

(e) Resize the slice from (d), selecting only the solution in the airfoil suction side region. Resize further
this result, selecting solution points up to a given distance speci�ed by the user (this distance is
selected in order to consider only the �ow region a�cted by the VG). The resizing process is done
using the SelectPoints and ExtractSelection functions with the proper boolean expression

(f) Extract the �ow variable of interest, in this case the vorticity magnitude, from the resulting domain
from (e).

(g) Store the extracted vorticity magnitude data, together with the coordinates of the points consid-
ered, in the corresponding .csv �les.

Figure Creation

The data stored in the .csv �les produced in the Simulations Data subsection are imported, and the contour
plots are created with equally spaced contour levels.
The �gure is created by combining the plots for the con�gurations mentioned in the Simulations Data
subsection in a unique �gure.

Figure 6.11 and Figure 6.12

In these �gures, the velocity components u, v and w, related to the corresponding coordinates directions x,
y and z, are displayed in contour plots for di�erent airfoil streamwise locations.
The results displayed are related to the FFA-W3-301 airfoil at an angle of attack of α = 12.9◦, for the Smooth
and the VG x/c=0.2 h=6mm cases.

Simulations Data

The simulation data displayed are obtained extracting slices normal to the airfoil streamwise direction axis,
from the Results.vtk �les created during the SU2 simulations.
The extraction process is the same as described in the Simulations Data subsection of Figure 6.9 and Figure
6.10.

Figure Creation

The data stored in the .csv �les produced in the Simulations Data subsection are imported, and the contour
plots are created with equally spaced contour levels.
The �gure is created by combining the plots for the con�gurations mentioned in the beginning of this sub-
section in a unique �gure, with three columns: the �rst related to the u component, the second to the v
component, and the third to the w component.
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Figure 6.13

In this �gure, the vorticity magnitude pro�les at di�erent streamwise locations are displayed, together with
the boundary layer thickness evolution along the streamwise direction.
The results are related to the FFA-W3-241 airfoil at an angle of attack of α = 8.8◦, for the Smooth and the
VG x/c=0.2 h=6mm cases.

Simulations Data

The simulation data displayed are obtained extracting lines normal to the airfoil streamwise direction axis,
from the Results.vtk �les created during the SU2 simulations.
If a VG solution is considered, �rst the VG surface mesh coordinates are extracted from the corresponding
.pw �le. This is done selecting the grid surface interactively in Pointwise, exporting it in the .cgns �le format.
Obtaining the VG coordinates allows, in the following data extraction phase, to skip locations too close to
the VG surface. In this way points in the computational cells immediately adjacent to the VG surface are
not extracted, avoiding unwanted interpolation errors due to the underlying Paraview functions used.
The data extraction phase is described by the following steps:

1. Import data of interest. These are contained in the Results.vtk, in the surface_�ow.vtk �le and in the
VG_GridPoints.cgns �le. The last �le is imported only if a VG simulation case is considered.

2. Compute the vorticity magnitude from the data provided by the SU2 simulation:

(a) The �rst step is to create a vector quantity in Paraview, corresponding to the velocity �eld. This is
performed using the Calculator function, creating a vector variable Vel_Field from all the velocity
components already present in the Results.vtk �le.

(b) In the second step the Python Calculator function is used, computing the curl of the velocity �eld
created in (a). This produces the vorticity �eld.

(c) In the third step, the vorticity magnitude is calculated from the vorticity �eld using the Calculator
function

3. Input the variables string names to extract, in this case the corresponding vorticity magnitude string.
All the variables present in this �le are �rst displayed in the standard output, to allow the user to
choose the proper string name.

4. Compute the normal vectors of the grid nodes in the airfoil surface solution surface_�ow.vtk. This
is done �rst using the ExtractSurface function on the surface_�ow.vtk data, in order to produce a
PolyData dataset. This PolyData dataset is subsequently given in input to the function GenerateSur-
faceNormals, producing the resulting surface data together with the computed normals.

5. Input whether the streamwise and spanwise locations, from which to extract the data, are to be created
linearly spaced, or are user-speci�ed.

(a) In case they are to be created linearly spaced, input �rst the number of points in the streamwise
direction to consider, and then the number of points in the spanwise direction for each streamwise
location. These linearly spaced coordinates are created between the streamwise and spanwise
airfoil surface boundaries, automatically obtained from the surface_�ow.vtk solution.

(b) In case the locations are user-speci�ed, input �rst the streamwise locations and then the spanwise
ones for each streamwise position.

6. If the simulation results are of a VG case simulated, then store the coordinates near the VG surface to
avoid. These coordinates are selected from the ones created in Step 3.

75



Chapter 5: Methodology

7. Extract the data, avoiding in the extraction loop the coordinates stored in Step 4:

(a) First, slice the results from 4. with a plane normal to the streamwise axis.

(b) Then, slice the extracted data from (a) with a plane normal to the spanwise axis.

(c) From the extracted data in (b), get the coordinates of the point in the upper airfoil surface (that
is the suction side), �nd its unique index in the global solution, and extract the corresponding
normal vector using this unique index.

(d) Create the normal polyline source, corresponding to the normal line to extract. This is done using
the normal vector and the point coordinates on the airfoil surface obtained from (c)

(e) Resample the �ow solution calculated in 2.(c) with the normal line created in (d), using the
function ResampleWithDataset.

(f) Extract the �ow variable of interest, in this case the vorticity magnitude, from the resulting domain
from (e).

(g) Store the extracted vorticity magnitude data, together with the coordinates of the points consid-
ered, in the corresponding .csv �les

Figure Creation

The data stored in the .csv �les produced in the Simulations Data subsection are imported.
The data for each streamwise location are averaged computing the arithmetic mean of the corresponding
spanwise positions.
The resulting spanwise averaged data for each streamwise location are subset according to the value of the
vorticity magnitude. A user-de�ned threshold is used in order to �rst select the solution data with a value
of the vorticity magnitude equal or greater than the threshold speci�ed.
From this subset of each streamwise location, the minimum vorticity magnitude value is detected, identifying
the boundary layer thickness for that streamwise position.
In the end, all the streamwise vorticity magnitude pro�les are grouped in plots displaying 5 pro�les each,
with the corresponding boundary layer thicknesses.
In each plot, both the Smooth and the VG case considered are shown.
The �gure is created by combining these plots in a unique �gure.
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Figure 6.14

In this �gure, the u velocity pro�les at di�erent streamwise locations are displayed, together with the boundary
layer thickness evolution along the streamwise direction.
The results are related to the FFA-W3-301 airfoil at an angle of attack of α = 12.9◦, for the VG x/c=0.3
h=6mm con�guration.

Simulations Data

The simulation data displayed are obtained extracting lines normal to the airfoil streamwise direction axis,
from the Results.vtk �les created during the SU2 simulations.
The extraction process is the same as described in the Simulations Data subsection of Figure 6.13.

Figure Creation

The data stored in the .csv �les produced in the Simulations Data subsection are imported.
The data for each streamwise location are averaged computing the arithmetic mean of the corresponding
spanwise positions.
The resulting spanwise averaged u components are plotted along the streamwise direction, grouped in plots
displaying 5 pro�les each.
In each plot, both the Smooth and the VG case considered are shown.

Figure 6.15, Figure 6.16 and Figure 6.17

In these �gures, the integral boundary layer quantities evolution in the streamwise direction is displayed,
that is the displacement thickness δ∗, the momentum thickness θ and the energy thickness θ∗.
The results are related to the FFA-W3-241 airfoil for all the angles of attack simulated, that is α = 8.8◦,
α = 10.2◦, α = 12.6◦ and α = 14.4◦. The curves shown are related to all the previous angles of attack
mentioned, and to all the con�gurations considered, i.e the Smooth, the VG x/c=0.2 h=4mm, the VG
x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm.

Simulations Data

The simulation data displayed are obtained extracting lines normal to the airfoil streamwise direction axis,
from the Results.vtk �les created during the SU2 simulations.
If a VG solution is considered, �rst the VG surface mesh coordinates are extracted from the corresponding
.pw �le. This is done selecting the grid surface interactively in Pointwise, exporting it in the .cgns �le format.
Obtaining the VG coordinates allows, in the following data extraction phase, to skip locations too close to
the VG surface. In this way points in the computational cells immediately adjacent to the VG surface are
not extracted, avoiding unwanted interpolation errors due to the underlying Paraview functions used.
The data extraction phase is described by the following steps:

1. Import data of interest. These are contained in the Results.vtk, in the surface_�ow.vtk �le and in the
VG_GridPoints.cgns �le. The last �le is imported only if a VG simulation case is considered.

2. Compute the vorticity magnitude from the data provided by the SU2 simulation:

(a) The �rst step is to create a vector quantity in Paraview, corresponding to the velocity �eld. This is
performed using the Calculator function, creating a vector variable Vel_Field from all the velocity
components already present in the Results.vtk �le.

(b) In the second step the Python Calculator function is used, computing the curl of the velocity �eld
created in (a). This produces the vorticity �eld.
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(c) In the third step, the vorticity magnitude is calculated from the vorticity �eld using the Calculator
function

3. Input the variables string names to extract, in this case the u velocity component and the vorticity
magnitude string. All the variables present in this �le are �rst displayed in the standard output, to
allow the user to choose the proper string name.

4. Compute the normal vectors of the grid nodes in the airfoil surface solution surface_�ow.vtk. This
is done �rst using the ExtractSurface function on the surface_�ow.vtk data, in order to produce a
PolyData dataset. This PolyData dataset is subsequently given in input to the function GenerateSur-
faceNormals, producing the resulting surface data together with the computed normals.

5. Input whether the streamwise and spanwise locations, from which to extract the data, are to be created
linearly spaced, or are user-speci�ed.

(a) In case they are to be created linearly spaced, input �rst the number of points in the streamwise
direction to consider, and then the number of points in the spanwise direction for each streamwise
location. These linearly spaced coordinates are created between the streamwise and spanwise
airfoil surface boundaries, automatically obtained from the surface_�ow.vtk solution.

(b) In case the locations are user-speci�ed, input �rst the streamwise locations and then the spanwise
ones for each streamwise position.

6. If the simulation results are of a VG case simulated, then store the coordinates near the VG surface to
avoid. These coordinates are selected from the ones created in Step 3.

7. Extract the data, avoiding in the extraction loop the coordinates stored in Step 4:

(a) First, slice the results from 4. with a plane normal to the streamwise axis.

(b) Then, slice the extracted data from (a) with a plane normal to the spanwise axis.

(c) From the extracted data in (b), get the coordinates of the point in the upper airfoil surface (that
is the suction side), �nd its unique index in the global solution, and extract the corresponding
normal vector using this unique index.

(d) Create the normal polyline source, corresponding to the normal line to extract. This is done using
the normal vector and the point coordinates on the airfoil surface obtained from (c).

(e) Resample the �ow solution calculated in 2.(c) with the normal line created in (d), using the
function ResampleWithDataset.

(f) Extract the �ow variables of interest, in this case the u velocity component and the vorticity
magnitude, from the resulting domain from (e).

(g) Store the extracted data, together with the coordinates of the points considered, in the corre-
sponding .csv �les.

Figure Creation

The data stored in the .csv �les produced in the Simulations Data subsection are imported.
The data for each streamwise location are averaged computing the arithmetic mean of the corresponding
spanwise positions.
The resulting spanwise averaged data for each streamwise location are subset according to the value of the
vorticity magnitude. A user-de�ned threshold is used in order to �rst select the solution data with a value
of the vorticity magnitude equal or greater than the threshold speci�ed.
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From this subset of each streamwise location, the minimum vorticity magnitude value is detected, identifying
the boundary layer thickness for that streamwise position.
Identi�ed the boundary layer thickness, the values of δ∗, θ and θ∗ can be integrated between the wall airfoil
surface and the boundary layer thickness found.
Each plot displays the computed displacement, momentum or energy thickness for the speci�ed streamwise
coordinates.

Figure 6.18, Figure 6.19 and Figure 6.20

In these �gures, the integral boundary layer quantities evolution in the streamwise direction is displayed,
that is the displacement thickness δ∗, the momentum thickness θ and the energy thickness θ∗.
The results are related to the FFA-W3-301 airfoil for all the angles of attack simulated, that is α = 9◦,
α = 11.2◦, α = 12.9◦ and α = 14.6◦. The curves shown are related to all the previous angles of attack
mentioned, and to all the con�gurations considered, i.e the Smooth, the VG x/c=0.2 h=6mm and the VG
x/c=0.3 h=6mm.

Simulations Data

The simulation data displayed are obtained extracting lines normal to the airfoil streamwise direction axis,
from the Results.vtk �les created during the SU2 simulations.
The extraction process is the same as described in the Simulations Data subsection of Figure 6.15, Figure
6.16 and Figure 6.17.

Figure Creation

The data stored in the .csv �les produced in the Simulations Data subsection are imported.
The plots creation process is the same one reported in the Figure Creation subsection of Figure 6.15, Figure
6.16 and Figure 6.17.
Each plot displays the computed displacement, momentum or energy thickness for the speci�ed streamwise
coordinates.

Figure 6.21

In this �gure the vortex core line is displayed together with the velocity pro�les, for the FFA-W3-301 airfoil
at an angle of attack of α = 12.9◦, in the VG x/c=0.3 h=6mm con�guration.

Simulations Data

The simulation data displayed are obtained extracting lines normal to the airfoil streamwise direction axis,
from the Results.vtk �les created during the SU2 simulations.
The extraction process is the same as described in the Simulations Data subsection of Figure 6.13.
The vortex core lines are instead extracted using the Vortex Core Plugin of Paraview [62].
The steps to reproduce the vortex core lines extracted are:

1. Create the velocity �eld vector from the velocity components provided in output in the SU2 simulations

2. Use the VCGVortexCores with input the velocity �eld vector just created

The parameters that have been set in the VCGVortexCores �lter are the following:

� Method = Sujudi-Haimes;

� Min Num of vertices = 100;
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� Max Num of Exceptions = 1;

� Min Strength = 100;

� Max Angle = 30;

The algorithm used to identify the vortex core points is the one proposed by Sujudi and Hames in [63]. This
metod of identifying vortex cores lines relies upon the critical-point theory, which states that the eigenvalues
and eigenvectors of the velocity gradient tensor, when evaluated at a critical point, describe the local �ow
about that point. A critical point in general is a point where the vector �eld vanishes and di�erent vector �eld
trajectories converge or intersect. Critical points are considered to be part of the vortex core line, therefore
to identify such a line, the algorithm can be brie�y summarized as follows:

1. Compute the velocity gradient tensor J ;

2. Compute the three eigenvalues of J ;

3. If two of the eigenvalues computed in step 2 are complex conjugate:

(a) Compute the eigenvector for the remaining real eigenvalue from 2.

(b) Project the velocity vectors on the plane normal to the eigenvector calculated in (a)

(c) If one of the projected velocity vectors from (b) is zero, the point considered is part of the vortex
core line.

To be able to plot the vortex core line on the corresponding velocity pro�les plot, the distance of the vortex
core points from the airfoil surface has to be computed.
To do so, the vortex core line extracted is projected on the airfoil surface. This is performed using the
SliceAlongPolyline �lter, subsetting the sliced data selecting only line on the suction side. The sliced line is
the actual projected line on the airfoil surface, so that a point-to-point subtraction can be executed between
the original vortex core line and the one projected on the surface of the airfoil, obtaining the vortex core line
distance from the airfoil.

Figure Creation

The plot creation process for the streamwise velocity pro�les is the same as the one described in the Figure
Creation subsection of Figure 6.13.
At this point, the vortex core line along the streamwise direction can be displayed in the corresponding
plots. Following the procedure mentioned in the Simulations Data subsection, this line is the 2D projection
of the 3D line obtained from the VCGVortexCores �lter. The plane onto which this line is projected is the
streamwise plane of the airfoil section. To plot this line, only the x coordinate of the extracted vortex core
line is displayed, together with the distance of the line from the surface computed in the Simulations Data
subsection.
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Figure 6.22

This �gure displays the vortex tube evolution for the FFA-W3-301 VG x/c=0.3 h=6mm case at an angle of
attack of α = 12.9◦.

Simulations Data and Figure Creation

The vortex tube displayed is obtained using the Q-Criterion feature of the GradientOfUnstructuredDataset
�lter. To use this �lter, �rst the velocity �eld has to be created from the velocity components of the SU2
simulation result Results.vtk. Subsequently with the �lter, it is possible to compute the divergence of the
velocity �eld, the vorticity, and the Q-Criterion.
The Q-Criterion is based on the velocity gradient tensor Dij = ∇u = ∂ui

∂xj
[64].

This is a second order tensor, therefore it can be decomposed into a symmetric and a skew-symmetric part, i.
e. Dij = Sij + Ωij . The symmetric part Sij is also known as the rate-of-strain tensor, and it is expressed as

Sij = 1/2∗( ∂ui

∂xj
+
∂uj

∂xi
). The skew-symmetric part is the vorticity tensor expressed by Ωij = 1/2∗( ∂ui

∂xj
− ∂uj

∂xi
).

The characteristic equation for Dij results in:

λ3 + Pλ2 +Qλ+R = 0

where P , Q and R are the three invariants, that is the quantities that remain unchanged when transformations
are applied to them. With the de�nitions of Sij and Ωij , the invariants can be expressed as:

P = −tr(Dij)

Q = 1/2 ∗ tr[(Dij)
2 − tr(D2

ij)] = 1/2∗ ‖ Ωij ‖2 − ‖ Sij ‖2

R = −det(Dij)

The Q-Criterion de�nes a vortex as the connected �uid region where Q > 0. The invariant Q represents
the balance between the shear-strain-rate magnitude ‖ Sij ‖2 and the vorticity magnitude ‖ Ωij ‖2, so
the condition Q > 0 de�nes a vortex as the �uid area where the vorticity magnitude is greater than the
shear-strain-rate magnitude.
The vortex core line displayed is extracted with the procedure mentioned in the Simulations Data subsection
of Figure 6.21.
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Figure 6.23

These �gures display the skin friction lines on the airfoil surface. The con�gurations considered are the
Smooth and the VG x/c=0.2 h=6mm ones, for the FFA-W3-301 airfoil section at an angle of attack of
α = 12.9◦.

Simulations Data and Figure Creation

To create these �gures, �rst the skin friction coe�cient vector is created from the skin friction components
provided in the SU2 simulation result surface_�ow.vtk.
Then a Surface Line Integral Convolution representation of this vector is applied, loading the SurfaceLIC
Paraview plugin, and selecting the SurfaceLIC option in the representation panel in the left side of the GUI.
Line Integral Convolution (LIC) is a visualization technique for representing dense streamlines in a vector
�eld, that takes in input a vector �eld and a white noise texture [65]. This texture is smoothed locally along
the streamlines of the vector �eld, performing a convolution integral of the resulting smoothed texture with a
�lter kernel. The neighbouring pixels along streamlines present a high correlation between grey-scale values,
whereas the pixels perpendicular to the streamlines have little to no correlation with this grey-scale values.

5.5 Conclusions

In this chapter, the methodology followed to set up and run the simulations is described, considering all the
main phases typical of a CFD simulation process.
The Pre-Processing phase, consisting of the CAD model creation and the mesh generation procedure, is
summarized. A detailed mesh description can be found in Appendix C and Appendix D. The CFD's
con�guration-�les set-up is described in detail, with all the relevant numerical models and all the values of
the parameters used. The Post-Processing phase is subsequently described in more detail, presenting all the
procedures for the data extraction and the �gures creation. This allows to recreate all the �gures displayed
in Chapter 6.
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Results

This chapter presents the results obtained from the simulations. The results are introduced by discussing
each research question through the use of line plots, contour plots and 3D visualization �gures.
The four research questions introduced in Section �1.2 are:

1. Is the current SU2's incompressible solver implementation able to reproduce vortex generators' exper-
imental results up to a reasonable degree of accuracy?

2. Are the results obtained from the simulations qualitatively describing the relevant �ow modi�cations?

3. Is a 2D boundary layer analysis showing the expected essential qualitative aspects?

4. Is a 3D qualitative �ow visualization analysis displaying the important �ow features?

6.1 Question 1

In this section the results related to the �rst research question proposed are discussed, comparing the simu-
lations data with the corresponding experimental values.
This comparison is performed through the analysis of lift coe�cient, drag coe�cient and pressure coe�cient
values, for both the FFA-W3-241 and the FFA-W3-301 airfoils sections.
In Figure 6.1 the FFA-W3-301 experimental and simulated values of the lift and drag coe�cients are shown,
for the angles of attack simulated, i.e α = 9°, α = 11.2°, α = 12.9°, α = 14.6°. The con�gurations displayed
are: Smooth (e.g without VGs), VG x/c=0.2 h=6mm and VG x/c=0.3 h=6mm. The values of the lift and
drag coe�cients are obtained from the log �les resulting from the SU2 simulations. These plots were resized
to display only the region of interest of the polar curve, allowing a better comparison of the experimental
values with the simulation results.
It can be seen that the values obtained from the simulations are signi�cantly di�erent from the results
presented in the reference paper [23].
In some cases, it is possible to see that the simulations somehow capture the curve shape behaviour, as in
the Smooth and VG x/c=0.2 h=6mm cases.
In the Smooth case, the lift shows a peak in values as displayed also in the corresponding experimental
data, after which the curve has initially a slight decrease, followed by a further increase. The peak from the
simulations results is likely to be related to the experimental value at the bottom left of the plot considered,
thus corresponding to an overestimation of both the maximum lift value and of the corresponding angle of
attack. This means that the critical angle of attack from the simulations can be identi�ed as α = 11.2◦,
whereas the angle from experiments as α = 9°.
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Considering also the other plots' lift curves behaviours, it can be stated that the simulations for the Smooth
case predict stall conditions later than what is indicated from experiments.
In the VG x/c=0.2 h=6mm, the overestimation of the stall conditions is not easily recognizable, since both
the experimental and simulations values are increasing, without a clear decrease after a certain peak value.
In the VG x/c=0.3 h=6mm plot, the overestimation of the critical conditions is instead clearly visible, since
the simulations still show a rising and almost linear curve shape. From the wind tunnel results, the airfoil
would be expected to stall earlier than what the simulations results display, with the lift values already
decreasing for angles of attack α = 13◦.
As for the drag coe�cient, the results generally underpredict the corresponding experimental ones.
In the Smooth case, the drag curve shape is well captured, even if the di�erence in values with the experiments
is quite noticeable. From this curve it is possible to identify the stall angle of attack as α = 9◦, con�rming
the value hypothesized from the Smooth lift curve.
In the other two cases, the di�erence in values for the drag coe�cient is substantial, with curves that depart
signi�cantly from the expected values.
In Figure 6.2, the experimental and simulated values of the lift and drag coe�cients for the FFA-W3-241
airfoil are shown. The angles of attack simulated are α = 8.8°, α = 10.2°, α = 12.6°, and α = 14.4°. The
con�gurations displayed are: Smooth (e.g without VGs), VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and
VG x/c=0.3 h=6mm. The values of the lift and drag coe�cients are again obtained from the log �les from
the SU2 simulations. The plots were resized as in Figure 6.1.
Regarding the Smooth case, the lift coe�cient shows an overpredicted maximum value when compared to the
reference values from [23]. The drag coe�cient shows overestimated values for angles of attack below the stall
angle, in contrast with what described for the FFA-W3-301 airfoil. When considering stall �ow condition, the
general underprediction behaviour of the previous FFA-W3-241 cases is instead con�rmed. From the curves
plotted, the critical angle of attack can be identi�ed around α = 12.4◦.
As for the VG x/c=0.2 h=4mm case, it can be seen that the lift curve shape is well described in comparison
with the experimental values. In this case, the lift critical value is not displayed, since it lies outside the range
plotted for the angles of attack, for both the simulations and the experimental values. The drag coe�cient
curve for this case has values closer to the experimental reference, although observing the plot, it can not be
stated that the simulations' curve shape is representative of the corresponding experimental values.
For the remaining two cases, that is VG x/c=0.2 h=6mm and VG x/c=0.3 h=6mm, the drag coe�cient
values are overpredicted in the angles of attack range before stall. Nothing can be said about the stall region,
since it is not clearly identi�able the critical angle of attack after which the curve departures from a previous
nearly linear behaviour.
Regarding the lift coe�cient behaviour, the VG x/c=0.2 h=6mm case shows an unexplicable peak for the
α = 10.2◦ simulation, when compared to the other simulation values: this could be due to an improper mesh
re�nement in some regions of the �ow domain, or to some hardly identi�able numerical bugs in the code.
In the VG x/c=0.3 h=6mm case, the simulations curve shape seems to agree with the increasing trend of
the corresponding experimental reference values. The stall peak is not captured, but in accordance with the
previous cases, where generally the maximum lift coe�cient in the simulations was overpredicted, it could
be stated that also in this case the critical lift is likely to be overpredicted.
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Figure 6.1: Comparison between experimental and simulated values of lift and drag co-
e�cient, for the FFA-W3-301 airfoil
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Figure 6.2: Comparison between experimental and simulated values of lift and drag co-
e�cient, for the FFA-W3-241 airfoil
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In Figure 6.3, the pressure coe�cient for the FFA-W3-241 airfoil is displayed, comparing the simulations
results with the corresponding experimental values.
The con�gurations displayed are:

� Smooth (e.g without VGs) for the angles of attack α = 8.8°, α = 10.2°, α = 12.6°, α = 14.4°,

� VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm and VG x/c=0.3 h=6mm for the angle of attack α = 10.2°,
and

� VG x/c=0.3 h=6mm for the angle of attack α = 14.4°.

The y-axis has been inverted, in order to show the suction side on the upper part and the pressure side on
the lower part of each plot. This is in accordance with the typical airfoil sections representation.
Regarding the Smooth simulations, for the α = 8.8◦ and the α = 10.2° case, a good agreement between
experimental and simulated data is shown. The streamwise locations where the simulations depart from
the experimental reference are detectable near the leading edge and trailing edge location of the airfoil
pro�le, both for the pressure and suction side. In the remaining streamwise locations, at the suction side a
slight underestimation of the values from the simulations is noticeable, whereas, at the pressure side, a close
agreement between the two curves is identi�able.
For the stalled cases, i.e the α = 12.6◦ and the α = 14.4° angles of attack, a considerable di�erence between
values from the simulations and the experiments can be seen at the suction side. At the leading edge
streamwise location there is a substantial underprediction in the pressure values resulting from simulations,
when compared to the experimental reference. In the following adverse-pressure-gradient portion of the airfoil,
the values are therefore underestimated, leading to a displacement of the separation point towards greater
streamwise positions than the experimentally predicted results. For the α = 12.6◦ case, the separation point
is predicted to be at approximately x/c = 0.5 from the experimental results, whereas, from the simulation
results, it is calculated at around x/c = 0.75. For the α = 14.4◦ case, the separation point is expected at
approximately x/c = 0.4 from the experimental results; from the simulation values it is instead predicted at
x/c = 0.55.
At the pressure side, a good agreement between experiments and simulations can instead be found for the
cases so far investigated.
For the VG cases, the simulations predict reasonably well the pressure coe�cient for the three cases at
α = 10.2◦, that is the VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and VG x/c=0.3 h=6mm cases. At the
suction side, there is a minimal overall underprediction of the simulated values, whereas, at the pressure side,
the simulation results reasonably agree with the experiments. At the leading edge, the largest di�erences
can be found. It is also noticeable the characteristic decreasing peak in pressure corresponding to the VG
location considered.
In the VG x/c=0.3 h=6mm case at α = 14.4◦, the simulation results at the suction side of the airfoil, when
compared with the corresponding experimental values, deviate considerably in the �rst portion of the airfoil,
from the leading edge to half the normalized chord x/c = 0.5; in the remaining part of the airfoil chord,
the simulations instead agree with the experiments. At the pressure side, a negligible di�erence between the
results and the simulations can be seen.
For all the cases displayed in Figure 6.3, at the trailing edge streamwise position an outlier peak can be seen,
probably due to some numerical errors during the calculations.
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Figure 6.3: Comparison between experimental and simulated values of the pressure coef-
�cient, for the FFA-W3-241 airfoil
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In Figure 6.4, the pressure coe�cient comparison between the simulation results and the corresponding
experimental values is displayed, for the FFA-W3-301 airfoil section.
For the Smooth simulations considered, an overall underprediction of the simulated values with respect to
the experimentally obtained results is noticeable at the suction side.
In the α = 9◦ case, from the leading edge location to approximately x/c = 0.6, at the suction side the
resulting values are generally lower than the corresponding experimental results. At the pressure side the
values are overpredicted, in contrast to what generally found for the FFA-W3-241 airfoil.
For the α = 11.2◦ and the α = 12.9◦ cases, in addition to the substantial di�erence of the simulated values
with the reference ones, it can be seen that the separation point location is generally overestimated. In the
α = 11.2◦ case, from experiments separation is expected to occur after approximately x/c = 0.5, however
in the simulations, it is predicted around x/c = 0.8. In the α = 12.9◦, the �ow separation is expected
experimentally from x/c = 0.45 on, whereas, in the simulations, it occurs at x/c = 0.65.
In the α = 14.6◦ case, the results from the simulations completely fail to predict the pressure values, with
an initial overestimation at the leading edge location at the suction side, followed by an oscillatory curve
behaviour both at the suction and pressure side.
Regarding the VG cases, for the VG x/c=0.2 h=6mm and VG x/c=0.3 h=6mm ones, at α = 9◦, it can be
seen that experimental values are well predicted by simulations at the pressure side of the airfoil, whereas, at
the suction side, the general underprediction mentioned previously is again noticeable. At the suction side
near the leading edge locations, the pressure values from the simulation results are initially lower than the
corresponding results obtained experimentally; approaching the trailing edge positions, the values gradually
increase, matching the experiments.
For the remaining VG case displayed, i.e the VG x/c=0.3 h=6mm at α = 12.9◦, the pressure values at
the pressure side are again well predicted, with a slightly more pronounced overestimation in the central
streamwise positions. At the suction side, from the leading edge up to approximately x/c = 0.6, the values
obtained from the simulations are quite underpredicted.
For all the cases displayed, as noticed also in Figure 6.3, at the trailing edge streamwise position an outlier
peak is again seen, possibly due to some numerical errors during the calculations.
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Figure 6.4: Comparison between experimental and simulated values of the pressure coef-
�cient, for the FFA-W3-301 airfoil
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6.2 Question 2

To answer the second question, the simulations data are analyzed from a qualitative point of view. This
is performed through a comparison, in terms of pressure coe�cient and skin friction magnitude values, of
all the cases simulated for the FFA-W3-241 and the FFA-W3-301 airfoil sections. In addition to that, the
contour plots of the vorticity magnitude and the u, v, w velocity components are displayed, investigating the
�ow features from a 2D perspective.

6.2.1 Pressure Coe�cient Plots

In Figure 6.5, the pressure coe�cient is plotted against the normalized streamwise coordinate x/c of the
airfoil section, for both the FFA-W3-241 and FFA-W3-301 pro�les.
These two plots are obtained slicing the original 3D solution at 100 di�erent linearly spaced streamwise
locations, and, for each one of these, 20 di�erent linearly spaced spanwise positions are extracted. The data
obtained are then averaged in the spanwise direction, for each streamwise location considered.
The FFA-W3-241 plot is obtained for all the Smooth and VG cases at the same α = 10.2° angle of attack,
while the FFA-W3-301 plot is obtained for all the related Smooth and VG cases at α = 11.2°.
In the FFA-W3-241 plot, it can be seen that all the VG cases are characterized by a lower pressure on the
suction side of the airfoil, and a slightly higher value on the pressure side, when compared to the corresponding
Smooth case. This results in an increase of the lift coe�cient, as would be expected from the use of Vortex
Generators.
The position of the VGs is displayed clearly with the corresponding peaks of low pressure. These peaks can be
explained considering that the pressure data are obtained from numerical simulations in which the VGs are
modeled only through a 2D surface object, in order to simplify the meshing generation process. Therefore,
slicing a 3D solution with a plane produces sharp discontinuities in the values extracted.
For the VG cases, the pressure decrease and departure from the distribution of the Smooth airfoil con�guration
occurs almost immediately after the leading edge, whereupon the pressure increases smoothly as it approaches
the trailing edge (apart from the peaks due to the presence of the VG). As for the pressure distribution at
the trailing edge, the Smooth case shows a slight lower pressure than the VG cases.
Overall, it can be seen that the pressure recovery in the streamwise direction is increased with the use of
VGs, when compared to the Smooth reference con�guration. This pressure recovery is supported by the
increase of �ow mixing in the downstream region of the VG, which prevents �ow in the boundary layer from
experiencing strong negative e�ects of the adverse pressure gradient.
In the FFA-W3-301 plot, the lower pressure on the suction side of the airfoil due to the VG presence is even
more evident. This causes, for this particular airfoil at the given angle of attack, a higher lift than what
would be experienced under the Smooth case circumstances. The �ow conditions considered at α = 10.2◦ are
in fact close to the stalled values, characterized in the Smooth case by a decrease in lift capability.
For this airfoil, it can also be noted that near the trailing edge, the previous airfoil behaviour, regarding a
slight lower pressure present in the clean case when compared with the VG cases, is not that pronounced.
All the other considerations made for the FFA-W3-241 plot are valid for the FFA-W3-301 as well.
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Figure 6.5: Pressure coe�cient comparison of all the simulated con�gurations. On the top
plot, the FFA-W3-241 airfoil case at an angle of attack of α = 10.2◦ is shown, displaying
the Smooth, VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm and the VG x/c=0.3 h=6mm
con�gurations. On the bottom plot, the FFA-W3-301 airfoil case at an angle of attack
of α = 11.2◦ is shown, displaying the Smooth, VG x/c=0.2 h=6mm and the VG x/c=0.3
h=6mm con�gurations.

In Figure 6.6, the pressure coe�cient of a �ow condition characterized by developed stall is considered.
These two plots were obtained in the same way as what done in Figure 6.5, regarding the spanwise and
streamwise locations considered. The FFA-W3-241 plot is obtained for all the cases at the same α = 14.4°
angle of attack, while the FFA-W3-301 plot is obtained for all the related cases at α = 12.9°.
In these plots, it is possible to distinguish clearly the occurring separation, characterized by a �at portion of
the pressure coe�cient curve. For the FFA-W3-241 case, there is a separation from x/c = 0.55, whereas, for
the FFA-W3-301, a separation occurs from x/c = 0.65.
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In both cases it is therefore possible to detect the aerodynamic performance enhancement of the VGs, by
simply looking at the curve behaviour for all the VG cases. The curve does not present the �at portion
anymore, and overall, the low pressure on the suction side decreases, causing a raise in the lift capability of
the airfoil.
For the FFA-W3-241, there seems to be a higher improvement on the lift for the VG x/c=0.2 h=6mm and
the VG x/c=0.3 h=6mm cases, probably due to the fact that higher-height VGs are able to break the growth
of the boundary layer and energize it more e�ciently when stalled �ow conditions arise.
For the FFA-W3-301, there seems to be little to no di�erence regarding lift improvement between the two
VG cases considered. This is likely due to the fact that both VGs con�gurations have the same height, thus
increasing performance similarly under stalled �ow conditions.
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Figure 6.6: Pressure coe�cient comparison of all the simulated con�gurations. On the top
plot, the FFA-W3-241 airfoil case at an angle of attack of α = 14.4◦ is shown, displaying
the Smooth, VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and the VG x/c=0.3 h=6mm
con�gurations. On the bottom plot, the FFA-W3-301 airfoil case at an angle of attack of
α = 12.9◦ is shown, displaying the Smooth, VG x/c=0.2 h=6mm, and the VG x/c=0.3
h=6mm con�gurations.
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6.2.2 Skin Friction Coe�cient Plots

In Figure 6.7, the magnitude of the skin friction coe�cient is plotted against the normalized streamwise
coordinate x/c of the FFA-W3-241 and FFA-W3-301 airfoil sections.
These two plots are obtained slicing the original 3D solution in the same manner as Figure 6.5: 100 di�erent
streamwise locations, and, for each one of these, 20 di�erent spanwise positions are extracted. The data
obtained are then averaged in the spanwise direction, for each streamwise location considered.
The FFA-W3-241 plot is obtained for all the cases at the same α = 10.2° angle of attack, while the FFA-W3-
301 plot is obtained for all the related cases at α = 11.2°.
In both plots, the favourable e�ect of the VG presence regarding prevention of �ow separation can be easily
noticed.
In fact, the large peaks occurring in the plots at the related VG locations on the airfoil surface are the sign
of enhanced �ow-mixing, that causes a sudden increase in the skin friction values as expected.
The transition to turbulent �ow conditions for the angles of attack considered, is seen to always occur before
the VG location.
Increasing the skin friction coe�cient, donwstream of the VG, allows still an attached �ow at the airfoil wall
surface, although this results in increased energy dissipation due to the greater friction in the same boundary
layer region. This attached �ow situation will not occur in the case of separated �ow, in which the skin
friction coe�cient would reach a zero value, increasing then slightly for the remaining portion of the surface.
In the FFA-W3-241 plot, it can be seen that the airfoil without VG does not experience considerable �ow
separation yet, even if the angle of attack α = 10.2◦ could be related to incipient stall conditions, based on
the evaluation of the lift coe�cient for the airfoil considered. In fact, the skin friction coe�cient zero value
is at a streamwise coordinate very close to the trailing edge.
For the VG cases, a noticeable increase of the skin friction values can be seen, with a fast decay of these values
for the remaining portion of the airfoil surface, downstream of the VG. This behaviour could be explained
with the fact that, immediately after the VG, the �ow mixing is considerable and energizes the �ow at the
cost of an increase in friction due to the vortex arising from the mixing. As already con�rmed in [18], for a
counter-rotating pair of VG as the ones considered, this vortex, after an initial direction towards the surface,
tends to move away from it, carrying with itself the �uid that has been subject to mixing. With this �ow
movement, less �uid a�ects the airfoil surface, thus causing a rapid decrease in skin friction compared to the
initial values.
It can be seen also that for the same VG position, its height has an in�uence on the length of the favourable
mixing.
Looking at the decrease of skin friction for the two cases VG x/c=0.2 h=4mm and VG x/c=0.2 h=6mm, in
the case with VG height h=6mm, the skin friction rises to almost the same value of the h=4mm case, but it
decays slower than it.
In the area near the trailing edge, the airfoil will consequently experience a higher skin friction. This is an
indication of a more e�ective mixing of the �ow, regarding prevention of detachment and separation from
the surface.
In the case of the VG placed at x/c=0.3, the peak of skin friction is less pronounced than the other cases,
and after a short path the values almost approach the ones from the VG x/c=0.2 h=6mm case.
Summarizing, it can be seen that for the purposes of separation and stall prevention, the cases VG x/c=0.2
h=6mm and VG x/c=0.3 h=6mm are the most e�ective, causing a higher value of the skin friction coe�cient
in the zone where the �ow is expected to be separating, that is, near the trailing edge.
In the FFA-W3-301 plot, a di�erent �ow condition than the previous is displayed. The data displayed were
extracted from a case with an angle of attack α = 11.2◦ of the ones in the stalled conditions for this airfoil.
It is therefore possible to detect the separating �ow region and the even clearer positive e�ect of the presence
of VGs.
For the Smooth case, the �ow condition considered is characterized by a fast decay of the skin friction
coe�cient in the initial portion of the airfoil near the leading edge. This behaviour most probably corresponds
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to the laminar �ow region.
Very close to the leading edge, at the position of x/c = 0.06, the �ow already transitions to turbulent
conditions, and the skin friction coe�cient decays downstream of this position, reaching a zero value at
x/c = 0.76.
At this location, the �ow separates leading to detachment from the surface, as it can be seen by the skin
friction coe�cient values of the remaining portion until the trailing edge. These values are slowly increasing
after the �ow separation point, but with very low values, indicating that there is a small �uid fraction which
is still in contact with the airfoil surface.
The use of VGs in this case clearly prevents �ow separation, as it can be evinced from the skin friction curves
behaviour for both the VG x/c=0.2 h=6mm and the VG x/c =0.3 h=6mm.
Both VG con�gurations cause a higher skin friction downstream of them, not reaching a zero value in the
airfoil portion which otherwise would experience �ow separation.
It can also be noticed that the presence of VGs triggers transition to turbulent conditions earlier than the
Smooth case, in the upstream portion of the airfoil.
Regarding this airfoil application, it could be stated that the VG x/c=0.3 h=6mm con�guration is the most
favourable regarding aerodynamic e�ciency, with lower skin friction values than the other VG case, and
therefore, less drag force.
In Figure 6.8, the magnitude of the skin friction coe�cient for a deep stalled �ow condition is shown.
These two plots are obtained using the same method as for what done in Figure 6.7, regarding the spanwise
and streamwise locations considered.
The FFA-W3-241 plot is obtained for all the cases at the same α = 14.4° angle of attack, while the FFA-W3-
301 plot is obtained for all the related cases at α = 12.9°.
In the FFA-W3-241 plot, it is shown that the VG h=4mm con�guration helps to delay separation, but not
completely prevent it, since the separation point is only moved further from x/c = 0.55 to x/c = 0.75. The
other two VG cases are able to prevent separation completely, since the skin friction coe�cient values never
reach the separated condition denoted by a zero value.
In the FFA-W3-301 plot, the trend observed for the previous corresponding case at an angle of attack of
α = 10.2° is con�rmed. The only di�erence is in the separation point position, that is displaced before than
the previous case mentioned, since the �ow is characterized by a stronger adverse pressure gradient.
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Figure 6.7: Skin friction magnitude coe�cient comparison of all the simulated con�gura-
tions. On the top plot, the FFA-W3-241 airfoil case at an angle of attack of α = 10.2◦ is
shown, displaying the Smooth, VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and the VG
x/c=0.3 h=6mm con�gurations. On the bottom plot, the FFA-W3-301 airfoil case at an
angle of attack of α = 11.2◦ is shown, displaying the Smooth, VG x/c=0.2 h=6mm and
the VG x/c=0.3 h=6mm con�gurations.
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Figure 6.8: Skin friction magnitude coe�cient comparison of all the simulated con�gura-
tions. On the top plot, the FFA-W3-241 airfoil case at an angle of attack of α = 14.4◦ is
shown, displaying the Smooth, VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and the VG
x/c=0.3 h=6mm con�gurations. On the bottom plot, the FFA-W3-301 airfoil case at an
angle of attack of α = 12.9◦ is shown, displaying the Smooth, VG x/c=0.2 h=6mm and
the VG x/c=0.3 h=6mm con�gurations.
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6.2.3 Contour Plots

In Figure 6.9 and Figure 6.10, the vorticity magnitude evolution in the streamwise direction of the FFA-W3-
301 airfoil it is displayed, for both the Smooth case and the VG x/c=0.2 h=6mm con�guration, at an angle
of attack of α = 12.9◦.
The streamwise locations considered are x/c = 0.1054, x/c = 0.2106, x/c = 0.26, x/c = 0.3159, x/c = 0.36,
x/c = 0.4211, x/c = 0.6316, x/c = 0.8421.
In each contour plot, 20 equally spaced levels are shown, from a vorticity magnitude value of 0 to a value of
150.
The domain from the CFD simulations was re�ected with respect to the minimum spanwise coordinate (y-
coordinate), to reproduce the VG pair simulated. In the y-axis, the normal distance from the airfoil surface
is considered.
The plots present the boundary layer region at the suction side, where the VG is positioned.
It was chosen to display the vorticity magnitude, since this is a quantity that allows a clear qualitative
evaluation of the intensity of the vortical structures arising due to the in�uence of VGs.
Looking at the VG �gure, it can be seen that immediately donwstream of the VG location, at x/c = 0.2106,
small turbulent structures appear in the boundary layer region. This increased turbulence is the direct
e�ect of the VG presence, and together with the primary vortices helps in energizing the boundary layer,
mantaining it attached to the wall.
These turbulent structures soon grow in radius, as shown in the x/c = 0.26 streamwise position: the two
primary vortices identi�ed by Velte, that where introduced in Section �3.1, become, therefore, identi�able.
Proceeding downstream, the two vortices gradually lose their intensity: this is due to the energy dissipation
from larger to smaller turbulent scales, as explained in 2.3.2. As a consequence of this, the vortices tend to
increase more their radius, thus progressively converging on each other.
The counter-rotating vortical movement of the VG pair's vortices can be easily evinced from the smoothed
contours. This movement is causing the �ow in the boundary layer to be forced closer to the wall, as can
be seen from the x/c = 0.36 location on. Moreover, in the middle region between the two vortices a slight
increase in the boundary layer thickness is also noticeable, when compared to the extreme spanwise positions
of the plot being considered.
The situation depicted is typical of the common-�ow-down category for a counter-rotating VG pair, where
the outer �ow is entrained near the wall in the middle-spanwise area between the VGs.
From the comparison between the smooth and the VG case of interest, it can be seen that starting from
x/c = 0.26, the boundary layer is considerably thinned in the VG case, as it would be expected using this
type of passive �ow control device. The �ow separation that would otherwise occur for some streamwise
location after x/c = 0.6316, is clearly prevented. This can be seen in particular for the x/c = 0.8421 position
considered, where the �ow leaving the airfoil surface is identi�ed by lighter blue regions surrounded by darker
blue areas. For the VG case in the same position, only the dissipating vortical movement of the vortices
induced by the VG is identi�able in the same �ow area, with a lower boundary layer region still presenting
enough vorticity to sustain the adverse pressure gradient.
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Figure 6.9: Vorticity magnitude contour plots for the FFA-W3-301 airfoil at an angle of
attack of α = 12.9◦ for the Smooth case.
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Figure 6.10: Vorticity magnitude contour plots for the FFA-W3-301 airfoil at an angle of
attack of α = 12.9◦ for the VG x/c=0.2 h=6mm case.
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In Figure 6.11 and Figure 6.12, the FFA-W3-301 is again considered, at an angle of attack of α = 12.9◦,
displaying the velocity components for di�erent streamwise positions using smoothed contour plots. Since
the VG is positioned at the suction side of the airfoil, where the �ow would experience the greater separation,
in the plots the boundary layer region is presented for this side of the airfoil. From left to right, the columns
show to the u, v and w velocity components, respectively, related to the corresponding x, y and z geometrical
axis.
The velocity components u, v and w resulting from the SU2 simulations are nondimensionalized internally in
the solver with respect to the freestream velocity. A value greater than 1 represents therefore a local increased
velocity compared to the undisturbed freestream velocity value, whereas a value lower than 1 indicates a local
decrease in velocity.
The contour levels chosen for each plot are determined by a sequence of 20 linearly spaced values. The levels
vary from the minimum to the maximum value displayed in each plot, thus changing for every streamwise
position considered.
The domain from the CFD simulations was re�ected with respect to the minimum spanwise coordinate (y-
coordinate), to reproduce the simulated VG pair. In the y-axis, the normal distance from the airfoil surface
is considered.
Regarding the smooth case, in the left column the acceleration that the u component is subject to is clearly
seen. This is displayed by the red range of values resulting in values up to u = 1.8, from the streamwise
location at x/c = 0.1054 to the position at x/c = 0.4211. These higher velocities are the e�ect of the
highly-cambered FFA-W3-301 airfoil shape, characterized by a 30% thickness at the point of maximum lift
at x/c = 0.3. The curvature introduced in the �ow �eld by the presence of the airfoil solid object is what
induces the described local acceleration. At the x/c = 0.6316 position, the initial �ow reversal at the wall
can be noticed by the appearance of a very small negative u value in the scale of the contour levels.
The v velocity component in the Smooth case, presented in the middle column, allows the identi�cation of
the vortical movements in the boundary layer. These are displayed by the blue and red contour regions
appearing in the plots. From the contour level bar at the side of the plot, it can be evinced that the red
regions are related to a positive v component, whereas, the blue regions indicate a negative v component.
Relative to each plot-coordinates frame-of reference, that could be evinced by the axis values for each plot,
a positive v value characterizes a velocity vector in the right direction of the plot considered, and a negative
v value denotes instead a velocity vector pointing in the left direction of the plot.
With this information, the growing vortices inside the boundary layer can be qualitatively evaluated.
These vortices present stronger velocity components in the �rst streamwise positions, i.e x/c = 0.1054 and
x/c = 0.2106. Two stronger vortices in the middle region of the �ow domain are identi�able, with weaker
vortices at the two sides of the plot. The vortices in the middle are initially characterized by a larger radius,
when compared to the vortical structures at the sides.
Proceeding downstream, the spanwise v velocity values decrease in both the minimum and maximum values.
The vortices in the middle are seen to grow in radius slower than the vortices at the side, which become
predominant from x/c = 0.4211 on. In the last contour plot shown at x/c = 0.6316, it can be seen that
the vortices at the sides prevail over the vortical structures in the middle, and that two main diverging �ow
directions are noticeable, pointing to the sides of the �ow domain.
The w velocity component, in the right column of the Smooth case �gure, does not add any meaningful
information. In fact, it shows that, in the �rst locations until the point of maximum lift, i.e from x/c = 0.1054
to before the x/c = 0.36 position, the velocity points in the upward direction due to the curvature of the
airfoil. From the point of maximum lift at x/c = 0.3 on, the velocity is characterized mainly by a downward
movement, trying to follow the airfoil shape curvature. It can be noted that in the x/c = 0.6316 location, in
the region closer to the wall, the �ow is characterized by a growing upward w velocity component, indicating
the start of separating �ow phenomena.
From the evaluation of Figure 6.11, it can be stated that the separation occurring for the considered �ow
situation is mainly due to the combined e�ect of the streamwise u velocity component and the spanwise
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v velocity component. The w component only shows the expected behaviour, following the airfoil shape
curvature, with the indication of a growing upward velocity direction after x/c = 0.6316.
It is possible at this point to compare the �ow velocity behaviour described for the Smooth case with the VG
pair case.
Related to the u component in the left column, the main e�ect of the VG pair is to introduce a deceleration
at the sides of the �ow domain. This deceleration corresponds to the vortical regions of the two induced
vortices, inside of which u decreases due to the viscous dissipation becoming predominant. Regarding the
maximum u values, an overall increase can be seen in the boundary layer middle region, when compared to
the Smooth case. This is a clear indication of the energization of the boundary layer, since the �ow presenting
a higher streamwise velocity component, is able to resist the adverse pressure gradient experienced after the
point of maximum lift.
The v component in the middle column shows the disappearence of the vortical movement that was noticed
for the Smooth case in the middle region of the boundary layer.
At the x/c = 0.1054 location, with respect to the Smooth case, smaller and weaker vortices are present,
spread on the airfoil surface.
Right after the VG location, the disappearance of the two vortices in the middle region mentioned before
is visible. With the considerations introduced for the Smooth case, related to the colours displayed in the
contour plots and the corresponding signs of the v component, the two counter-rotating vortices introduced
by the VG presence in the �ow �eld can be identi�ed.
These are the two main vortical structures that are present in the �ow �eld downstream of the VG. In the
middle region of the boundary layer, the energization by the mixing induced by the vortices creates a mainly
streamwise velocity direction that helps in preventing �ow separation reducing �ow lateral movements.
The w component in the right column indicates, at the sides of the �ow domain, a �ow movement away from
the wall. This con�rms what has been seen in the vorticity magnitude contour plots in Figure 6.10, where the
vortices tend to lift away from the wall, increasing their radiuses and consequently lowering their intensity
due to the viscous dissipation. In the middle region of the boundary layer, a strong tendency of the �ow to
move towards the wall is seen, that explains the persistence of an attached �ow condition downstream of the
VG. This behaviour is expected from a common-�ow-down counter-rotating VG con�guration.
From the evaluation of Figure 6.12, a typical �ow behaviour for the VG con�guration investigated is noticed,
thus con�rming that, from a qualitative point of view, the simulations are able to capture the relevant 3D
�ow features. In fact, it is shown that the �ow remains attached to the airfoil surface in the boundary
layer, due to the combination of the increasing streamwise u velocity component and the strong downward
movement of the w component. The middle vortices in the boundary layer, that were present in the Smooth
case, disappear. This can be considered one of the causes for the delay of the streamwise separation location,
since the two main vortices, arising after the VG location, mix with each other later than what would occur
in the Smooth case. In this situation, in fact, an earlier mixing of the two main vortical structures in the
boundary layer, the middle and the lateral ones, is seen to create a strong �ow divergence that is likely to
contribute to the 3D �ow separation phenomenon.
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1Figure 6.11: Velocity components contour plots for the FFA-W3-301 airfoil at an angle of
attack of α = 12.9◦ for the Smooth case. The left column shows the u component in the
x direction (airfoil streamwise direction). The middle column shows the v component in
the y direction (airfoil spanwise direction). The right column shows the w component in
the z direction (direction normal to the airfoil).
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1Figure 6.12: Velocity components contour plots for the FFA-W3-301 airfoil at an angle
of attack of α = 12.9◦ for the VG x/c=0.2 h=6mm case. The left column shows the u
component in the x direction (airfoil streamwise direction). The middle column shows
the v component in the y direction (airfoil spanwise direction). The right column shows
the w component in the z direction (direction normal to the airfoil).
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6.3 Question 3

The third question is discussed considering the boundary layer from an averaged 2D point of view. This is
performed through the evaluation of the 2D vorticity magnitude and the u velocity pro�les, together with the
boundary layer thickness for the cases considered. In addition to these �gures, the three integral boundary
layer thicknesses introduced in Section �2.4 are calculated, showing the results through cumulative plots of
all the Smooth and VG con�gurations tested, for all the simulated angles of attack.

6.3.1 Boundary Layer Pro�les Analysis

In Figure 6.13, the vorticity magnitude evolution at the suction side of the FFA-W3-241 airfoil is shown along
with the boundary layer thickness, for an angle of attack of α = 8.8°.
This plot was obtained extracting the solution along lines normal to the airfoil surface, up to a distance of
d = 0.08∗ c, with c being the airfoil chord. A total of 30 linearly spaced streamwise locations was considered,
and for each streamwise position, 20 spanwise locations lines were extracted. The pro�les corresponding
to a given streamwise location are obtained averaging all the corresponding extracted lines in the spanwise
direction.
The vorticity magnitude is obtained from the vorticity �eld, computed as the curl of the velocity �eld resulting
from the simulations.
The boundary layer thickness evolution line is obtained considering that the vorticity magnitude tipically
decays exponentially from the airfoil surface to the outside of the boundary layer, where it reaches a zero
value.
It is therefore possible to detect the edge of the boundary layer by �ltering the vorticity magnitude values,
from the maximum value down to a minimum value threshold speci�ed by the user (usually as a percent
value threshold, typically in the order of magnitude of 10−2).
In this plot, the increase in the boundary layer thickness due to the presence of the VG can immediately be
seen. This is due to the induced vortex inside the boundary layer, causing a greater vorticity and thus a shift
in the boundary layer edge.
In the position upstream of the VG, the vorticity magnitude pro�les of the Smooth and VG case almost
match. As the �ow is approaching the obstacle caused by the VG, its presence is detected by the �ow,
causing a slight increase in vorticity, when compared to the Smooth case.
Immediately after the VG position, for the case taken into consideration (x/c = 0.2m), the vorticity magni-
tude pro�les of the VG solution show an increase in vorticity in the region near the airfoil surface. A peak
in the vorticity magnitude pro�les starts to arise.
This peak is most probably corresponding to the peak that would be expected in the region of maximum
vorticity inside the vortex generated.
Proceeding downstream, the vorticity pro�les reveal that initially the vortex stays closer to the wall, with a
greater vorticity in this area. The vorticity peak denoted before decreases in magnitude, and the cross-section
of the ideal vortex tube starts to diverge, as denoted by the stretching of the pro�les. This is the cause of
the greater boundary layer thickness.
The pro�les are more and more stretched in the normal direction as the trailing edge is approached, and this
denotes the lift-o� of the vortex from the surface. In this region, the boundary layer thickness increases, but
the vorticity near the airfoil surface decreases in magnitude when compared to the Smooth case.
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Vorticity Magnitude Profiles
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Figure 6.13: Vorticity magnitude 2D pro�les in the streamwise direction, with the bound-
ary layer thickness evolution. The airfoil considered is the FFA-W3-241 at an angle of
attack of α = 8.8◦. The con�gurations displayed are the Smooth and the VG x/c=0.3
h=6mm.
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In Figure 6.14, the streamwise-component velocity pro�les development in the streamwise direction, for the
FFA W3 301 airfoil, is shown, at an angle of attack α = 12.9◦. The VG con�guration considered is the VG
x/c=0.3 h=6mm.
The pro�les were obtained extracting lines normal to the airfoil surface, up to a distance of d = 0.08 ∗ c, with
c the airfoil chord. The lines are considered at 30 di�erent streamwise locations and 20 di�erent spanwise
locations. The plots show the u values for each streamwise locations, averaged with respect to the spanwise
direction.
From the �gure, it can be seen how the streamwise-component u evolves on the airfoil surface.
Before the location where the VG is positioned, the pro�les of the Smooth and the VG case are nearly
identical. They show the characteristic turbulent pro�les shape, with very large velocity gradients near the
wall, followed by the distinguishable slope change, up to the freestream constant value, that identi�es the
turbulent mixing region.
Right after the VG, from the analysis of the pro�les shape, it can be seen that the �ow modi�cation induced
is resembling one similar to the presence of an obstacle in the �ow, as it is actually experienced by the
streamwise �ow developing near the airfol surface. In the very �rst two locations after the VG, that is the
two x/c = 0.32 locations (coordinates were rounded for displaying purposes), two distinct �ow regions can
be identi�ed in the boundary layer, one characterized by an almost zero velocity, and the other identi�ed by
the freestream U∞ velocity value.
As the �ow proceeds downstream, the region characterized by a zero velocity regains a higher u value already
at the x/c = 0.42 location. The velocity pro�les at nearly zero distances values, that is close to the airfoil
surface, show a shape similar to the one shown in 2.3.2.
Due to the vortex arising in the �ow, caused by the VG presence, �ow mixing occurs in a shear layer at a
certain distance from the wall. From the velocity pro�les shape, this shear layer region can be identi�ed by
the slope change of the curves between the turbulent velocity pro�le near the airfoil wall surface, and the
outer free stream constant pro�le.
Starting from the x/c = 0.42 streamwise position, the e�ect of the adverse pressure gradient can be quali-
tatively evaluated by the considerable deceleration that the Smooth case velocity pro�les are experiencing.
The position of the velocity pro�le in�ection that can be regarded as the beginning of �ow separation is
identi�able at x/c = 0.68, after which a �ow reversal appears and aerodynamic stalled conditions develop.
From this location on, the positive e�ect of the VG in the �ow is clearly visible. The corresponding velocity
pro�les do not show the in�ection and �ow reversal behaviour that characterizes separated �ow conditions.
The �ow can therefore be considered staying attached on the whole airfoil surface.
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Figure 6.14: 2D pro�les of the u velocity component in the streamwise direction, with
the boundary layer thickness evolution. The airfoil considered is the FFA-W3-301 at an
angle of attack of α = 12.9◦. The con�gurations displayed are the Smooth and the VG
x/c=0.3 h=6mm.
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6.3.2 Integral Boundary Layer Analysis

In the following �gures, from Figure 6.15 to Figure 6.17, the integral boundary layer quantities displacement
thickness δ∗, momentum thickness θ, and energy thickness θ∗ are displayed, for all the con�gurations and
angles of attack simulated for the FFA-W3-241 airfoil.
These �gures were obtained extracting lines normal to the airfoil surface, from 30 di�erent streamwise loca-
tions and 20 di�erent spanwise locations. The plots show the calculated thicknesses values for each streamwise
locations, averaged with respect to the spanwise direction.
In Figure 6.15 the calculated displacement thickness δ∗ is displayed.
It can be seen that at angles of attack near stall, for example α = 8.8◦, the presence of VGs in the �ow�eld
induces a higher displacement thickness when compared with the Smooth case.
The highest δ∗ values at the trailing edge are obtained in the VG x/c=0.2 h=6mm case. Recalling 2.4.3, it was
said that the displacement thickness could be interpreted as the height of the free-shear-layer centerline for
separated �ow conditions. In this case, since the VG introduces an additional mixing in the �ow, an associated
free-shear-layer can be considered forming, therefore allowing the use of the mentioned interpretation. It can
then be stated that a VG of an elevated height, placed at an early streamwise location under �ow conditions
close to the stalled ones, causes a free shear layer at a higher distance from the airfoil surface than the
other con�gurations investigated. Being δ∗ also the mass defect of the real �ow compared to a theoretically
Equivalent Inviscid Flow (see 2.4.3), a higher displacement thickness value implies, from an integral boundary
layer point of view, less energy in the boundary layer donwstream of the VG, caused by this higher shear
layer.
When considering more developed stalled �ow conditions, occurring at higher angles of attack, the e�ect
of VGs is to decrease progressively the growth of δ∗ along the streamwise direction. With the information
reintroduced before in 2.4.3, this indicates a lower mass defect and therefore an increased energy in the
boundary layer. The bene�cial e�ect of VGs in terms of aerodynamic performance can be clearly evaluated
when considering deep stall �ow conditions such as the ones at α = 14.4◦. The displacement thicknesses
of the VG cases maintain much lower values along the streamwise direction than the corresponding Smooth
case. The lowest δ∗ values for high angles of attack are obtained in the VG x/c=0.3 h=6mm case. This
indicates that, in order for wind turbines to withstand more severe operating conditions, a single strip of
VGs of an elevated height, placed at a farther streamwise location from the leading edge, can be employed,
allowing attached �ow conditions for a longer streamwise distance.
In Figure 6.16, the momentum thickness θ is displayed.
From this �gure, an increase in the momentum thickness is seen for all the VG cases considered, when
compared to the Smooth reference. The highest θ values are obtained with the VG x/c=0.2 h=6mm case.
Recalling the physical explanation of the momentum thickness θ introduced in 2.4.3, related to the momentum
defect due to the drag force, from the curves plotted it can evinced that using a VG with an elevated height at
an early streamwise position causes a detrimental e�ect on the airfoil performance. In fact, the VG x/c=0.2
h=6mm case highlighted before shows an increase in the momentum thickness, implying an increase in drag.
In this VG con�guration the displacement thickness δ∗ is also high with respect to other VGs con�gurations.
Being the mass defect δ∗ related to less energy in the �ow, as stated previously, the information from θ,
together with the behaviour of δ∗, explains the detrimental e�ect on the airfoil performance for the VG
con�guration mentioned previously.
From the momentum thickness curves, the transition from laminar to turbulent �ow conditions can be evinced
more easily than from the behaviour of the displacement thickness curves. The typical slope change can be
detected more clearly, and it can be seen that it occurs at the VG location of the con�guration considered.
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Figure 6.15: Displacement thickness calculated for the FFA-W3-241 airfoil. The angles
of attack considered are α = 8.8◦, α = 10.2◦, α = 12.6◦, and α = 14.4◦. The con�gura-
tions displayed are Smooth, VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and VG x/c=0.3
h=6mm.
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Figure 6.16: Momentum thickness calculated for the FFA-W3-241 airfoil. The angles of
attack considered are α = 8.8◦, α = 10.2◦, α = 12.6◦, and α = 14.4◦. The con�gura-
tions displayed are Smooth, VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and VG x/c=0.3
h=6mm.
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In Figure 6.17, the energy thickness θ∗ is displayed.
In 2.4.3, it was seen that the physical interpretation of the energy thickness was related to the combined
action of the drag and the viscous forces. Being the integral boundary layer thicknesses generally related to a
defect of a certain physical quantity, in the case of the energy thickness, this is related to an energy defect of
the real boundary layer compared to an inviscid ideal �ow (EIF). Since the vortices induced in the �ow�eld
by VGs introduce viscous dissipation in the �ow through a shear layer, with the physical interpretation cited
previously, it can be stated that the use of VGs increases the energy defect donwstream of the VG location,
thus increasing the energy dissipated in the boundary layer.
This would seem in contrast with what said in previous considerations, where the enhanced mixing of VGs
in the �ow was said to cause an energization, allowing attached �ow conditions. The explanation for the
increased energy thickness is to be found in the averaging processing of the 3D data, that smooths the local
�ow behaviour. This smoothing is then subject to an additional integration to derive the integral boundary
layer quantities. The resulting values are due to the averaged sum of regions where the �ow is not energized,
that is near the vortices, and of regions where the �ow is e�ectively mantained closer to the wall, through
the entrainment from the vortices of the outer high energy �ow.
The energy thickness curves show a behaviour similar to the momentum thickness ones. This follows from the
de�nition of the two thicknesses, being in fact the energy thickness proportional to the momentum thickness
through a factor (1 + u/U∞). Hence, it is displayed that, for all the angles of attack considered, the VG
x/c=0.2 h=4mm con�guration causes the highest energy thickness; for the momentum thickness the same
VG con�guration shows analogously the maximum values. Similarly to the previous explanation, this is
related to an increase in drag, but also for this particular case to an increased vicous dissipation. This
dissipation develops earlier than what would instead happen with a VG positioned at greater streamwise
locations, causing therefore more disadvantages than bene�ts.
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Figure 6.17: Energy thickness calculated for the FFA-W3-241 airfoil. The angles of attack
considered are α = 8.8◦, α = 10.2◦, α = 12.6◦, and α = 14.4◦. The con�gurations dis-
played are Smooth, VG x/c=0.2 h=4mm, VG x/c=0.2 h=6mm, and VG x/c=0.3 h=6mm.
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In Figure 6.18 to Figure 6.20, the displacement thickness, momentum thickness and energy thickness for the
FFA-W3-301 airfoil are displayed, for all the con�gurations and simulated angles of attack.
These �gures were obtained extracting lines normal to the airfoil surface as done for the FFA-W3-241 case;
30 di�erent streamwise locations and 20 di�erent spanwise locations were considered. The plots show the
calculated thicknesses values for each streamwise locations, averaged with respect to the spanwise direction.
In all the three �gures, relatively to each integral boundary layer thickness, similar considerations to the ones
presented for the FFA-W3-241 airfoil can be stated.
For the FFA-W3-301, the decrease of δ∗ and the increase of θ and θ∗ when using VGs are more pronounced
than the FFA-W3-241 case.
The same physical interpetations stated for the FFA-W3-241 integral thicknesses can be applied too, with
the addition that the change of slope due to the transition from laminar to turbulent is even more visible
from the energy and momentum thicknesses plots. The order of magnitude of the calculated δ∗, θ, and θ∗ is
comparable with the values obtained for the FFA-W3-241 airfoil.

0.000

0.025

0.050

0.075

0.100

0.125

0.00 0.25 0.50 0.75 1.00
x/c

δ*

Case AoA11_2 AoA12_9 AoA14_6 AoA9

Case Smooth VG_xc02_6mm VG_xc03_6mm

Displacement Thickness Plot

Figure 6.18: Displacement thickness calculated for the FFA-W3-301 airfoil. The angles
of attack considered are α = 9◦, α = 11.2◦, α = 12.9◦, and α = 14.6◦. The con�gurations
displayed are Smooth, VG x/c=0.2 h=6mm, and VG x/c=0.3 h=6mm.
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Figure 6.19: Momentum thickness calculated for the FFA-W3-301 airfoil. The angles of
attack considered are α = 9◦, α = 11.2◦, α = 12.9◦, and α = 14.6◦. The con�gurations
displayed are Smooth, VG x/c=0.2 h=6mm, and VG x/c=0.3 h=6mm.
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Figure 6.20: Energy thickness calculated for the FFA-W3-301 airfoil. The angles of attack
considered are α = 9◦, α = 11.2◦, α = 12.9◦, and α = 14.6◦. The con�gurations displayed
are Smooth, VG x/c=0.2 h=6mm, and VG x/c=0.3 h=6mm.
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6.4 Question 4

The fourth question is discussed considering 3D visualization techniques. This is performed using Vortex
Cores Line detection, Q-Criterion calculations and Surface Line Integral Convolution visualizations.

6.4.1 Vortex Cores Line

In Figure 6.21, it is shown the vortex core line extracted from the simulation results, together with the u
velocity component pro�les. This line is representative of the presumed vortex core centre as it evolves in
the streamwise direction. The airfoil con�guration considered is the FFA-W3-301 VG x/c=0.3 h=6mm at
an angle of attack of α = 12.9◦.
Recalling what said in Figure 6.14, it can be seen that the vortex core line extracted from the data is in
agreement with the considerations about the change of slope. This change of slope occurrs outside the viscous
sublayer, in the outer region of the turbulent boundary layer. Outside the viscous sublayer, as can be seen
in the �gure, the e�ect of the VG regarding the slope of the pro�les is to introduce a local minimum for each
pro�le. These local minima can be physically interpreted as describing the locations near to the vortex core.
This seems to be in contrast with intuitive physical considerations regarding ideal irrotational vortices. These
are known to be characterized by a minimum pressure region near the vortex core, and therefore, a higher
velocity. The real vortices evolution is instead in�uenced by a dissipation phenomena due to viscosity; inside
the vortex region this a�ects considerably the velocity, decreasing it if compared to the region outside the
vortex. For this reason, lower velocities are identi�able in the vortices region.
Therefore, it can be seen that the vortex core line extracted is close to the ideal line that would connect the
local minima in the velocity pro�le, con�rming this interpretation.
In the vortex core line extraction process, the parameters tuning procedure of the model is of fundamental
importance, since it a�ects the number of points on the vortex core line extracted. As for the line obtained,
various parameters combinations were tested, and the �nal set-up reported in Section �5.4 allowed to attain
a qualitatively representative line of the VG vortex centre path. However, the number of points of the line
extracted is not su�cient to describe the vortex propagation until the trailing edge of the airfoil. It is believed
that the reason for this incomplete point detection is related to the progressive vortex dissipation and mixing
with the outer �ow, that prevents a proper detection of the vortex centre evolution.
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1Figure 6.21: Pro�les evolution of the u velocity component, together with the vortex core
line extracted. The con�guration considered is the FFA-W3-301 VG x/c=0.3 h=6mm at
an angle of attack of α = 12.9◦.

115



Chapter 6: Results

6.4.2 Q-Criterion

From the top image in Figure 6.22, the vortex tube evolution is shown for the FFA-W3-301 VG x/c=0.3
h=6mm case, at an angle of attack of α = 12.9◦. This �gure is created from the Q-Criterion calculation,
displaying the contour level value of 30. It can be seen that it is possible from the simulation performed
to capture the evolution of the vortex tube arising from the VG. The vortex tube was coloured by the
corresponding vorticity magnitude values, showing the decay of the strength of the vortex as it proceeds
downstream the VG location.
From the bottom image in Figure 6.22, is shown the vortex tube evolution, together with the vortex core
line extracted. The case considered is the same FFA-W3-301 VG x/c=0.3 h=6mm, at an angle of attack of
α = 12.9◦. It is clearly shown in this image that the vortex core line is indeed representative of the vortex
tube that describes the induced vortex due to the VG presence on the �ow �eld.
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Figure 6.22: Q-Criterion visualization for the FFA-W3-301 VG x/c=0.3 h=6mm con�g-
uration, at an angle of attack of α = 12.9◦. The top image shows a contour level value
of 100 for the Q-Criterion calculated. The bottom image shows the same case as the top
image, together with the vortex core line extracted.
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6.4.3 Surface Line Integral Convolution

In Figure 6.23, the skin friction coe�cient lines are displayed on the airfoil surface. This image was obtained
using a surface Line Integral Convolution representation of the skin friction coe�cient vector created with
the skin friction coe�cient components present in the SU2 simulations results. In this picture, the VG pair
is recreated mirroring the surface �ow solution with respect to the minimum spanwise coordinate.
In the VG x/c=0.2 h=6mm case, the two vortices arising from the VG pair can be easily noticed by the skin
friction lines pointing to the sides of the �ow domain. These skin friction lines show a curved behaviour that
resembles the vortical movement of the �ow near the airfoil surface. In the middle region, the skin friction
lines are mainly oriented in the streamwise direction, identifying an attached �ow condition. For this VG
con�guration, no �ow separation is experienced, and this can be observed by the absence of clear converging
skin friction lines on the airfoil surface.
In the Smooth case, the skin friction lines show a main streamwise direction. Flow separation in this case
is expected to occur at around x/c=0.6 from the 2D skin friction magnitude �gure in Figure 6.8. From
a qualitative evaluation of this 3D image, the visual inspection of the skin friction lines shows a strange
behaviour of the lines around the x/c=0.6 streamwise location, although it is not the converging behaviour
expected from the theoretical explanations of �ow separation for 3D �ows presented in Section �2.5.
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Figure 6.23: Surface Line Integral Convolution visualization of the skin friction vector, for
the FFA-W3-301 Smooth and VG x/c=0.2 h=6mm con�gurations. The angle of attack
is α = 12.9◦. The top image shows the Smooth con�guration. The bottom image shows
the VG x/c=0.2 h=6mm con�guration.
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6.5 Conclusions

In this chapter, the simulation results were discussed for each research question proposed. In the following
chapter, the conclusions of this analysis are presented, answering the research questions together with future
work recommendations.
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Conclusions

In this thesis, a numerical investigation of the e�ect of vortex generators placed at the suction side of various
wind turbine airfoil sections was conducted.
The airfoil sections and con�gurations are reported in [23]. From this paper, it was decided to analyze
the FFA-W3-301 and the FFA-W3-241 sections, considering angles of attack in near-stalled �ow conditions.
This choice was motivated by the visual inspection of the values of the lift and drag coe�cients from the
experimental data: in these �ow conditions a qualitative analysis could show clearly the bene�ts of such
devices regarding �ow separation prevention. The con�gurations analyzed from the paper consider two
di�erent VG heights, h=4mm and h=6mm, and two di�erent airfoil sections streamwise positions, x/c=0.2
and x/c=0.3.
CAD models of the geometrical con�gurations of the airfoil sections, with and without the VGs strips, were
created, simulating only a single VG instead of the original VG pair. This allowed a reduction in the number
of grid cells generated during the subsequent mesh creation process, reducing the computational time. The
simulations were run using the current SU2's incompressible solver, investigating its capabilities. The result
were investigated discussing four research questions introduced in Section �1.2, to which an answer is provided
as follows:

Question 1

The �rst question proposed was:

Is the current SU2's incompressible solver implementation able to reproduce vortex

generators' experimental results up to a reasonable degree of accuracy?

From the analysis of Figure 6.1 to Figure 6.4, it can be concluded that the results obtained from the simula-
tions generally do not match the experimental values of reference. This becomes clear when considering the
comparison between the lift and drag coe�cient for the cases simulated, but it is less obvious when examining
the pressure coe�cient plots. In fact, when considering the FFA-W3-241 airfoil in the Smooth con�gura-
tion case at an angle of attack of α = 8.8◦, together with the α = 10.2◦ case in the Smooth, VG x/c=0.2
h=4mm, VG x/c=0.2 h=6mm and VG x/c=0.3 h=6mm con�guration, it seems that the simulations do not
mispredict excessively the reference values from the experiments in [23]. In the remaining cases, for both
the FFA-W3-241 and the FFA-W3-301 airfoils, the results from the simulations are clearly di�erent from the
experimental values. The substantial deviation, with respect to the experiments, of the values of lift and
drag coe�cient obtained numerically with SU2, could be explained considering that, even if in some cases
the pressure qualitatively seems predicted reasonably well, the small di�erences still contribute signi�cantly
during the integration to obtain the lift and drag forces and the related coe�cients.
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Question 2

The second question proposed was:

Are the results obtained from the simulations qualitatively describing the relevant �ow

modi�cations?

From the analysis of Figure 6.5 to Figure 6.12, it can be stated that the relevant �ow features are captured
qualitatively.
Regarding the pressure coe�cient, Figure 6.6 show that the �ow mixing induced by the VGs is delaying
�ow separation. Overall, the VG presence is seen to decrease the pressure at the suction side more than the
corresponding Smooth cases, as it would be expected from the use of such devices. The decrease in pressure
at the suction side causes an increase in lift, con�rming what was seen also in the reference paper.
As for the skin friction coe�cient magnitude, it is shown clearly from both Figure 6.7 and Figure 6.8 how
the VGs increase the skin friction because of the vortical mixing. This favourable e�ect with regard to �ow
separation mantains a skin friction value high enough to be able to withstand the adverse pressure gradient,
thus mantaining the �ow attached until the trailing edge.
From the contour plots of the vorticity magnitude in Figure 6.10, the primary vortices described in [18] are
captured. Regarding the secondary vortical movements, these are not captured in the simulations results, in
accordance to what would be generally expected from Reynolds Averaged Navier Stokes CFD simulations.
In the contour plots of the velocity components in Figure 6.12, the �ow generally tends to stay closer to
the wall, as indicated by the downward w velocity component (velocity in the z direction). This con�rms
the bene�ts of VGs in mantaining the �ow attached to the airfoil surface. In these plots, the dissipation
occurring in the vortices is also displayed: in fact, this is indicated by the lower u velocity component inside
the vortical structures.

Question 3

The third question proposed was:

Is a 2D boundary layer analysis showing the expected essential qualitative aspects?

From the analysis of Figure 6.13 to Figure 6.20, the main 2D boundary layer features are captured, as can
be seen from the vorticity magnitude pro�les in Figure 6.13 and from the u velocity pro�les in Figure 6.14.
The vorticity magnitude pro�les have the typical shape showing an exponential decay, with a distinguishable
peak in correspondence of the vortex. The vortex dissipation along the streamwise direction is depicted by
the decrease in magnitude of the peak.
The u velocity pro�les show clearly how the �ow is decelerated in the streamwise direction by the presence of
the VG. The pro�les show an in�ection in correspondence of the vortex core, and near the airfoil surface the
typical turbulent pro�le shape can be noticed. When comparing the Smooth and a VG case, the prevention
of separation is highlighted by the disappearance of the �ow reversal typical shape, characterized by negative
streamwise u velocity component values.
Regarding the integral boundary layer analysis from Figure 6.15 to Figure 6.20, the displacement thicknesses
δ∗ show an increase in values for the VG cases when compared to the Smooth ones, conferming the increased
drag force caused by the shear layer forming. The momentum thicknesses θ show the characteristic change
of slope in correspondence of the transition from laminar to turbulent �ow conditions, that occurs at the VG
location. In accordance with the displacement thickness behaviour, θ shows an increase caused by the drag
force as well. The energy thicknesses θ∗ tend to also increase when considering the use of VGs, due to the
combined action of drag forces and viscous dissipation.
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Question 4

The fourth question proposed was:

Is a 3D qualitative �ow visualization analysis displaying the important �ow features?

From the analysis of Figure 6.21 to Figure 6.23, it can be stated that the results are able to partially capture
3D �ow features.
From the representation of the vortex core line, together with the velocity pro�les, it can be seen that the
vortex core line extracted is representative of the in�ection points of the velocity pro�les. This is expected,
since this low-velocity region is the one where the highest dissipation occurs, that is, at the core of the vortex.
As for the vortex tube detection, the Q-Criterion is able to capture the vortex evolution up to a certain
streamwise location, after which the dissipation occuring and the consequent increase in the vortex tube
radius prevent a distinguishable visualization.
The skin friction lines' visualization, using a Surface Line Integral Convolution representation, shows that
the skin friction lines characterizing the �ow separation from the surface are not clearly identi�able. The
converging behaviour of the lines towards an asymptote is not detectable. However, the lines computed
describe the vortices movements on the surface with reasonable accuracy, when compared to the vortices
development shown in Figure 6.10.

Future Work

From the numerical analysis conducted, it is therefore possible to conclude that the current SU2's solver
implementation is capable to resolve the main �ow features. During the course of this thesis work, an
important aspect of the Pre-Processing phase was identi�ed in the mesh generation process. From Chapter 4
and from the �nal simulations' set-up in Chapter 5, a proper resolving of key �ow regions to investigate has
shown a considerable improvement in the resulting data obtained. However, this step of the Pre-Processing
phase is quite time-consuming, and even with an acceptable mesh resolution, the �nal results are still far
from the corresponding experimental data obtained. Therefore, it is believed that a further investigation on
di�erent mesh generation strategies could lead to an improved accuracy in the results.
Nevertheless, the results obtained are considered to be accurate enough to be used for modelling purposes,
especially in Integral Boundary Layer codes. In fact, from Figure 6.15 to Figure 6.20, it was shown that the
integral quantities computed already describe qualitatively the expected thicknesses curves' trends. From
these data, a suitable model for the 2D VG in�uence in the �ow �eld could be derived.
An attempt in this direction was presented in [66], where an integral boundary layer model for the e�ect of
VGs mounted on �at plates is introduced, with promising results.
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Appendix A

Boundary Layer Equations

A.1 Boundary Layer Equations

Following is the approach of Veldman [16] to derive the laminar boundary layer equations.
First an order of magnitude analysis is performed, to determine the corresponding factors by which to
nondimensionalize the 2D Navier-Stokes equations:
The relations are presented in Equation (A.1):

u ∼ U∞, x ∼ c, y ∼ δ, p ∼ ρU2
∞ (A.1)

where U∞ is the boundary layer edge velocity (the velocity that corresponds to the outer inviscid irrotational
�uid), x and y are the coordinates respectively in the tangential and normal direction to the surface, and δ
is the boundary layer thickness measured along the y direction here de�ned.
From the terms in Equation (A.2) it could be derived an expression for the velocity v, expressed in Equa-
tion (A.3):

∂u

∂x
+
∂v

∂y
= 0 (A.2)

(
U∞
c

)+(
v

δ
) = 0 ⇒ v ∼ U∞δ

c
(A.3)

The analysis for the x-momentum equation in Equation (A.4) provides for all the terms the relations in
Equation (A.5):

u
∂u

∂x
+ v

∂u

∂y
= −1

ρ

∂p

∂x
+ ν (

∂2u

∂x2
+
∂2u

∂y2
) (A.4)

(
U2
∞
c

) + (
U2
∞
c

) = (
U2
∞
c

) + (ν
U∞
c2

) + (ν
U∞
δ2

) (A.5)

Recalling the hypothesis of the boundary layer model stated in Equation (2.7), the viscous term ν ∂
2u
∂x2 can be

neglected, and from the remaining terms in Equation (A.6), the relation in Equation (A.7) can be obtained:

(
U2
∞
c

) + (
U2
∞
c

) = (
U2
∞
c

) + (ν
U∞
δ2

) (A.6)
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δ

c
∼

√
ν

U∞c
∼ 1√

Re
(A.7)

where Re = U∞c
ν is the Reynolds number, the nondimensional parameter that represents the ratio between

inertia and viscous forces.
Using Equation (A.7) in the expression for the velocity component v obtained in Equation (A.3), it is possible
to derive the �nal expression for this velocity component, shown in Equation (A.8):

v ∼ U∞δ

c
∼ U∞√

Re
(A.8)

Having performed this order of magnitude analysis, at this point it is possible to derive the nondimensional
boundary layer equations, applying the nondimensionalization to the original variables with the estimated
quantities just obtained, as expressed in Equation (A.9):

u ∼ U∞, x ∼ c, y ∼ δ, p ∼ ρU2
∞, v ∼ U∞δ

c
(A.9)

The nondimensional variables are the following ones in Equation (A.10), with the prime sign identifying
them:

x′ =
x

c
, y′ =

y

δ
=
y

c

√
Re, u′ =

u

U∞
, v′ =

v
U∞δ
c

=
v

U∞

√
Re, p′ =

p

ρU2
∞

(A.10)

The incompressible Navier-Stokes equations nondimensionalized are provided in Equation (A.11), Equa-
tion (A.12) and Equation (A.13):

U∞
c

∂u′

∂x′
+
U∞
c

∂v′

∂y′
= 0 (A.11)

U2
∞
c
u′
∂u′

∂x′
+
U2
∞
c
v′
∂u′

∂y′
= −U

2
∞
c

∂p′

∂x′
+ ν

U∞
c2

∂2u′

∂x′2
+ νRe

U∞
c2

∂2u′

∂y′2
(A.12)

U2
∞
c

1√
Re

(u′
∂v′

∂x′
+ v′

∂v′

∂y′
) = −

√
Re

U2
∞
c

∂p′

∂y′
+

1√
Re

ν
U∞
c2

∂2v′

∂x′2
+
√
Reν

U∞
c2

∂2v′

∂y′2
(A.13)

These equations can be simpli�ed, if Equation (A.11) is divided by U∞
c and if Equation (A.12) and Equa-

tion (A.13) are divided by the corresponding factor in front of the pressure term.
The resulting equations are shown in Equation (A.14), Equation (A.15) and Equation (A.16):

∂u′

∂x′
+
∂v′

∂y′
= 0 (A.14)

u′
∂u′

∂x′
+ v′

∂u′

∂y′
= −∂p

′

∂x′
+

1

Re

∂2u′

∂x′2
+
∂2u′

∂y′2
(A.15)

1

Re
(u′

∂v′

∂x′
+ v′

∂v′

∂y′
) = −∂p

′

∂y′
+

1

Re2
∂2v′

∂x′2
+

1

Re

∂2v′

∂y′2
(A.16)

132



Appendix A: Boundary Layer Equations

The �nal step is to take the limit for large Reynolds number, since this is the assumption for the viscous
forces to be neglected, obtaining in the end the �nal nondimensionalized boundary layer equations, reported
in Equation (A.17), Equation (A.18) and Equation (A.19):

∂u′

∂x′
+
∂v′

∂y′
= 0 (A.17)

u′
∂u′

∂x′
+ v′

∂u′

∂y′
= −∂p

′

∂x′
+
∂2u′

∂y′2
(A.18)

0 =
∂p′

∂y′
(A.19)

A.2 Von Kàrmàn Integral Momentum Equation

For the derivation of the Von Kàrmàn integral momentum equation, Equation (2.27) is considered. This
equation can be �rst modi�ed, according to [14], as shown in Equation (A.20):

u
∂u

∂x
+ v

∂u

∂y
=

1

ρ

∂τ

∂y
+ U∞

∂U∞
∂x

, ⇒ ρu
∂u

∂x
+ ρv

∂u

∂y
=
∂τ

∂y
+ ρU∞

∂U∞
∂x

(A.20)

It is then possible to add and subtract to the LHS of Equation (A.20) the following quantity ρu∂U∞∂x , obtaining
Equation (A.21), that can be further simpli�ed as in Equation (A.22):

ρu
∂u

∂x
+ ρv

∂u

∂y
+ ρu

∂U∞
∂x
− ρu∂U∞

∂x
=
∂τ

∂y
+ ρU∞

∂U∞
∂x

, ⇒

ρu
∂U∞
∂x
− ρu∂u

∂x
− ρv ∂u

∂y
− ρu∂U∞

∂x
+ ρU∞

∂U∞
∂x

= −∂τ
∂y

(A.21)

ρu
∂

∂x
(U∞ − u)− ρv ∂u

∂y
+ ρ(U∞ − u)

∂U∞
∂x

= −∂τ
∂y

(A.22)

The term −ρv ∂u∂y can be further rewritten as in Equation (A.23):

−ρv ∂u
∂y

= −ρv ∂[U∞ − (U∞ − u)]

∂y
= −ρv ∂(U∞)

∂y
+ ρv

∂(U∞ − u)

∂y
= ρv

∂(U∞ − u)

∂y
(A.23)

considering that ∂(U∞)
∂y → 0 inside the boundary layer.

Equation (A.22) therefore results in Equation (A.24):

ρu
∂

∂x
(U∞ − u) + ρv

∂(U∞ − u)

∂y
+ ρ(U∞ − u)

∂U∞
∂x

= −∂τ
∂y

(A.24)

Integrating Equation (A.22) term by term, from y = 0 (y coordinate corresponding to the airfoil surface) to
y = δ (y coordinate corresponding to the edge of the boundary layer), yields for each term Equation (A.25),
Equation (A.26) and Equation (A.27):∫ δ

0

ρ(U∞ − u)
∂U∞
∂x

dy = ρU∞
∂U∞
∂x

∫ δ

0

(1− u

U∞
)dy = ρU∞

∂U∞
∂x

δ∗ (A.25)
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∫ δ

0

ρv
∂(U∞ − u)

∂y
dy = ρv(U∞ − u) |δ0 −ρ

∫ δ

0

(U∞ − u)
∂v

∂y
dy = 0 + ρ

∫ δ

0

(U∞ − u)
∂u

∂x
dy (A.26)

∫ δ

0

−∂τ
∂y
dy = −τ |δ0= τw (A.27)

Substituting Equation (A.25), Equation (A.26) and Equation (A.27) in Equation (A.24), an intermediate
integral equation is obtained in Equation (A.28):∫ δ

0

ρu
∂

∂x
(U∞ − u)dy + ρ

∫ δ

0

(U∞ − u)
∂u

∂x
dy + ρU∞

∂U∞
∂x

δ∗ = τw, ⇒∫ δ

0

[ρu
∂

∂x
(U∞ − u) + ρ(U∞ − u)

∂u

∂x
]dy + ρU∞

∂U∞
∂x

δ∗ = τw (A.28)

As a last step, the remaining integral in Equation (A.28) can be rewritten as shown in Equation (A.29):∫ δ

0

[ρu
∂

∂x
(U∞ − u) + ρ(U∞ − u)

∂u

∂x
]dy =

∫ δ

0

[ρ
∂

∂x
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∂

∂x

∫ δ

0

ρ[u(U∞ − u)]dy =

∂

∂x

∫ δ

0

ρ[uU∞(1− u
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∂

∂x
ρU2
∞

∫ δ

0

[
u

U∞
(1− u

U∞
)]dy =

∂

∂x
(ρU2
∞θ) (A.29)

Substituting Equation (A.29) in Equation (A.28), the Von Kàrmàn integral momentum equation in dimen-
sional form results in Equation (A.30):

∂

∂x
(ρU2
∞θ) = τw − ρU∞

∂U∞
∂x

δ∗ (A.30)

A.3 Integral Kinetic Energy Equation

For the derivation of the integral kinetic energy equation, both Equation (2.26) and Equation (2.27) will
be considered. These equations are modi�ed following the approach in [67], that initially considers Equa-
tion (A.31) and Equation (A.32):

∂u

∂x
+
∂v

∂y
= 0, ⇒ 0 = ρ(U2

∞ − u2)[
∂u

∂x
+
∂v

∂y
] (A.31)

u
∂u

∂x
+ v

∂u

∂y
=

1

ρ

∂τ

∂y
+ U∞

∂U∞
∂x

, ⇒ −2u
∂τ

∂y
= 2uρU∞

∂U∞
∂x
− 2uρu

∂u

∂x
− 2uρv

∂u

∂y
(A.32)

Equation (A.31) and Equation (A.32) are summed together, yielding Equation (A.33):

−2u
∂τ

∂y
= 2uρU∞

∂U∞
∂x
− 2uρu

∂u

∂x
− 2uρv

∂u

∂y
+ ρU2

∞
∂u

∂x
− ρu2 ∂u

∂x
+ ρU2

∞
∂v

∂y
− ρu2 ∂v

∂y
(A.33)

From Equation (A.33) the shear stress term, the derivatives in the x and the y direction are considered
separately, as in Equation (A.34), Equation (A.35) and Equation (A.36) respectively:

−2u
∂τ

∂y
= −2[

∂(τu)

∂y
− τ ∂u

∂y
] = −2

∂(τu)

∂y
+ 2τ

∂u

∂y
(A.34)
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2uρU∞
∂U∞
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∂u
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∂u

∂x
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(A.35)

−2uρv
∂u

∂y
+ ρU2

∞
∂v

∂y
− ρu2 ∂v

∂y
= ρ[−v ∂u

2

∂y
+ U2
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− u2 ∂v
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]

= ρ[−∂(vu2)

∂y
+
∂(U2

∞v)

∂y
] = ρ

∂(U2
∞v − vu2)

∂y
(A.36)

After the rearranging, the di�erential equation results in Equation (A.37):

−2
∂(τu)

∂y
+ 2τ

∂u

∂y
= ρ

∂(U2
∞u− u3)

∂x
+ ρ

∂(U2
∞v − vu2)

∂y
(A.37)

Equation (A.37) can be integrated term by term, from y = 0 (y coordinate corresponding to the airfoil
surface) to y = δ (y coordinate corresponding to the edge of the boundary layer), yielding Equation (A.38),
Equation (A.39) and Equation (A.40):∫ δ

0

[−2
∂(τu)

∂y
+ 2τ

∂u

∂y
]dy =

∫ δ

0

−2
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∫ δ

0
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∫ δ
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The integral kinetic energy equation in its dimensional form follows in Equation (A.41):
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∂(ρU3

∞θ
∗)

∂x
(A.41)
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Appendix B

Mesh Description 2D

1. Import the 2D CAD Model, as follows:

1.1 Go to File -> Properties, and in the Tolerances Frame set Model Size = 10 (following Pointwise
Guidelines, this value has to be 1 Order of Magnitude greater than the largest dimension of the
CAD Model (in this case airfoil chord=1), to allow the software to detect the edges of the 2D CAD
Model correctly. A value too large may cause wrong edges creation from the Database entities
imported)

1.2 Go to File -> Import -> Database, and from the Browser Window that appears select the CAD
�le containing the 2D Model

1.3 In the Import Database Panel that appears, choose Metric in the Units Frame, and Use Format
Speci�c Conversion Settings in the File Conversion Frame, and click OK

Figure B.1: CAD Model imported

2. Create Connectors from the 2D Model imported as follows

2.1 Select all Database Entities and create Connectors on Database Entities
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Figure B.2: Create connectors on database entities

3. Assign number of nodes on connectors

3.1 Assign 250 nodes to connectors along airfoil surface (Suction and Pressure Side)

Figure B.3: Connectors along airfoil surface

3.2 Assign 4 nodes to connectors along blunt Trailing Edge

Figure B.4: Connectors along blunt Trailing Edge
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4. Create Normal Extrusion Domain as follows:

4.1 Select Connectors to extrude from

Figure B.5: Connectors to extrude from

4.2 Go to Create -> Extrude -> Normal

4.3 In the Assemble frame accept the proposed assembling choice and click Done

4.4 Set the parameters of the Normal Extrusion in the Attributes tab

4.4.1 In the Step Size frame set:
- Initial∆s = 4.56e− 6
- GrowthRate = 1.088

4.4.2 In the Orientation frame click on Flip, if the normals are not pointing out

Figure B.6: Normals pointing out

4.4.3 In the Stop Conditions frame set Total Height = 500 (it de�nes the maximum limit of the
extrusion distance from the connectors, to extrude from)

4.6 In the Run tab, in the Extrude frame, set the number of extrusion steps to a large arbitrary
number (e.g Steps=500), and click Run. The Stop Condition Total Height will stop the extrusion
when the desired distance from the surface has reached the value 500.
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4.7 Click OK to accept the resulting extrusion

Figure B.7: Total Normal Extrusion

5. De�ne Boundary Conditions and Output format of the Mesh created

5.1 Go to CAE -> Select Solver -> Stanford ADL/SU2 and click OK

5.2 Go to CAE -> Set Dimension -> 2D

5.3 Go to CAE -> Set Boundary Conditions, and de�ne the boundary conditions as follows:

5.3.1 Create with the New Button 2 Boundary Conditions, named �airfoil�,�far�eld�

5.3.2 Select Domains for the �airfoil� Boundary Condition

Figure B.8: Airfoil Boundary Condition

5.3.3 Click on the tick box near the �airfoil� Boundary Condition name, to assign the connectors
selected to the corresponding Boundary Condition
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5.3.4 Select Domains for the �far�eld� Boundary Condition

Figure B.9: Far�eld Boundary Condition

5.3.5 Click on the tick box near the �far�eld� Boundary Condition name, to assign the connectors
selected to the corresponding Boundary Condition

6. Export the 2D Mesh created in the SU2 format

6.1 Select all the domains created

6.2 Go to File -> Export -> CAE

6.3 Specify name of the *.su2 �le to be created

6.4 In the frame Data Precision specify Double for Double Precision

6.5 Click OK to generate the Mesh
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Appendix C

Mesh Description 3D Smooth

1. Import the 3D CAD Model, as follows:

1.1 Go to File -> Properties, and in the Tolerances Frame set Model Size = 10 (following Pointwise
Guidelines, this value has to be 1 Order of Magnitude greater than the largest dimension of the
CAD Model (in this case airfoil chord=1), to allow the software to detect the edges of the 3D CAD
Model correctly. A value too large may cause wrong edges creation from the Database entities
imported)

1.2 Go to File -> Import -> Database, and from the Browser Window that appears select the CAD
�le containing the 3D Model

1.3 In the Import Database Panel that appears, choose Metric in the Units Frame, and Use Format
Speci�c Conversion Settings in the File Conversion Frame, and click OK

Figure C.1: CAD Model imported
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2. Create Connectors from the 3D Model imported as follows:

2.1 Delete the 2 redundant lateral surfaces created after the import, to avoid wrong connector creation

Figure C.2: Lateral surfaces to delete

2.2 Select all Database Entities and create Connectors on Database Entities

Figure C.3: Create connectors on database entities

3. Assign number of nodes on connectors

3.1 Assign 250 nodes to connectors along airfoil surface (Suction and Pressure Side)

Figure C.4: Connectors along airfoil surface
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3.2 Assign 15 nodes along third direction

Figure C.5: Connectors along third direction

3.3 Assign 4 nodes to connectors along blunt Trailing Edge

Figure C.6: Connectors along blunt Trailing Edge

4. Assemble Domains from connectors created and de�ned. All domains will have quadrilateral cells
(�structured� according to Pointwise de�nition). In order to do so, for every domain to be created,
select a closed loop of connectors (ensuring that opposite sides have the same number of nodes) and go
to Create -> Assemble Special -> Domain

Figure C.7: Assembled domains
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5. Create Normal Extrusion Block as follows:

5.1 Select Domains to extrude from

Figure C.8: Domains to extrude from

5.2 Go to Create -> Extrude -> Normal

5.3 In the Assemble frame accept the proposed assembling choice and click Done

5.4 Set the parameters of the Normal Extrusion in the Attributes tab

5.4.1 In the Step Size frame set:
- Initial∆s = 4.56e− 6
- GrowthRate = 1.088

5.4.2 In the Orientation frame click on Flip, if the normals are not pointing out

Figure C.9: Normals pointing out

5.4.3 In the Stop Conditions frame set Total Height = 500 (it de�nes the maximum limit of the
extrusion distance, from the surface to extrude from)
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5.5 In the Boundary Condition tab de�ne the boundary conditions of the Normal Extrusion:

5.5.1 All the connectors will be set to the Boundary Condition Type=Symmetry Y

Figure C.10: Symmetry Y Boundary Condition for the Last Normal Extrusion

5.6 In the Run tab, in the Extrude frame, set the number of extrusion steps to a large arbitrary
number (e.g Steps=500), and click Run. The Stop Condition Total Height will stop the extrusion
when the desired distance from the surface has reached the value 500.

5.7 Click OK to accept the resulting extrusion

Figure C.11: Total Normal Extrusion
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6. De�ne Boundary Conditions and Output format of the Mesh created

6.1 Go to CAE -> Select Solver -> Stanford ADL/SU2 and click OK

6.2 Go to CAE -> Set Dimension -> 3D

6.3 Go to CAE -> Set Boundary Conditions, and de�ne the boundary conditions as follows:

6.3.1 Create with the New Button 3 Boundary Conditions, named �airfoil�,�symmetry�,�far�eld�

6.3.2 Select Domains for the �airfoil� Boundary Condition

Figure C.12: Airfoil Boundary Condition

6.3.3 Click on the tick box near the �airfoil� Boundary Condition name, to assign the Domains
selected to the corresponding Boundary Condition

6.3.4 Select Domains for the �far�eld� Boundary Condition

Figure C.13: Far�eld Boundary Condition

6.3.5 Click on the tick box near the �far�eld� Boundary Condition name, to assign the Domains
selected to the corresponding Boundary Condition
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6.3.6 Select Domains for the �symmetry� Boundary Condition (all the Domains with the normal to
the domain pointing in the y-direction)

Figure C.14: Symmetry Boundary Condition

6.3.7 Click on the tick box near the �symmetry� Boundary Condition name, to assign the Domains
selected to the corresponding Boundary Condition

7. Export the 3D Mesh created in the SU2 format

7.1 Select all the blocks created

7.2 Go to File -> Export -> CAE

7.3 Specify name of the *.su2 �le to be created

7.4 In the frame Data Precision specify Double for Double Precision

7.5 Click OK to generate the Mesh
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Appendix D

Mesh Description 3D VG

1. Import the 3D CAD Model, as follows:

1.1. Go to File -> Properties, and in the Tolerances Frame set Model Size = 10 (following Pointwise
Guidelines, this value has to be 1 Order of Magnitude greater than the largest dimension of the
CAD Model (in this case airfoil chord=1), to allow the software to detect the edges of the 3D CAD
Model correctly. A value too large may cause wrong edges creation from the Database entities
imported)

1.2. Go to File -> Import -> Database, and from the Browser Window that appears select the CAD
�le containing the 3D Model

1.3. In the Import Database Panel that appears, choose Metric in the Units Frame, and Use Format
Speci�c Conversion Settings in the File Conversion Frame, and click OK

Figure D.1: CAD Model imported
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2. Create Connectors from the 3D Model imported as follows:

2.1. Delete the 2 redundant lateral surfaces created after the import, to avoid wrong connector creation

Figure D.2: Lateral edges to delete

2.2. Select all Database Entities and create Connectors on Database Entities

Figure D.3: Create connectors on database entities
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3. Starting from the 3D CAD model, the VG blocking already created in it is now mirrored as follows:

3.1. Copy and Translate lateral edges of the VG Blocking

3.1.1. Select lateral Edge VG Blocking

Figure D.4: Lateral edge VG Blocking

3.1.2. Go to Edit -> Copy

3.1.3. Go to Edit -> Paste -> Translate

3.1.4. Click on Clear Translation Vector (only if previous translation vectors are already de�ned)

3.1.5. De�ne Points of the Translation Vector

Figure D.5: De�ne points of the translation vector
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3.1.6. Click OK to con�rm the procedure

Figure D.6: Translated edge

3.1.7. Repeat from 3.1.1 to 3.1.6 for the other lateral edge

Figure D.7: Other translated edge

3.2. Split airfoil connectors selecting end point of the connectors just translated

3.2.1. Select airfoil connector

3.2.2. Go to Edit -> Split

3.2.3. Select end point of the connector translated at point 3.1, and click OK

Figure D.8: Split airfoil connector
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3.2.4. Repeat from point 3.2.1 to 3.2.3 for the other connector on the opposite side

Figure D.9: Other Airfoil connector split

3.3. Delete connectors translated at point 3.1

Figure D.10: Delete previously translated connectors
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3.4. Copy and Translate connectors corresponding to VG base band thickness

3.4.1. Select connector

Figure D.11: Connector of the VG Base Band Thickness

3.4.2. Go to Edit -> Copy

3.4.3. Go to Edit -> Paste -> Translate

3.4.4. Click on Clear Translation Vector (only if previous translation vectors are already de�ned)

3.4.5. De�ne Points of the Translation Vector

Figure D.12: Translation vector of the connector corresponding to the VG
Base Band Thickness

3.4.6. Click OK to con�rm the procedure

Figure D.13: VG Base Band Thickness connector translated
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3.4.7. Repeat from 3.4.1 to 3.4.6 for the other connector

Figure D.14: Other VG Base Band thickness connector translated

3.5. Create connector on the airfoil surface connecting the 2 VG base band thickness connectors just
created

3.5.1. Go to Create -> Draw Curves -> Line on Database

3.5.2. In the On Database Options frame click Begin

3.5.3. Select Database corresponding to the airfoil surface

Figure D.15: Database to draw line on

3.5.4. Click End

3.5.5. Create connector selecting the 2 points on opposite sides

Figure D.16: Select connector start and end points
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3.5.6. Click Apply

Figure D.17: Line on database created

3.6. Copy and Translate VG Base Band Edge of the Blocking

3.6.1. Select VG Base Band Edge of the Blocking

Figure D.18: VG Base Band Edge of the Blocking

3.6.2. Go to Edit -> Copy

3.6.3. Go to Edit -> Paste -> Translate

3.6.4. Click on Clear Translation Vector (only if previous translation vectors are already de�ned)

3.6.5. De�ne Points of the Translation Vector

Figure D.19: Translation Base Band Edge connector
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3.6.6. Click OK to con�rm the procedure

Figure D.20: Base Band Edge Translated

3.7. Split connector created at point 3.5, selecting the end point of the VG Base Band Edge just created

3.7.1. Select connector created at point 3.5

Figure D.21: Select connector created at point 3.5

3.7.2. Go to Edit -> Split

3.7.3. Select end point of the VG Base Band Edge created at point 3.6, and click OK

Figure D.22: Split connector created at point 3.5
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3.8. Copy and Translate connector normal to VG Base Band Edge of the Blocking

3.8.1. Select connector from point 3.4

Figure D.23: Select connector to translate

3.8.2. Go to Edit -> Copy

3.8.3. Go to Edit -> Paste -> Translate

3.8.4. Click on Clear Translation Vector (only if previous translation vectors are already de�ned)

3.8.5. De�ne Points of the Translation Vector

Figure D.24: De�ne Translation Vector

3.8.6. Click OK to con�rm the procedure

3.9. Create remaining connectors to complete the VG Blocking Mirroring, with Create -> 2 Point
Curves and Create -> Line on Database
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4. Create additional edges on the airfoil surface, to avoid not regular mesh lines on the remaining part of
the surface

4.1. Copy and Translate lateral edges of the VG Blocking, to translate it before the VG

4.1.1. Select lateral Edge VG Blocking

Figure D.25: Additional edge on airfoil surface, before the VG

4.1.2. Go to Edit -> Copy

4.1.3. Go to Edit -> Paste -> Translate

4.1.4. Click on Clear Translation Vector (only if previous translation vectors are already de�ned)

4.1.5. De�ne Points of the Translation Vector

Figure D.26: De�ne Translation Vector
4.1.6. Click OK to con�rm the procedure

Figure D.27: Translated additional edge
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4.1.7. Repeat from 4.1.1 to 4.1.6 for the other additional edge

Figure D.28: Other additional edge before the VG

4.2. Copy and Translate lateral edges of the VG Blocking, to translate it after the VG

4.2.1. Select lateral Edge VG Blocking

Figure D.29: Additional edge on airfoil surface, after the VG

4.2.2. Go to Edit -> Copy

4.2.3. Go to Edit -> Paste -> Translate

4.2.4. Click on Clear Translation Vector (only if previous translation vectors are already de�ned)

4.2.5. De�ne Points of the Translation Vector

Figure D.30: De�ne Translation vector
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4.2.6. Click OK to con�rm the procedure

Figure D.31: Translated additional edge

4.2.7. Repeat from 4.2.1 to 4.2.6 for the other additional edge

Figure D.32: Other additional edge before the VG
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5. Split the airfoil surface connectors, following the procedure at point 3.2, considering the end point of
the connectors created at point 4. Create then the connectors on the airfoil surface as in point 3.5

Figure D.33: Additional connectors created

6. Assign number of nodes on connectors

6.1. Assign 34 nodes to connectors normal to airfoil surface (to resolve properly Boundary Layer in the
regions away from the VG)

Figure D.34: Connectors normal to airfoil surface
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6.2. Assign 10 nodes to connectors along airfoil surface (not too many nodes since it's not necessary
to resolve too �ne the region near the VG. It's important to resolve properly the region after the
VG)

Figure D.35: Connectors along airfoil surface

6.3. Assign 8 nodes to connectors along third dimension (extruding direction of the airfoil pro�le)

Figure D.36: Connectors along extruding direction of the airfoil pro�le
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6.4. Assign 10 nodes to additional edges along airfoil surface

Figure D.37: Additional connectors along airfoil surface

6.5. Assign 15 nodes along third direction

Figure D.38: Connectors along third direction
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6.6. Assign 90 nodes to connectors along airfoil surface, before the VG

Figure D.39: Connectors along airfoil surface, before the VG

6.7. Assign 393 nodes to connectors along airfoil surface, after the VG

Figure D.40: Connectors along airfoil surface, after the VG
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6.8. Assign 520 nodes to connectors along airfoil surface, on the pressure side

Figure D.41: Connectors along airfoil surface, on the pressure side

6.9. Assign 4 nodes to connectors along blunt Trailing Edge

Figure D.42: Connectors along blunt Trailing Edge
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7. De�ne end spacing of connectors normal to the airfoil surface, setting it to the value 4.56e-6 (half of
the spacing necessary to obtain a y+ = 1, to ensure a good y+ value at the end of the simulation)

Figure D.43: End Spacing of connectors normal to the airfoil surface

8. Assemble Domains from connectors created and de�ned. All domains will have quadrilateral cells
(�structured� according to Pointwise de�nition). In order to do so, for every domain to be created,
select a closed loop of connectors (ensuring that opposite sides have the same number of nodes) and go
to Create -> Assemble Special -> Domain

Figure D.44: Assembled domains
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9. Create Blocks out of the domains created for the VG Blocking. In order to do so, to construct a
�structured block� according to Pointwise de�nition, select for each block 6 domains and go to Create
-> Assemble Special -> Block.

Figure D.45: VG Blocking

10. Create First Extrusion Block, relative to the Boundary Layer, as follows:

10.1. Select Domains to extrude from

Figure D.46: Domains to extrude from

10.2. Go to Create -> Extrude -> Normal

10.3. In the Assemble frame accept the proposed assembling choice and click Done

10.4. Set the parameters of the Normal Extrusion in the Attributes tab

10.4.1. In the Step Size frame set:
- Initial∆s = 4.56e− 6
- GrowthRate = 1.088
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10.4.2. In the Orientation frame click on Flip, if the normals are not pointing out

Figure D.47: Normals pointing out

10.4.3. In the Stop Conditions frame set Total Height = 500 (it de�ne the maximum limit of the
extrusion distance, from the surface to extrude from)

10.5. In the Boundary Condition tab de�ne the boundary conditions of the Normal Extrusion:

10.5.1. In the Boundary Conditions frame select Type=Adjacent Grid

10.5.2. Select the connector adjacent to the Domain representing the VG Band Thickness

Figure D.48: Connector adjacent to VG Band Thickness

10.5.3. In the Adjacent Grid Selection frame click Begin
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10.5.4. Select the Adjacent Grid that will provide the spacing that the Normal Extrusion algorithm
will follow

Figure D.49: Select Adjacent Grid

10.5.5. In the Adjacent Grid Selection frame click End

10.5.6. In the Boundary Conditions frame click Set Boundary Condition

172



Appendix D: Mesh Description 3D VG

10.5.7. Repeat points 10.5.1 to 10.5.6 for the other connectors adjacent to the Domains representing
the VG Band Thickness

Figure D.50: Other connectors adjacent to the Domains representing the
VG Band Thickness
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10.5.8. All the other connectors will be set to the Boundary Condition Type=Symmetry Y

Figure D.51: Symmetry Y Boundary Condition for the Normal Extrusion of the region
in the Boundary Layer

10.6. In the Run tab, in the Extrude frame, set the number of extrusion steps Steps=33, and click Run

10.7. Click OK to accept the resulting extrusion

Figure D.52: Boundary Layer Normal Extrusion
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11. Create Last Extrusion Block as follows:

11.1. Select Domains to extrude from

Figure D.53: Domains to extrude from

11.2. Go to Create -> Extrude -> Normal

11.3. In the Assemble frame accept the proposed assembling choice and click Done

11.4. Set the parameters of the Normal Extrusion in the Attributes tab

11.4.1. In the Step Size frame set:
- Initial∆s = 1/10 ∗ MinimumSurfaceSpacing (MinimumSurfaceSpacing is speci�ed by
Pointwise right above the box Initial∆s. This ensures a good growth of the cells during the
extrusion)
- GrowthRate = 1.088

11.4.2. In the Orientation frame click on Flip, if the normals are not pointing out

Figure D.54: Normals pointing out

11.4.3. In the Stop Conditions frame set Total Height = 500 (it de�nes the maximum limit of the
extrusion distance, from the surface to extrude from)
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11.5. In the Boundary Condition tab de�ne the boundary conditions of the Normal Extrusion:

11.5.1. All the connectors will be set to the Boundary Condition Type=Symmetry Y

Figure D.55: Symmetry Y Boundary Condition for the Last Normal Extrusion

11.6. In the Run tab, in the Extrude frame, set the number of extrusion steps to a large arbitrary
number (e.g Steps=500), and click Run. The Stop Condition Total Height will stop the extrusion
when the desired distance from the surface has reached the value 500.

11.7. Click OK to accept the resulting extrusion

Figure D.56: Total Normal Extrusion
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12. De�ne Boundary Conditions and Output format of the Mesh created

12.1. Go to CAE -> Select Solver -> Stanford ADL/SU2 and click OK

12.2. Go to CAE -> Set Dimension -> 3D

12.3. Go to CAE -> Set Boundary Conditions, and de�ne the boundary conditions as follows:

12.3.1. Create with the New Button 4 Boundary Conditions, named �airfoil�,�symmetry�,�far�eld�,�vg�

12.3.2. Select Domains for the �airfoil� Boundary Condition

Figure D.57: Airfoil Boundary Condition

12.3.3. Click on the tick box near the �airfoil� Boundary Condition name, to assign the Domains
selected to the corresponding Boundary Condition
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12.3.4. Select Domains for the �far�eld� Boundary Condition

Figure D.58: Far�eld Boundary Condition

12.3.5. Click on the tick box near the �far�eld� Boundary Condition name, to assign the Domains
selected to the corresponding Boundary Condition

12.3.6. Select Domains for the �symmetry� Boundary Condition (all the Domains with the normal to
the domain pointing in the y-direction)

Figure D.59: Symmetry Boundary Condition

12.3.7. Click on the tick box near the �far�eld� Boundary Condition name, to assign the Domains
selected to the corresponding Boundary Condition
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12.3.8. Select Domains for the �vg� Boundary Condition, selecting �rst the box Select Connections,
and then the 2 domains pointing in opposite directions relatively to the VG surface

Figure D.60: VG Boundary Condition

12.3.9. Click on the tick box near the �vg� Boundary Condition name, to assign the Domains selected
to the corresponding Boundary Condition

13. Export the 3D Mesh created in the SU2 format

13.1. Select all the blocks created

13.2. Go to File -> Export -> CAE

13.3. Specify name of the *.su2 �le to be created

13.4. In the frame Data Precision specify Double for Double Precision

13.5. Click OK to generate the Mesh
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Appendix E

Airfoil Data Extraction Script

In this Appendix, an example of a Python script to extract data from a 3D airfoil solution is reported.

# −*− coding : u t f−8 −*−
"""
Created on Mon May 07 13 :22 :56 2018

@author : Andrea
"""

from os import getcwd , path , mkdir
import errno
from h5py import F i l e
import numpy
import pandas
from paraview . s imple import (LegacyVTKReader ,

servermanager , S l i c e )
from vtk . u t i l . numpy_support import vtk_to_numpy
from math import fmod

def merge_reshape_coordinates (MeshGrid ) :
"""
Merges the 3 coord ina te arrays in t o one 3D L i s t o f Tuples
o f the form (x , y , z ) , each one r ep r e s en t i n g a po in t in the 3D space .

The i n i t i a l index ing o f the imported coord ina t e s from the CGNS Struc tured
mesh i s rearranged , to keep the correspondence wi th the Pointwise mesh ,
c rea t ed accord ing to the norm used in SU2 of having ' x ' as 1 s t dimension ,
' z ' as 2nd dimension , ' y ' as 3 rd dimension ) .

For 3D Grid :
−−−−−−−−−−−−−−−
I n i t i a l l y the 3 indexes o f the MeshGrid array r e f e r r e d to :

− 1 s t MeshGrid array index K −> z d i r e c t i o n
− 2nd MeshGrid array index J −> y d i r e c t i o n
− 3rd MeshGrid array index I −> x d i r e c t i o n
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The rearrangement l e ad s to :
− K index was the f i r s t dimension in the o r i g i n a l MeshGrid array

−> I index now i s f o r f i r s t dimension ( x ) o f Coordinates Array
− J index was the second dimension in the o r i g i n a l MeshGrid array

−> K index now i s f o r second dimension ( z ) o f Coordinates
Array

− I index was the t h i r d dimension in the o r i g i n a l MeshGrid array
−> J index now i s f o r t h i r d dimension ( y ) o f Coordinates Array

For 2D Grid ( approx imate ly p a r a l l e l to x−z p lane ) :
−−−−−−−−−−−−−−−
I n i t i a l l y the 2 indexes o f the MeshGrid array r e f e r r e d to :

− 1 s t MeshGrid array index K −> z d i r e c t i o n
− 2nd MeshGrid array index I −> x d i r e c t i o n

The rearrangement l e ad s to :
− K index was the f i r s t dimension in the o r i g i n a l MeshGrid array

−> I index now i s f o r f i r s t dimension ( x ) o f Coordinates Array
− I index was the second dimension in the o r i g i n a l MeshGrid array

−> J index now i s f o r second dimension ( z ) o f Coordinates
Array

N.B Doesn ' t work so f a r f o r o ther 2D Grids on d i f f e r e n t p lanes (K, I w i l l
r e f e r to d i f f e r e n t d i r e c t i o n s in o ther cases )

Input
−−−−−−−−−−
MeshGrid :

Or i g ina l S t ruc tured CGNS Imported Mesh .

Function Var iab l e s
−−−−−−−−−−
x_coordinates_dataset : 3D Numpy array o f f l o a t s

x coord ina t e s o f the po in t s in the 3D space
y_coordinates_dataset : 3D Numpy array o f f l o a t s

y coord ina t e s o f the po in t s in the 3D space
z_coordinates_datase t : 3D Numpy array o f f l o a t s

z coord ina t e s o f the po in t s in the 3D space
Is2D : boo lean

Flag f o r 2D Input Mesh
Is3D : boo lean

Flag f o r 3D Input Mesh
I_dim : f l o a t

Length o f matrix dimension corresponding to I index
J_dim : f l o a t

Length o f matrix dimension corresponding to J index
K_dim: f l o a t

Length o f matrix dimension corresponding to K index
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Output
−−−−−−−
Points_Coordinates : 3D L i s t o f Tuples

Coordinates o f po in t s in the 3D space .

"""

# Obtain x , y , z Mesh coord ina t e s
x_coordinates_dataset = (MeshGrid [ ' Base ' ] [ 'VG' ] [ ' GridCoordinates ' ]

[ ' CoordinateX ' ] [ '  data ' ] . va lue )
y_coordinates_dataset = (MeshGrid [ ' Base ' ] [ 'VG' ] [ ' GridCoordinates ' ]

[ ' CoordinateY ' ] [ '  data ' ] . va lue )
z_coordinates_dataset = (MeshGrid [ ' Base ' ] [ 'VG' ] [ ' GridCoordinates ' ]

[ ' CoordinateZ ' ] [ '  data ' ] . va lue )

Is3D = False
Is2D = False

i f x_coordinates_dataset . ndim == 3 :

Is3D = True

e l i f x_coordinates_dataset . ndim == 2 :

Is2D = True

else :

print "1D Grid Provided"
raise SystemExit

i f Is3D :

# Obtain arrays dimensions l e n g t h
K_dim = numpy . s i z e ( x_coordinates_dataset , 0 ) # K index −> z coord ina t e s
J_dim = numpy . s i z e ( x_coordinates_dataset , 1 ) # J index −> y coord ina t e s
I_dim = numpy . s i z e ( x_coordinates_dataset , 2 ) # I index −> x coord ina t e s

# I n i t i a l i z e 3D L i s t ' Points_Coordinates ' , wi th L i s t Comprehension
syntax

Points_Coordinates = [ [ [ ( ) for index_J in range (0 , J_dim) ]
for index_K in range (0 ,K_dim) ]

for index_I in range (0 , I_dim) ]

# Populate Points_Cooordinates
for J in range (0 , J_dim) :

for K in range (0 ,K_dim) :
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for I in range (0 , I_dim) :
Points_Coordinates [ I ] [K ] [ J ] = ( x_coordinates_dataset [K ] [ J

] [ I ] ,
y_coordinates_dataset [K ] [ J ] [

I ] ,
z_coordinates_dataset [K ] [ J ] [

I ] )

e l i f Is2D :

# Obtain arrays dimensions l e n g t h
K_dim = numpy . s i z e ( x_coordinates_dataset , 0 ) # K index −> z coord ina t e s
I_dim = numpy . s i z e ( x_coordinates_dataset , 1 ) # I index −> x coord ina t e s

# I n i t i a l i z e 2D L i s t ' Points_Coordinates ' , wi th L i s t Comprehension
syntax

Points_Coordinates = [ [ ( ) for index_K in range (0 ,K_dim) ]
for index_I in range (0 , I_dim) ]

# Populate Points_Cooordinates
for K in range (0 ,K_dim) :

for I in range (0 , I_dim) :
Points_Coordinates [ I ] [K] = ( x_coordinates_dataset [K ] [ I ] ,

y_coordinates_dataset [K ] [ I ] ,
z_coordinates_dataset [K ] [ I ] )

return Points_Coordinates

def ExtractSurfaceData ( Surface_reader , Quantity_to_extract ,
X_Slice_Position , Y_Slice_Posit ion ) :

"""
Extrac t user s p e c i f i e d su r f a c e data at user s p e c i f i e d l o c a t i o n s on the

a i r f o i l s u r f a c e .
I t does t ha t as f o l l o w s :

1) S l i c e s the su r f a c e s o l u t i o n wi th a p lane perpend i cu l a r to the x−ax i s
2) S l i c e s the r e s u l t from 1) wi th a p lane perpend i cu l a r to the y−ax i s
3) From 2) s e l e c t po in t s on suc t i on and pres sure s i d e
4) Extrac t quan t i t y o f i n t e r e s t from 3)

Input
−−−−−−−−−−
Surface_reader : v t k Object wi th a t t r i b u t e SMProxy

Object con ta in ing a i r f o i l s u r f a ce s o l u t i o n

OutputVar iab les : L i s t o f s t r i n g s
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Var iab l e s to e x t r a c t from a i r f o i l s u r f a c e

Quanti ty_to_extract : s t r i n g
Var iab l e to e x t r a c t from the a i r f o i l s u r f a c e s o l u t i o n

X_Slice_Position : f l o a t
X po s i t i o n f o r s l i c i n g a i r f o i l s u r f a ce

Y_Slice_Position : f l o a t
Y po s i t i o n f o r s l i c i n g a i r f o i l s u r f a ce

Function Var iab l e s
−−−−−−−−−−
Slice_X_Proxy : v t k S l i c e Object

S l i c e at s p e c i f i e d x p o s i t i o n

Slice_Y_Proxy : v t k S l i c e Object
S l i c e at s p e c i f i e d y po s i t i o n

Slice_Y : v t k servermanager Object
So lu t i on Data from Slice_Y_Proxy Object

S l i ced_Points : numpy array o f f l o a t s
Points Coordinates r e s u l t i n g from the 2nd s l i c i n g opera t ion

Row_Index_Suction_Point : numpy array o f f l o a t
Point index o f the po in t on the suc t i on s i d e o f the a i r f o i l

Row_Index_Pressure_Point : numpy array o f f l o a t
Point index o f the po in t on the pre s sure s i d e o f the a i r f o i l

Point_On_Suction_Surface_Coordinates : numpy array o f f l o a t s
Coordinates o f the po in t on the suc t i on sur f a ce

Point_On_Pressure_Surface_Coordinates : numpy array o f f l o a t s
Coordinates o f the po in t on the pre s sure su r f a ce

Point_ID_Suction_Surface : numpy array o f f l o a t
PointID from Slice_Y of the Point_On_Suction_Surface_Coordinates

Point_ID_Pressure_Surface : numpy array o f f l o a t
PointID from Slice_Y of the Point_On_Pressure_Surface_Coordinates

Quant i ty_extracted : s t r i n g
Var iab l e o f i n t e r e s t to e x t r a c t from the s o l u t i o n

Output
−−−−−−−
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Quantity_Suction_Surface : numpy array o f f l o a t s
Extrac ted quan t i t y corresponding to Point_ID_Suction_Surface

Quantity_Pressure_Surface : numpy array o f f l o a t s
Extrac ted quan t i t y corresponding to Point_ID_Pressure_Surface

"""
################# 1) Extrac t S l i c e at X po s i t i o n

##########################

Slice_X_Proxy = S l i c e ( Input=Surface_reader )

Slice_X_Proxy . S l iceType = ' Plane '
Slice_X_Proxy . S l i c eO f f s e tVa l u e s = [ 0 . 0 ]
Slice_X_Proxy . S l iceType . Or ig in = [ X_Slice_Position , 0 . 0 , 0 . 0 ]
Slice_X_Proxy . S l iceType . Normal = [ 1 . 0 , 0 . 0 , 0 . 0 ]
Slice_X_Proxy . UpdatePipe l ine ( )

############# 2) Extrac t S l i c e at Y pos i t i on , o b t a in ing 2 Values
##########

Slice_Y_Proxy = S l i c e ( Input=Slice_X_Proxy )

Slice_Y_Proxy . S l iceType = ' Plane '
Slice_Y_Proxy . S l i c eO f f s e tVa l u e s = [ 0 . 0 ]
Slice_Y_Proxy . S l iceType . Or ig in = [ 0 . 0 , Y_Slice_Position , 0 . 0 ]
Slice_Y_Proxy . S l iceType . Normal = [ 0 . 0 , 1 . 0 , 0 . 0 ]
Slice_Y_Proxy . UpdatePipe l ine ( )
Slice_Y = servermanager . Fetch ( Slice_Y_Proxy )

###### 3) Obtain Points on the upper and lower sur f a c e o f the a i r f o i l
#########

Sl i ced_Points = vtk_to_numpy( Slice_Y . GetPoints ( ) . GetData ( ) )
Row_Index_Suction_Point = numpy . argmax ( S l i ced_Points [ : , 2 ] )
Row_Index_Pressure_Point = numpy . argmin ( S l i ced_Points [ : , 2 ] )

########### 4) Obtain Sur face Quanti ty va l u e s ######

Point_On_Suction_Surface_Coordinates = Sl iced_Points [
Row_Index_Suction_Point ]

Point_On_Pressure_Surface_Coordinates = Sl iced_Points [
Row_Index_Pressure_Point ]

Point_ID_Suction_Surface = Slice_Y . FindPoint (
Point_On_Suction_Surface_Coordinates )

Point_ID_Pressure_Surface = Slice_Y . FindPoint (
Point_On_Pressure_Surface_Coordinates )
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Quantity_Suction_Surface = vtk_to_numpy( Slice_Y . GetPointData ( ) .
GetArray ( Quantity_to_extract ) ) [

Point_ID_Suction_Surface ]
Quantity_Pressure_Surface = vtk_to_numpy( Slice_Y . GetPointData ( ) .

GetArray ( Quantity_to_extract ) ) [
Point_ID_Pressure_Surface ]

return [ Quantity_Suction_Surface , Quantity_Pressure_Surface ]

####################### MAIN PROGRAM START
####################################

############################ Fi l e Paths
#######################################

# Get Current Working Direc tory
cwd = getcwd ( )

# Appends t r a i l i n g s l a s h p la t form ind ipendent
path_vtk_solution = path . j o i n (cwd , ' ' )

# Get Input from user i f cons ider a VG s imu la t i on
IsVGSimulation = raw_input( ' I s  t h i s  a 3D VG s imu la t i on ? ( yes /no ) :  ' )

VG = False
i f IsVGSimulation == "yes " :

path_VG_CGNS = path . j o i n (cwd , "VG_GridPoints . cgns " )

# Imports VG CGNS Mesh
MeshGrid = F i l e (path_VG_CGNS, ' r ' )

# Merges and Reshapes MeshGrid
Points_Coordinates = merge_reshape_coordinates (MeshGrid )

VG = True

# Create Path where to save * . csv f i l e s e x t r a c t e d from the s o l u t i o n
ExtractedNormalLinesSolut ionPath = path . j o i n (cwd , ' DataExtracted ' )

# Creates d i r e c t o r y and hand les e r ro r s
try :

mkdir ( ExtractedNormalLinesSolut ionPath )
except OSError as e :

i f e . e r rno != errno .EEXIST :
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raise

# Appends t r a i l i n g s l a s h p la t form ind ipendent
ExtractedNormalLinesSolut ionPath = path . j o i n ( ExtractedNormalLinesSolutionPath ,

'  ' )

###################### Setup the vtkUnstructuredGridReader
####################

SU2_Surface_reader = LegacyVTKReader ( FileNames=[path_vtk_solution+
" sur face_f low . vtk" ] )

################### Obtain v a r i a b l e s names
###################################

Variables_Names = SU2_Surface_reader . PointData . keys ( )

# Print Var iab l e s to screen , to l e t the user choose
print ( ' L i s t  o f  Var iab l e s  a v a i l a b l e  (NumberID :  Var iab le ) ' )
for counter , name in enumerate( Variables_Names ) :

i f fmod ( counter , 3 ) == 0 :
print ( ' \n ' )

print ( "{ counter : 02 d } :  {name :30 s }\ t " . format ( counter=counter , name=name) ) ,
print ( ' \n ' )

OutputVariables = Variables_Names

######################### Compute Sur face Normals
#############################

Surface_reader_servermanager = servermanager . Fetch ( SU2_Surface_reader )

x_start , x_end=Surface_reader_servermanager . GetPoints ( ) . GetData ( ) . GetRange (0 )
y_start , y_end=Surface_reader_servermanager . GetPoints ( ) . GetData ( ) . GetRange (1 )

x_start = x_start + 0.0001
x_end = x_end − 0 .0001

y_start = y_start + 0.0001
y_end = y_end − 0 .0001

##################### Get x , y p o s i t i o n f o r s l i c i n g
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############################
############################### from user

#####################################

# Variab l e to e x t r a c t from A i r f o i l Sur face
Var iab leToExtractFromAir fo i lSur face = raw_input( ' Enter  va r i a b l e  to  ex t r a c t '

'
from
 
A i r f o i l
 
Sur face
:
 
'
)

Var iab leToExtractFromAir fo i lSur face = Var iab leToExtractFromAir fo i lSur face .
s p l i t ( ' " ' )

Var iab leToExtractFromAir fo i lSur face = Var iab leToExtractFromAir fo i lSur face [ 1 ]

# Consider l i n e a r l y spaced points , or s p e c i f i c l o c a t i o n s ?
LinearlySpaced_Or_UserDefined = raw_input( ' Consider  l i n e a r l y  spaced  po in t s  '

' ( a long  x and y d i r e c t i o n ) ,  '
' or  user  de f ined  s p e c i f i c  l o c a t i o n s ?

'
' ( l i n : l i n e a r l y  spaced  points , '
' spec : s p e c i f i c  l o c a t i o n s ) :  ' )

LinearlySpaced_Or_UserDefined = LinearlySpaced_Or_UserDefined . s p l i t ( ' " ' ) [ 1 ]

L inear lySpaced = False
UserDef ined = False
i f LinearlySpaced_Or_UserDefined == " l i n " :

Linear lySpaced = True
e l i f LinearlySpaced_Or_UserDefined == ' spec ' :

UserDef ined = True

i f Linear lySpaced :

# Number o f X po s i t i o n s to cons ider
Number_Of_X_positions = raw_input( ' Enter  Number o f  X l o c a t i o n s  to  con s id e r

 '
' ( l i n e a r l y  spaced l o c a t i o n s  on the  

su r f a c e  '
' o f  the  blade  s e c t i o n  w i l l  be cons idered

,  '
' from Leading Edge to  Tra i l i n g  Edge ) :  ' )
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Number_Of_X_positions = int (Number_Of_X_positions )

X_Sl ices_Posit ions = numpy . l i n s p a c e ( s t a r t=x_start , stop=x_end ,
num=Number_Of_X_positions ) . t o l i s t ( )

# Number o f Y po s i t i o n s to cons ider
Number_Of_Y_positions_raw_input = ( ' Enter  Number o f  Y l o c a t i o n s  to  

con s id e r  '
' ( l i n e a r l y  spaced  l o c a t i o n s  on the  

su r f a c e  '
' o f  the  blade  s e c t i o n  w i l l  be cons idered

,  '
' from '+str ( y_start )+'  to  '+str (y_end)+'

) :  ' )
Number_Of_Y_positions = raw_input(Number_Of_Y_positions_raw_input )
Number_Of_Y_positions = int (Number_Of_Y_positions )

Y_Sl ices_Posit ions = numpy . l i n s p a c e ( s t a r t=y_start , stop=y_end ,
num=Number_Of_Y_positions ) . t o l i s t ( )

e l i f UserDef ined :

X_Sl ices_Posit ions = raw_input( ' Enter  Number o f  X l o c a t i o n s  to  cons ider ,  '
' s eparated  by a comma '
' ( from Leading Edge to  Tra i l i n g  Edge ) :  ' )

X_Sl ices_Posit ions = l i s t ( X_Sl ices_Posit ions . s p l i t ( ' , ' ) )
X_Sl ices_Posit ions = [ f loat ( p o s i t i o n ) for po s i t i o n in X_Sl ices_Posit ions ]

Y_Slices_Positions_raw_input = ( ' Enter  Number o f  Y l o c a t i o n s  to  cons ider ,  
'

' s eparated  by a comma '
' ( from '+str ( y_start )+'  to  '+str (y_end)+' ) :

 ' )
Y_Sl ices_Posit ions = raw_input( Y_Slices_Positions_raw_input )
Y_Sl ices_Posit ions = l i s t ( Y_Sl ices_Posit ions . s p l i t ( ' , ' ) )
Y_Sl ices_Posit ions = [ f loat ( p o s i t i o n ) for po s i t i o n in Y_Sl ices_Posit ions ]

###################### Extrac t s o l u t i o n a long PolyLines
#######################

i f VG:

######### Create box to avoid around VG
###################################
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# Round z coord ina te columns , to avoid very sma l l n e ga t i v e numbers in
# the VG Mesh
for index_row , row in enumerate( Points_Coordinates ) :

for index_point , po int in enumerate( row ) :
Points_Coordinates [ index_row ] [ index_point ] = ( po int [ 0 ] , po int [ 1 ] ,

abs ( round( po int [ 2 ] , n d i g i t s=14 ) ) )

# Find maximum X va lue o f the VG Mesh
VG_Max_X = max ( [ [ po int [ 0 ] for po int in row ]

for row in Points_Coordinates ] )
VG_Max_X = max(VG_Max_X)

# Find minimum X va lue o f the VG Mesh
VG_Min_X = min ( [ [ po int [ 0 ] for po int in row ]

for row in Points_Coordinates ] )
VG_Min_X = min(VG_Min_X)

# Find maximum X va lue o f the VG Mesh
VG_Max_Y = max ( [ [ po int [ 1 ] for po int in row ]

for row in Points_Coordinates ] )
VG_Max_Y = max(VG_Max_Y)

# Find minimum X va lue o f the VG Mesh
VG_Min_Y = min ( [ [ po int [ 1 ] for po int in row ]

for row in Points_Coordinates ] )
VG_Min_Y = min(VG_Min_Y)

X_Slices_Positions_ToAvoid = [ ]
Y_Slices_Positions_ToAvoid = [ ]
for y in Y_Sl ices_Posit ions :

for x in X_Sl ices_Posit ions :
i f ( ( x >= VG_Min_X) and ( x <= VG_Max_X) and

( y >= VG_Min_Y) and ( y <= VG_Max_Y) ) :
Y_Slices_Positions_ToAvoid . append (y )
X_Slices_Positions_ToAvoid . append (x )

Y_Slices_Positions_ToAvoid = numpy . unique ( Y_Slices_Positions_ToAvoid )
X_Slices_Positions_ToAvoid = numpy . unique ( X_Slices_Positions_ToAvoid )

Quantity_Suct ion_Surface_l ist = [ ]
Quantity_Pressure_Surface_l ist = [ ]
for x_pos it ion in X_Sl ices_Posit ions :

for y_pos it ion in Y_Sl ices_Posit ions :
i f VG:

i f ( ( x_pos it ion in X_Slices_Positions_ToAvoid ) and
( y_pos it ion in Y_Slices_Positions_ToAvoid ) ) :

continue
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[ Quantity_Suction_Surface , Quantity_Pressure_Surface ] =
ExtractSurfaceData ( Surface_reader=SU2_Surface_reader ,

Quantity_to_extract
=
Var iab leToExtractFromAir fo i lSur face
,

X_Slice_Posit ion=
x_posit ion ,

Y_Slice_Posit ion=
y_pos it ion )

Quantity_Suct ion_Surface_l ist . append ( ( x_posit ion , y_posit ion ,
Quantity_Suction_Surface ) )

Quantity_Pressure_Surface_l ist . append ( ( x_posit ion , y_posit ion ,
Quantity_Pressure_Surface ) )

Quantity_Suction_Surface_array = numpy . array ( Quantity_Suction_Surface_list ,
dtype=[( "x" , " f8 " ) , ( "y" , " f8 " ) , ( "

Pre s su r e_Coe f f i c i en t " , " f 8 " ) ] )
Quantity_Pressure_Surface_array = numpy . array ( Quantity_Pressure_Surface_l ist ,

dtype=[( "x" , " f8 " ) , ( "y" , " f8 " ) , ( "
Pre s su r e_Coe f f i c i en t " , " f 8 " ) ] )

pandas . DataFrame ( Quantity_Suction_Surface_array ) . to_csv (
ExtractedNormalLinesSolut ionPath + "Pres sureCoe f f i c i entData_Suct ionS ide . csv
" , index=None )

pandas . DataFrame ( Quantity_Pressure_Surface_array ) . to_csv (
ExtractedNormalLinesSolut ionPath + "Pres sureCoe f f i c i en tData_Pres sureS ide .
csv " , index=None )

############################ MAIN PROGRAM END
#################################
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IBL Parameters Script

In this Appendix, an example of a R script to create the velocity pro�les plot, using the solution slices
extracted from 3D results, is reported.

# Clear p l o t s
i f ( ! i s . null (dev . l i s t ( ) ) ) dev . of f ( )
# Clear conso l e
cat ( "\014" )
# Clean workspace
rm( l i s t=l s ( ) )

##### Requires to i n s t a l l f o l l ow i n g packages wi th i n s t a l l . packages ( '
namepackage ' ) :

##### −' r s t ud i oap i '
##### −' dp lyr '
##### −' r l i s t '
##### −' g gp lo t2 '
##### −' s ca l e s '
##### −' cowplot '
##### − ' s t r i n g r '

### This f i l e has to be p laced ou t s i d e any f o l d e r con ta in ing * . csv f i l e s to
read from

### * . csv f i l e s need to have the f o l l ow i n g name s t r u c t u r e " S l i c e_x_i n t ( xcoord )
_dec ( xcoord )_y_i n t ( ycoord )_dec ( ycoord )"

### or "Line_x_i n t ( xcoord )_dec ( xcoord )_y_i n t ( ycoord )_dec ( ycoord )"
### where xcoord and ycoord are the x and y l o c a t i o n s o f the s l i c e * . csv f i l e

l ibrary ( dplyr )
l ibrary ( r l i s t )
l ibrary ( ggp lot2 )
l ibrary ( cowplot )
l ibrary ( s c a l e s )
l ibrary ( s t r i n g r )
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############################################## Sta r t Library
#######################################################

Read_Al l_S l i c e s <− function (path ) {

#### This func t i on i s used to read data from . csv f i l e s con ta in ing s l i c e s
data from SU2 s o l u t i o n .

#### I t i s meant to be used wi th i n s t r u c t i o n s l i k e do . c a l l ( " rb ind " , l a p p l y (
CsvFi lePaths , Read_Al l_S l i c e s ) )

t e s t <− read . csv (path , header = TRUE, sep=" , " )

CSVFileName <− basename(path ) # Get * . csv FileName fo r VG case

# Get S l i c e Locat ion from case FileName
S l i c e_Locat ions <− s t r sp l i t ( x=CSVFileName , sp l i t=" . csv " )
S l i c e_Locat ions <− unlist ( S l i c e_Locat ions )

# Get S l i c e Coordinates from S l i c e_Locat ions
S l i c e_Coordinates <− s t r sp l i t ( x=S l i c e_Locat ions , sp l i t="_" )
S l i c e_Coordinates <− unlist ( S l i c e_Coordinates )

##### Fi l e s s t a r t wi th " S l i c e " or "Line" and then the coord inates ,
##### so s k i p always the f i r s t e lement o f the vec t o r S l i c e_Coordinates

# Create P lo t T i t l e
X_po s i t i o n <− c ( S l i c e_Coordinates [ 2 ] , " " , S l i c e_Coordinates [ 3 ] , "_" , S l i c e_

Coordinates [ 4 ] )
X_po s i t i o n <− paste (X_pos i t i on , c o l l a p s e = "" )

Y_po s i t i o n <− c ( S l i c e_Coordinates [ 5 ] , " " , S l i c e_Coordinates [ 6 ] , "_" , S l i c e_
Coordinates [ 7 ] )

Y_po s i t i o n <− paste (Y_pos i t i on , c o l l a p s e = "" )

t e s t$Sl i ceX <− rep (X_pos i t i on , t imes=length ( t e s t$Points . 0 ) )
t e s t$Sl i ceY <− rep (Y_pos i t i on , t imes=length ( t e s t$Points . 0 ) )

t e s t
}

#######################################################################

CleanAndRound <− function ( DataExtracted ) {

#### In t h i s f unc t i on some data rounding and column renaming i s done
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# Rename columns proper l y
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Points . 0 " ] <− "X"
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Points . 1 " ] <− "Y"
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Points . 2 " ] <− "Z"

i f ( "Conservat ive_2" %in% colnames ( DataExtracted ) ) {
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Conservat ive_2" ] <− "u"}

i f ( "Conservat ive_3" %in% colnames ( DataExtracted ) ) {
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Conservat ive_3" ] <− "v"}

i f ( "Conservat ive_4" %in% colnames ( DataExtracted ) ) {
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Conservat ive_4" ] <− "w"}

i f ( "X.Momentum" %in% colnames ( DataExtracted ) ) {
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="X.Momentum" ] <− "u"}

i f ( "Y.Momentum" %in% colnames ( DataExtracted ) ) {
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Y.Momentum" ] <− "v"}

i f ( "Z .Momentum" %in% colnames ( DataExtracted ) ) {
colnames ( DataExtracted ) [ colnames ( DataExtracted )=="Z .Momentum" ] <− "w"}

# Round Points Coordinates
DataExtracted$X <− round( DataExtracted$X, 8 )
DataExtracted$Y <− round( DataExtracted$Y, 8 )
DataExtracted$Z <− round( DataExtracted$Z , 8 )

return ( DataExtracted )
}

#######################################################################

ComputeDistanceFromAirfo i lSurface <− function ( DataExtracted ) {

#### This func t i on computes Distance from the a i r f o i l sur face , a long a l i n e
normal to i t

#### I t uses the coord ina t e s data a l r eady presen t in the s l i c e s output from
SU2 .

#### These s l i c e s correspond a l r eady to a normal l i n e

DataExtracted <− DataExtracted %>%
group_by( Sl iceX , S l i ceY ) %>%
arrange ( Sl iceY , S l i ceX ) %>%
mutate ( Distance = c (0 , sqrt ( (X[ 2 : n ( ) ] − X[ 1 : ( n ( )−1) ] ) ^2 + (Y[ 2 : n ( ) ] − Y

[ 1 : ( n ( )−1) ] ) ^2 + (Z [ 2 : n ( ) ] − Z [ 1 : ( n ( )−1) ] ) ^2) ) ) %>%
mutate ( Distance_to t = cumsum( Distance ) ) %>%
ungroup ( )
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return ( DataExtracted )

}

########################################################################

Compara t i v eP lo t sVe lo c i tyPro f i l e s_Sh i f t edVa lues <− function (
DataExtracted_Smooth , DataExtracted_VG, ExtractedGroup_Plot , Sl iceXGroups_Elem ,

offset ,
x_axis_l a b e l_f l a g , y_axis_l a b e l_f l a g , plot_t i t l e_f l a g , plot_t i t l e_po s i t i o n_f l a g ,
legend_po s i t i o n_f l a g , scale_c o l o r_manual_f l a g ) {

#### This func t i on c r ea t e s a comparative p l o t o f Smooth (No VG) and VG
Ve loc i t y P r o f i l e s

####### Extrac t data f o r s i n g l e S l i c e to cons ider
ExtractedGroup_Smooth_ToPlot <− DataExtracted_Smooth %>% f i l t e r ( S l i ceX==

SliceXGroups_Elem)
ExtractedGroup_Smooth_ToPlot <− ExtractedGroup_Smooth_ToPlot %>% s e l e c t (

Distance_tot , u )

ExtractedGroup_VG_ToPlot <− DataExtracted_VG %>% f i l t e r ( S l i ceX ==
SliceXGroups_Elem)

ExtractedGroup_VG_ToPlot <− ExtractedGroup_VG_ToPlot %>% s e l e c t ( Distance_tot
, u )

i f ( of fset == 0) {

######## Set up gener i c p l o t o b j e c t Theme
ExtractedGroup_Plot <− ExtractedGroup_Plot +

theme_bw( ) +
theme ( legend . p o s i t i o n=' none ' ) +
theme (plot . t i t l e = element_blank ( ) )

}

######## Create P lo t l i n e s and po in t s
ExtractedGroup_Plot <− ExtractedGroup_Plot +

geom_l i n e (data = ExtractedGroup_Smooth_ToPlot , aes ( x = Distance_tot ,
y = u + offset , c o l ou r = "Smooth" ) ) +
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geom_l i n e (data = ExtractedGroup_VG_ToPlot , aes ( x = Distance_tot ,
y = u + offset , c o l ou r = "VG" ) ) +

coord_f l i p ( )

#### Add ex t ra f e a t u r e s to the curren t p l o t

i f ( x_axis_l a b e l_f l a g ) {

ExtractedGroup_Plot <− ExtractedGroup_Plot + xlab ( "d [m] " )

} else i f ( y_axis_l a b e l_f l a g ) {

ExtractedGroup_Plot <− ExtractedGroup_Plot + ylab ( expression ( 'u '/ 'U ' [
i n f i n i t y ] ) )

} else i f (plot_t i t l e_f l a g ) {

ExtractedGroup_Plot <− ExtractedGroup_Plot + g g t i t l e ( paste ( " Ve loc i ty  
P r o f i l e s " ) )

} else i f (plot_t i t l e_po s i t i o n_f l a g ) {

ExtractedGroup_Plot <− ExtractedGroup_Plot + theme (plot . t i t l e = element_
text ( h ju s t = 0 . 5 ) )

} else i f ( legend_po s i t i o n_f l a g ) {

ExtractedGroup_Plot <− ExtractedGroup_Plot + theme ( legend . p o s i t i o n = "
bottom" )

} else i f ( scale_c o l o r_manual_f l a g ) {

ExtractedGroup_Plot <− ExtractedGroup_Plot + scale_c o l o r_manual (name = "
Case" , # or name = element_b lank ( )
labels = c ( "Smooth" , "VG" ) , va lue s = c ( " red " , " blue " ) )

}
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return ( ExtractedGroup_Plot )

}

####################################################################

Crea t eVe l o c i t yPro f i l e sEvo l u t i on_Plot <− function ( ExtractedGroup_Plot_
Co l l e c t i o n ) {

#### In t h i s f unc t i on the Ve l o c i t y P r o f i l e s e v o l u t i on i s d i sp l ayed , c r ea t i n g
a unique p l o t

#### from e x i s t i n g p l o t o b j e c t s , t h a t are r e l a t i v e to s u b s e t s o f the a i r f o i l
chord

#### Define co lour f o r each p l o t l i n e s , f o r a l l the p l o t s conta ined in the
c o l l e c t i o n o f group p l o t s

#### ExtractedGroup_Plo t_Co l l e c t i on

for ( index in 1 : length ( ExtractedGroup_Plot_Co l l e c t i o n ) ) {

ExtractedGroup_Plot_Co l l e c t i o n [ [ index ] ] <− ExtractedGroup_Plot_Co l l e c t i o n
[ [ index ] ] +

scale_c o l o r_manual (name = "Case" , # or name = element_b lank ( )
labels = c ( "Smooth" ,

"VG" ) ,
va lue s = c ( " red " ,

" blue " ) ) +
theme ( legend . t i t l e=element_text ( s i z e =15) ,

legend . text=element_text ( s i z e =15) )

}

#### Create a unique p l o t from p l o t o b j e c t s conta ined in ExtractedGroup_Plo t
_Co l l e c t i on

Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot <− plot_grid ( p l o t l i s t = ExtractedGroup_Plot_
Co l l e c t i on ,

nrow = 2 ,
ncol = 3)

# Add s i n g l e l egend
legend_Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot <− get_legend ( ExtractedGroup_Plot_

Co l l e c t i o n [ [ 1 ] ] + theme ( legend . p o s i t i o n="bottom" ) )
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Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot <− plot_grid ( Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot ,
legend_Ve l o c i t yP r o f i l e sEvo l u t i o n

_Plot ,
ncol = 1 ,
r e l_he i gh t s = c (1 , . 1 ) )

# Add Plo t T i t l e
t i t l e <− ggdraw ( ) + draw_l a b e l ( " Ve loc i ty  P r o f i l e s " , f o n t f a c e=' p l a i n ' , s i z e

=15)

Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot <− plot_grid ( t i t l e , V e l o c i t yP r o f i l e sEvo l u t i o n_
Plot , ncol=1, r e l_he i gh t s=c ( 0 . 0 5 , 1) )

return ( Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot )

}

############################# End Library ###########################

#################################################################
######################### Main Program Sta r t ####################

# Get and Set Current d i r e c t o r y where t h i s R f i l e i s been run from
Current_Working_Direc tory <− dirname( r s t ud i o ap i : : getSourceEditorContext ( )$path

)
setwd ( Current_Working_Direc tory )

# Create Path and Direc tory f o r sav ing P lo t s
Plot s_SavePath <− f i l e .path ( Current_Working_Directory , "Extracted_Plot s " )
dir . create ( P lot s_SavePath )

# Get L i s t o f a l l * . csv f i l e s con ta in ing the so l u t i on , t r a v e r s i n g a l l
s u b d i r e c t i o r i e s

csv_f i l e s_path <− l i s t . f i l e s (path = Current_Working_Directory , pattern = " . csv
" , r e c u r s i v e = TRUE)

csv_f i l e s_path <− paste ( " . /" , csv_f i l e s_path , sep="" )

# Get Indexes o f Smooth and VG so l u t i o n s
Smooth_Fi lePath_Indexes <− grep ( "Smooth" , csv_f i l e s_path , f i x e d = TRUE)
VG_xc02_h6mm_Fi lePath_Indexes <− grep ( "xc02_6mm" , csv_f i l e s_path , f i x e d = TRUE

)
VG_xc03_h6mm_Fi lePath_Indexes <− grep ( "xc03_6mm" , csv_f i l e s_path , f i x e d = TRUE

)
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# Create separa t e l i s t s con ta in ing Fi l ePaths names f o r Smooth and VG cases
Smooth_Fi lePath <− csv_f i l e s_path [ Smooth_Fi lePath_Indexes ]
VG_xc02_h6mm_Fi lePath <− csv_f i l e s_path [VG_xc02_h6mm_Fi lePath_Indexes ]
VG_xc03_h6mm_Fi lePath <− csv_f i l e s_path [VG_xc03_h6mm_Fi lePath_Indexes ]

# Create Dataframe conta in ing a l l data
DataExtracted_Smooth <− do . ca l l ( " rbind " , lapply ( Smooth_FilePath , Read_Al l_

S l i c e s ) )
DataExtracted_VG_xc02_h6mm <− do . ca l l ( " rbind " , lapply (VG_xc02_h6mm_FilePath ,

Read_Al l_S l i c e s ) )
DataExtracted_VG_xc03_h6mm <− do . ca l l ( " rbind " , lapply (VG_xc03_h6mm_FilePath ,

Read_Al l_S l i c e s ) )

############### Rename Columns Name and round coord ina t e s va l u e s #########

DataExtracted_Smooth <− CleanAndRound ( DataExtracted_Smooth )
DataExtracted_VG_xc02_h6mm <− CleanAndRound ( DataExtracted_VG_xc02_h6mm)
DataExtracted_VG_xc03_h6mm <− CleanAndRound ( DataExtracted_VG_xc03_h6mm)

################## Compute l e n g t h o f l i n e segments cons idered #############

DataExtracted_Smooth <− ComputeDistanceFromAirfo i lSurface ( DataExtracted_Smooth
)

DataExtracted_VG_xc02_h6mm <− ComputeDistanceFromAirfo i lSurface ( DataExtracted_
VG_xc02_h6mm)

DataExtracted_VG_xc03_h6mm <− ComputeDistanceFromAirfo i lSurface ( DataExtracted_
VG_xc03_h6mm)

######################### Create P lo t s ################

SliceXGroups <− unique ( DataExtracted_Smooth$Sl i ceX )

Case_FileName <− "VG xc03 h=6mm"
of fset_Ve l o c i t yP r o f i l e s <− 2

ExtractedGroup_Plot <− ggp lot ( )
of fset_Ve l o c i t yP r o f i l e s_update <− 0 .0
nr_comparative_plot_Sh i f t edVa lues <− 0
count_Sl icesGroup <− 0
Co l l e c t i o nP l o t sL i s t_number <− 1
ExtractedGroup_Plot_Co l l e c t i o n <− l i s t ( )
for ( SliceXGroups_VG_Elem in SliceXGroups ) {
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ExtractedGroup_Plot <− Compara t i v eP lo t sVe l o c i tyPro f i l e s_Sh i f t edVa lues (
DataExtracted_Smooth ,

DataExtracted_VG_xc03_h6mm, ExtractedGroup_Plot , Sl iceXGroups_VG
_Elem , of fset_Ve l o c i t yP r o f i l e s_update ,

x_axis_l a b e l_f l a g = TRUE, y_axis_l a b e l_f l a g = FALSE, plot_t i t l e_f l a g =
FALSE,

plot_t i t l e_po s i t i o n_f l a g = FALSE, legend_po s i t i o n_f l a g = TRUE, scale_
c o l o r_manual_f l a g = TRUE)

of fset_Ve l o c i t yP r o f i l e s_update <− of fset_Ve l o c i t yP r o f i l e s_update + of fset_
Ve l o c i t yP r o f i l e s

i f ( ( of fset_Ve l o c i t yP r o f i l e s_update %% ( of fset_Ve l o c i t yP r o f i l e s*5) ) == 0)
{

# Subse t corresponding 5 s l i c e s per each time , from vec to r con ta in ing a l l
the s l i c e s

SliceXGroups_Plotted <− SliceXGroups [ ( 5*count_Sl icesGroup + 1) : ( 5* (count_
Sl icesGroup + 1) ) ]

Sl iceXGroups_Plotted <− gsub ( "_" , " " , SliceXGroups_Plotted )
SliceXGroups_Plotted_Sp l i t <− s t r sp l i t ( SliceXGroups_Plotted , " " )

SliceXGroups_Plotted_new <− c ( )
for ( index in 1 : length ( SliceXGroups_Plotted_Sp l i t ) ) {

S l i c e_po s i t i o n_s t r i n g <− paste (c ( SliceXGroups_Plotted_Sp l i t [ [ index ] ] [ 2 ] ,
" . " , Sl iceXGroups_Plotted_Sp l i t [ [ index ] ] [ 3 ] ) , c o l l a p s e="" )

S l i c e_po s i t i o n_number <− round( as .numeric ( S l i c e_po s i t i o n_s t r i n g ) ,2 )
S l i c e_po s i t i o n_s t r i n g_new <− s p r i n t f ( "%0.2 f " , S l i c e_po s i t i o n_number )
SliceXGroups_Plotted_new_s t r i n g <− paste (c ( SliceXGroups_Plotted_Sp l i t [ [

index ] ] [ 1 ] , " " , S l i c e_po s i t i o n_s t r i n g_new) , c o l l a p s e="" )
SliceXGroups_Plotted_new <− c ( SliceXGroups_Plotted_new, Sl iceXGroups_

Plotted_new_s t r i n g )
}
SliceXGroups_Plotted_new <− gsub ( "X" , "x/c =" , SliceXGroups_Plotted_new)

ExtractedGroup_Plot <− ExtractedGroup_Plot + ylab ( expression ( 'u '/ 'U ' [
i n f i n i t y ] ) )

ExtractedGroup_Plot <− ExtractedGroup_Plot + scale_y_cont inuous (
breaks = head ( seq (0 , of fset_Ve l o c i t yP r o f i l e s*5 , by=of fset_

Ve l o c i t yP r o f i l e s ) , −1) ,
labels = SliceXGroups_Plotted_new) # It ' s a x i s y because o f the coord_

f l i p ( ) b e f o r e

201



Appendix F: IBL Parameters Script

# Update L i s t con ta in ing a l l the p l o t s c rea t ed
ExtractedGroup_Plot_Co l l e c t i o n [ [ C o l l e c t i o nP l o t sL i s t_number ] ] <−

ExtractedGroup_Plot

# Save Comparative P lo t wi th Sh i f t e d Values , in A4 format
SaveFileName <− paste ( "ExtractedGroup Plot  f o r  Vo r t i c i t y  Magnitude " , Case_

FileName , nr_comparative_plot_Shi f tedValues , " . pdf " , sep="" )
ggsave ( f i l e=SaveFileName , plot = ExtractedGroup_Plot , path = Plot s_

SavePath , width = 297 , he ight = 210 , un i t s = "mm" )

# Remove Plo t Object t h a t has been j u s t saved in the . pd f f i l e
rm( ExtractedGroup_Plot )

# Re− i n i t i a l i z e p l o t o b j e c t
ExtractedGroup_Plot <− ggp lot ( )

# Reset O f f s e t ( in the func t i on Comparat ivePlotsVe loc i tyMagni tude_
Sh i f t edVa lue s a new p l o t w i l l be c rea t ed each time o f f s e t == 0.0)

of fset_Ve l o c i t yP r o f i l e s_update <− 0 .0

# Update counter f o r S l i c e s su b s e t to e x t r a c t
count_Sl icesGroup <− count_Sl icesGroup + 1

# Update number comparative p l o t s c rea t ed
nr_comparative_plot_Sh i f t edVa lues <− nr_comparative_plot_Sh i f t edVa lues + 1

# Update number o f p l o t , to use when s t o r i n g a l l the p l o t s in a s i n g l e
L i s t o b j e c t

Co l l e c t i o nP l o t sL i s t_number <− Co l l e c t i o nP l o t sL i s t_number + 1

}

}

# Update number comparative p l o t s c rea t ed f o r the l a s t curves , i f the number
o f the l a s t curves i s l e s s than 5

nr_comparative_plot_Sh i f t edVa lues <− nr_comparative_plot_Sh i f t edVa lues + 1

# Save Comparative P lo t wi th Sh i f t e d Values , in A3 format
SaveFileName <− paste ( "ExtractedGroup Plot  f o r  Ve loc i ty  " , Case_FileName , nr_

comparative_plot_Shi f tedValues , " . pdf " , sep="" )
ggsave ( f i l e=SaveFileName , plot = ExtractedGroup_Plot , path = Plot s_SavePath ,

width = 297 , he ight = 210 , un i t s = "mm" )

####### Create Grid P lo t f o r the e v o l u t i on o f Ve l o c i t y P r o f i l e s
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#######

Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot <− Crea t eVe l o c i t yPro f i l e sEvo l u t i on_Plot (
ExtractedGroup_Plot_Co l l e c t i o n )

# Save Evo lu t ion Plo t f o r Ve l o c i t y Magnitude , in A3 format
SaveFileName <− paste ( "Evolut ion  Plot  f o r  Ve loc i ty  " , Case_FileName , " . pdf " , sep=

"" )
ggsave ( f i l e=SaveFileName , plot = Ve l o c i t yP r o f i l e sEvo l u t i o n_Plot , path = Plot s_

SavePath , width = 297 , he ight = 420 , un i t s = "mm" )

#################### End Program Sta r t #######################
##############################################################
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